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Medical Device Directive
Medical Device Directive
These products conform with the requirements of council directive 93/42/EEC
concerning medical devices, when they bear the following CE Mark of Conformity:

This equipment generates, uses, and can radiate radio frequency energy. The
equipment may cause radio frequency interference with other medical and non-
medical devices and radio communications. To provide reasonable protection
against such interference, the:

GE Signa MR/i Systems

comply with emissions limits for (Group 2, Class A) Medical Devices as stated in
EN 60601-1-2. However, there is no guarantee that interference will not occur in a
particular installation.

If this equipment is found to cause interference (which may be determined by
turning the equipment on and off), the user (or qualified service personnel) should
attempt to correct the problem by one or more of the following measure(s):

• reorient or relocate the affected device(s);

• increase the separation between the equipment and the affected device;

• power the equipment from a source different from that of the affected device;
and/or

• consult the point of purchase or service representative for further
suggestions.

The manufacturer is not responsible for any interference caused by using
interconnect cables that are not recommended or by unauthorized changes or
modifications to this equipment. Unauthorized changes or modifications could
void the user’s authority to operate the equipment.

Do not use devices that transmit RF Signals (cellular phones, transceivers, or
radio controlled products) in the vicinity of this equipment as they may cause
performance outside the published specifications. Keep the power to these types
of devices turned off when near this equipment.

The medical staff in charge of this equipment is required to instruct technicians,
patients, and other people who may be around this equipment to fully comply with
the above requirement.

Immunity/Emissions Exceptions: Note the exceptions from the EMC test results.
Check with the business EMC engineer for this information.



Medical Device Directive
In accordance with the international safety standard IEC 601-1, this system is a
Class I device, acceptable for Continous Operation, having ordignary protection
against ingress of water with type B applied parts and is not for use in the
presence of flammable anesthetics.

CAUTION: User to call or contact the local authorities for disposal of the MR
System at the end of its useful life.
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Where Am I?
Volume 4

Chapter 1

Sharpening and
Smoothing

Images with
ClariView

Introduction
This chapter explains the ClariView™ image filtering process.
ClariView is a post-processing feature that filters MR and MRA
images to improve signal-to-noise, contrast, and edge sharpness.
ClariView is used to smooth and sharpen images. This chapter gives
you the step-by-step instructions for:

• Enhancing Images with Smoothing, Sharpening, and MRA
Algorithms
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In addition, this chapter answers the following questions:

1. When do I use ClariView?

2. How do I pick a filter in ClariView?

3. How do I save images with ClariView?

4. How are images be annotated with ClariView?

Something to Think About...

• Image filtering does not improve the diagnostic quality of
the image.

• ClariView is available for images with a maximum image
display matrix of 512 x 512.

• ClariView is NOT available for:

° 0.2T, 0.5T, or 3.0T images

° Screen saved images

° 64 X 64, 128 x 128, or 1024 x 1024 matrix images

° CT or DICOM images

° 3D surface images

• Individual images are saved as a series.

• The system saves a maximum of nine filtered series. If
you want to filter more than nine times, delete one or
more filtered series. A new filter can be selected at
anytime EXCEPT while the filtering process is running.

• Previewing temporarily assigns a new series number.

• A previewed image does not use the same window/level
as the original image.
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About... Sharpening and
Smoothing Images in
ClariView

This section presents the concepts necessary to successfully
complete image filtering using the ClariView process.
Specifically, you need to understand:

• The Purpose and Benefits of Image Enhancement

• Series Assignment in the Browser

• The ClariView Window

The Purpose and Benefits of Image
Enhancement

The ClariView feature filters MR images to improve apparent
signal to noise, contrast, and edge sharpness. ClariView makes
the image more aesthetically pleasing, but does not improve the
diagnostic quality of the image.

Any ClariView filter may be applied to any image. You may want
to use preview first, and apply a few different filters to pick the
filter that works best for that image.

Smoothing algorithms are used to remove graininess from high
resolution and low signal images. Grainy images such as 512 x
512 matrix head, abdomen, or extremities would be good
candidates for ClariView’s smoothing algorithm. Filters D
through I use a smoothing algorithm.

Sharpening algorithms help define structural edges in images
with high signal and low noise. Filters A through C use a
sharpening algorithm.

Filter J is used for filtering MRA (Magnetic Resonance
Angiography) images, and can be applied to either the source
images or the MIP (Maximum Intensity Pixel) images. The
MRA-MIP filter smooths the vascular structures without
introducing any black lines and provides good vessel
delineation.
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NOTE: If you plan to apply ClariView filters to the images, and
you have used PPS, do not complete the exam when
finished scanning. Post-processing functions must be
done before the exam is completed in PPS. First click the
[End Exam] button, then click the [Defer] button. Apply
the ClariView filters. Then complete the exam by clicking
PPS from the Browser menu bar, and click the
[Complete] button to complete the exam.

The following table lists the different algorithms and gives a
description of each.

• The following table gives a detailed description of the
filter functions and suggested application.

Filter Name Filter Description and Use

A Sharpen with very little smoothing. This
is an overall sharpening filter with very
little smoothing. Used for high signal
and very low noise 256 x 256 images.
Candidate images include heads,
abdomens, and extremities.

B Sharpen with little smoothing. This is an
overall sharpening filter with little
smoothing.This filter enhances
structural edges. Used for high signal
and low noise 256 x 256 images.
Candidate images include axial heads,
cervical spines, lumbar spines (small
FOV), abdomens, and extremities.

C Sharpen with smoothing. This is an
overall sharpening filter with smoothing.
This filter enhances structural edges
and suppresses noise. Extremity
images would be good candidates.

D Smoothing with sharpening. This filter
has an equal blend of smoothing and
sharpening. This filter enhances
structural edges and suppresses noise.
Candidate images include 512 x 512
head and extremity images.
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Series Assignment in the Browser
The filtered (enhanced) images created by the ClariView
feature are saved to a new series. The unenhanced images
remain in the original series in the Browser, while the new,
filtered, series receives a new series number.

E Smoothing with little sharpening. This
filter produces more smoothing while
sharpening a little to suppress noise.
This filter provides some edge
enhancement of structural edges.
Candidate images include 512 x 512
head, abdomen, and extremity images.

F High smoothing with very little
sharpening. This filter produces
smoothing and very little sharpening.
This filter suppresses noise and
provides smoother structural edges.
Candidate images include high
resolution and low signal images.

G High smoothing with some sharpening.
This filter produces both smoothing and
sharpening. This filter suppresses noise
and provides smoother regions but
sharper structural edges. Used for high
resolution and low signal images.

H High smoothing and sharpening. This
filter suppresses noise and provides
smoother regions and sharper structural
edges. Used for high resolution and low
signal images.

I 512 Spine. This filter produces
smoothing while maintaining structural
edge definition without blurring. Used for
512 x 512 spine images with a large
FOV.

J MRA-MIP. This filter produces
smoothing of vascular structures without
introducing black lines and provides
good vessel definition. Used for
Maximum Intensity Projections (MIP)
from MR Angiography (MRA) studies.

Filter Name Filter Description and Use
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After filtering, the new series number is a multiple of 100 plus
the original series’ number. For example, if series 4 is filtered,
the new series is 104; if series 4 is filtered again, it becomes
series 204. Once a ClariView filter has been applied to an
image or series, it is annotated in the series description in the
Browser.

NOTE: If ClariView has been applied to an image, the annotation
appears in the lower left corner of the film following the
pulse sequence annotation, as FL:A-J where A-J is the
applied filters. This annotation indicates that this is a
filtered image and may not be of diagnostic quality.

The ClariView Window

ClariView

• 1 - Image Slider. Click and drag right or left to select a
different image to preview.

• 2 - Image selector. Click to move to the next or prior
image.

• 3 - Zoom. Click and drag right or left to select a zoom
(magnification) factor and apply to the image.

• 4 - Filter setting selector. Click and drag to the desired
filter setting. The filter description text box is to the right
of this button.

7

5

8

2

4

1

3 6

9
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• 5 - Series selector. Click to move to the next or prior
series.

• 6 - [Display Normal]. Click this button to return the
image to its original form (no filters) and normal size.

• 7 - [Preview]. Click to preview the filtered image without
saving it. Previewing temporarily assigns a new series
number.

• 8 - Filter and Save to Database area. Use the buttons in
this area to apply the selected filter to an entire exam,
series, or image, and to save the new, filtered images.
The system counts the number of images or series
completed during the filtering process. This count is
shown in the area above the [Done] button.

• 9 - [Done]. Click this button to close and exit the
ClariView window.

Something to Think About...

• A message window appears after ClariView is closed,
stating “ClariView failed.” ClariView worked, so ignore
the error message.
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How to Sharpen and
Smooth Images using
ClariView
This section provides the step-by-step instructions for applying
ClariView. Specifically, it describes how to:

• Enhance Images with the Smoothing, Sharpening, and
MRA Algorithms
° Reboot During a ClariView Procedure
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Anchor LEnhance Images with Smoothing,
Sharpening, and MRA Algorithms

The ClariView feature filters MR images to make them more
aesthetically pleasing. These filters have varying combinations
of smoothing and sharpening.

ClariView smoothing algorithms remove graininess from
high resolution and low signal images.

ClariView sharpening algorithms provide edge
enhancement.

The MRA-MIP filter smooths the vascular structures without
introducing any black lines and provides good vessel
delineation. You can apply the MRA algorithm to either the
source images or to the MIP images.

The process is the same for applying a smoothing, sharpening,
or MRA filter. This section gives you step-by-step instructions
for the ClariView process.

1. Click the Display Desktop icon from the control panel.

2. From the Browser, select the exam, series, or images you
want to filter.

• ClariView filters the entire exam, series, or any number
of images you select.

• To filter a subset of images in a series, select them
before selecting ClariView.

3. Click [ClariView], found on the right side of the Browser.

In Brief: Enhance
with Smoothing,
Sharpening, and MRA
Algorithms

1. Click the Display
Desktop icon.

2. Select from the patient list
the exam, series, or
image(s) to filter.

3. Click [ClariView].

4. Select the image using
the Image Slider.

5. Click [Filter] and drag to
select filter. Select
MRA-MIP for MRA
images.

6. Click [Preview].

7. Repeat steps 5-6 to
preview with other filters.
Repeat steps 4-6 to
preview new images with
selected filter(s).

8. When ready to save
filtered images go to the
Filter and Save to
Database area. Click
[Image], [Series] or
[Exam].

9. Click [Done] to exit
ClariView.

10. Filtered images are now
listed in the Browser.
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The ClariView window is displayed.

ClariView

4. Select the desired image to view, preview, or filter using the
Image Slider.

5. Select the desired filter by clicking [Filter] and dragging to
the desired choice.

ClariView/Filter

• The default setting is filter A.

• Filters A-C are sharpening filters and filters D-I are
smoothing filters. The filters have a varying combination
of both types of enhancements.

• J - is the MRA-MIP filter. Select for filtering MRA
images.

• The filter description text box can be edited (up to 35
characters) and is saved with system shutdowns. For
example, you can edit a specific filter for a particular
exam; this helps to maintain consistency when filtering.

• To edit the text box, select the filter, place cursor in the
box to the right, and type in the desired text.
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6. Click [Preview] to view the current image with the selected
filter.

ClariView/Preview

• A previewed image is NOT be saved to the Browser.

7. Repeat steps 6-7 to preview original image with other filters.

• Repeat steps 5-7 to preview new images with the
selected filter.

8. When ready to save the filtered images, go to the Filter and
Save to Database area.

ClariView/Filter and Save to Database

a) Click [Image] to save the current image with the selected
filter.

b) Click [Series] to save the entire series with the selected filter.
If a subset of a series’ images is selected, then only these
images are saved with the selected filter.

c) Click [Exam] to save the current exam with the selected filter.

9. Click [Done] to exit the ClariView window and return to the
Browser.

ClariView/Done

• [Done] is not available while filtering is active.

• The filtered images are now be listed in the Browser.

NOTE: While the system is filtering the images, all other filter
options are invalid except for [Stop]; clicking [Stop] stops
the filtering process at any time.

° Any images processed prior to clicking [Stop] are
saved to a new series.

° Click [OK] to confirm stopping the ClariView
process.

• For filtering processes that exceed 5 minutes, a
message displays the estimated filtering time.
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Something to Think About...

• A message window appears after ClariView is closed,
stating “ClariView failed.” ClariView worked, so ignore
the error message.
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Rebooting During the ClariView ProcedureEnhance Images with Smoothing, Sharpening
and MRA Algorithms

Reboot During the ClariView
Procedure
When swapping between ClariView (Display Desktop) and
ScanRx Desktop, you may need to reboot in order to continue
with the ClariView procedure. An example situation and steps to
reboot are as follows:

Sample Situation

a) The Viewer is open.

b) Click [ClariView].

c) Filter the first series.

d) Click the ScanRx Desktop icon while ClariView is still
open.

e) Return to the Display Desktop and filter the second
series.

f) Click ScanRx Desktop icon again while ClariView is still
open.

g) Return to the Display Desktop and the following
happens to ClariView:

° The ClariView menu is not visible.

° The ClariView image window is up and is overlaid on
the Viewer.

h) Press Alt + F3 keys at the same time and switch
between the Viewer and the Browser.

i) ClariView cannot be reopened or closed.

Rebooting Procedure

1. The system must be rebooted to continue. Open the door of
the Octane computer.

In Brief: Reboot
During the ClariView
Procedure

1. Open the door of the
Octane.

2. Press Reset.

3. Type signa.

4. Type adw2.0.

on/off

reset
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2. Press the reset button.

Message appears requesting you hit any key to restart.

3. Press any Key on the keyboard.

The system comes up with the Login/Password window.

4. At login type signa, using lowercase letters and press
Enter.

5. At password, type adw2.0, using lowercase letters and
press Enter.

NOTE: A message appears stating Do not interact with the
system until this message disappears. You should not use
the mouse or keyboard until this message disappears.
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Chapter 2

Editing Patient
Information

Introduction

This chapter explains the process for editing patient information.
Editing allows you to correct improperly entered patient information
(i.e. wrong patient id) and you can add information that was
previously unavailable at the time the patient data was entered into
the system. This chapter contains the step-by-step instructions to:

• Edit the Patient Data

• View the Patient Log
2-1
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In addition, this chapter answers the following questions:

1. What information can I change?

2. How do I change the patient information?
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About... Edit Patient
Information

This section presents the concepts necessary to successfully
complete the edit process. Once the patient information data is
edited, a new exam is created that replaces the old exam. If the
original exam resides on archival media or another workstation,
you will want to remove it to avoid confusion or duplicate exam
numbers. Before editing patient data, you need to understand
the following concepts:

• Data Available for Edits

° Annotation of an Edited Exam

• The Edit Patient Data Window

• The Edit Log

Data Available for Edits
You can edit almost all of the patient information that was
entered on the Patient Information area. The patient weight and
exam number cannot be edited. The following is a list of
conditions that must be met before an exam can be edited.

• The edits must be done on the same operator’s console as
the original information was entered.

• Only one exam number can be selected.

• There is sufficient disk space.

• The exam is NOT active and the exam edit time limit of two
weeks has not expired.

• You cannot edit patient data when the following conditions
exist:

• The exam is “locked,” which means the exam is

° On the archive, network, or film queues.

° Displayed in the Viewer or MiniViewer.

° Still in scan mode (End Exam has not yet been
selected).

° Still reconstructing.
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• The exam has not been created on that system, i.e.
Hospital name, System ID, or Host ID do not match that
of system on which you are trying to edit patient data.

• The exam is too “old.” This parameter is set under
Guided Install>Edit Patient Data. Fourteen days is the
default.

• The images are not in DICOM format.

• You have started the edit process and the number of
images in the exam changes before the data updates.
This could happen if you start to edit the patient data,
then enter the Add/Subtract function and add images to
the exam. When the edits are accepted an error
message appears, you should exit the edit function and
try again.

Something to Think About...

• You can edit the patient data on an exam containing a
3D model, however, the 3D model series will not be part
of the new exam. If you select a 3D series, the edit
process exits with an error.

• To avoid possible confusion with duplicate exam
numbers, it is suggested that you edit the data before
archiving, networking, or filming the exam.

CAUTION:If your facility has purchased the ConnectPro
feature and the patient information you are
editing originated from the HIS/RIS Worklist
Browser, the patient information at the local
operator’s console will NOT match the patient
information in HIS/RIS. Although it is NOT
recommended to edit patient information
gathered from the HIS/RIS, the Connect Pro
feature does NOT lock the exam from being
edited.
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Something to Think About...

• All network and archive copies of the original exam are
NOT automatically removed and should be replaced
with the new exam.

° Copies of the exam may have been produced with
Auto Network, Auto Archive, and Auto Film.

• All filmed copies of the exam should be replaced.

• If previous edits have been made, all edits should be
made to the latest version of the exam.

• All images and post processing (screen saves, reformat,
3D surface) should be done before editing. All images
created after the edit do NOT contain the edited
information.

• When exams are sorted by date in the Display or Image
Management Browsers and multiple versions of the
exam are in the database, exams with the e+ annotation
sort with the latest version appearing first. This is
reversed for exams with the e- annotation, the most
recent version sorts last.
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Annotation of an Edited Exam
Edited exams have specific annotation indicating that the
patient data has been updated. This annotation is displayed in
the Examination lists of the Display and Image Management
Browsers, and in the Exam Description text box of the Series or
Exam Text Page.

An edited exam is annotated with:

• A prefix (e).

• A + (plus) or - (minus) sign to indicate that the exam’s
date and time has been increased or decreased. The
system determines the + or - by the time of day the
exam number was edited. Any original exam that is
edited after 11:55PM of the date the scan was
completed has a - (minus) sign.

• The number of times the data was edited. For example,
e+3, for data that was edited three times.

NOTE: The total number of edits allowed is 300.
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The Edit Patient Data Window
You can edit or update data using the Edit Patient Data window.
If the text box is empty, place the cursor in the in the text box,
click, and type in the new data. If the text box already contains
data, place your cursor in the text box and select the text you
want to change. Once the text is selected, either press Delete
(on the keyboard) or immediately begin typing in new data. If
you make an error you can reset the individual text box or all the
text boxes using the [Reset Selected Value] (1) or [Reset All
Values] (3) buttons.

Something to Think About...

• The Exam Number text box is the ONLY text box
displayed that CANNOT be edited. The patient weight is
not displayed and therefore cannot be edited.

• When entering data in the Birthdate text box (1) the
month, day, and year can be separated by a dash (-),
slash (/), comma (,), or period (.). The year must contain
four digits (1999).

31

2
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The Edit Log
The Patient Information Edit Log is a list of all patients whose
information has been edited. Each log file is composed of two
rows and each exam entry is separated by a line. The top row
contains the original information and the bottom row contains
the new information. The log lists the same exam as many
times as it is edited.

Vertical and horizontal sliders allow you to completely view the
log. The vertical (1) slider views the list of the exams that have
been edited, while the horizontal (2) slider allows you to view
the changes made to individual text boxes in that exam. You
must use the horizontal slider to view the text box edits because
the log does not entirely fit on the viewing screen.

2

1
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How to Edit Patient
Information
This section provides the step-by-step instructions for editing
patient information, including how to:

• Edit the Patient Data

• View the Patient Log
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Anchor Edit the Patient Data
Use this procedure to change the information entered about a
patient. For example, editing allows you to correct a wrongly
entered patient ID number and add information that was
previously unavailable.

Something to Think About...

• Be aware that the certain conditions must be met in
order to successfully complete the edit process. These
conditions are described in more detail in the About...
section of this chapter.

1. Click the Display Desktop icon from the control panel.

2. From the Browser, select the exam to be edited.

3. Click [Edit Patient].

The Edit Patient Applications window appears.

4. Click [Edit Patient Data] to get to the Patient Information
area.

• Clicking [Cancel] exits you from the Edit Patient Data
function.

In Brief: Edit the
Patient Data

1. Click the Display
Desktop icon.

2. Select the exam to edit.

3. Click [Edit Patient].

4. Click [Edit Patient Data].

5. Caution message
appears, click [Accept].

6. Enter information to be
edited, press Enter or left
click to move about the
window. Use Delete key
to erase.

7. Enter the editor’s initials.

8. Click [Accept] go to step
9, or [Cancel] go to step
10.

9. Click [Accept] at the
confirmation message.

10. Click [Accept] or
[Cancel].
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CAUTION:A caution message appears reminding you of the
precautions you should follow.

• All network and archive copies of the original exam are
NOT automatically removed and replaced with the new
exam.

• All filmed copies of the original exam should be
replaced.

• If there have been previous edits to this exam, all edits
should be made to the most recent version of the exam.

• 3D Models in this exam are deleted in the edited exam.
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5. Click [Accept] to continue or [Cancel] to exit the Edit
Patient Data process.

The Edit Patient Data window appears.

6. Press the Enter key on the keyboard or click to move
around this window and make (type in) the changes. The
Delete key must be used to erase highlighted text.

• If you make a mistake you can:

° Click [Reset Selected Values] (1) to reset the
changed values to the previous values in the active
(highlighted) text box.

° Click [Reset All Values] (3) to reset all the changed
values to the previous values.

7. Enter three characters in the Edited by text text box. You
must enter data in this text box.

8. Click [Accept] (2) to save the changes. A confirmation
message appears. Go to step 9.

• Clicking [Cancel] (4) exits without saving the changes.
A confirmation message appears. Go to step 10.

1 3

2 4
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A confirmation message appears asking you to confirm or
discard the creation of a new exam.

9. Click [Accept] on the confirmation message to start the
saving process and create a new exam with the changes
incorporated.

• Clicking [Cancel] on the confirmation message returns
you to the Edit Patient Data window without saving the
changes and a new exam is NOT created.

Something to Think About...

• A status window appears if [Accept] was selected on
the confirmation message window. This window remains
open providing the edit save status as a percentage of
completed. Depending on the size of the exam, it may
take several minutes for the edit to complete.

• The edited exam is labeled with an “e+1” in the
description area of the Browser. The “e” indicates that
the exam has been edited; the “+1” indicates how many
times the exam has been edited.

10. If [Cancel] was selected at step 8 do one of the following:

• Click [Accept] to exit and discard the change and exit
the Edit Patient Data window.

• Click [Cancel] to exit you from the confirmation
message but allows you to stay in the Edit Patient Data
window.
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Viewing the Patient Log View the Patient Log
The Patient Information Edit Log is a list of all exams that have
been edited. The Patient Information Edit Log is for viewing
purposes only and CANNOT be used for editing the patient
data.

1. Click the Display Desktop icon from the control panel.

2. From the Browser, click [Edit Patient].

The Edit Patient Applications window appears.

3. Click [View Edit Log] (A) to view the Patient Information
Edit Log.

• Click [Cancel] (B) to exit without viewing the Patient
Information Edit Log.

In Brief: View the
Patient Log

1. Click the Display
Desktop icon.

2. Click [Edit Patient].

3. Click [View Edit Log].

4. Click and drag sliders to
view the Patient
Information Edit Log.

5. Click [Cancel].

A B
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4. Click and drag on the vertical (1) and horizontal (2) sliders to
view the entire the Patient Information Edit Log.

5. Click [Cancel] (3) to exit from the Patient Information Edit
Log.

1
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Chapter 3

Combining
Images

Introduction
This chapter explains image combination, including addition,
subtraction, pixel extraction, and binding processes. These
processes allows you to perform various operations on one or two
sets of images selected and place the resulting images in a new
series. This chapter contains the step-by-step instructions to help
you learn how to:

• Add One or Two Sets of Images

• Subtract Two Images Within the Same Set or Two Sets of
Images

• Extract the Minimum or Maximum Pixels from One Set of Images

• Extract the Minimum or Maximum Pixels from Two Sets of
Images

• Bind Images
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In addition, this chapter answers the following questions:

1. What functions can be performed with the
addition/subtraction application?

2. What are the effects of addition and subtraction?

3. What is binding?

4. What is image combination?

5. What is minimum and maximum pixel extraction?

6. What is the Ratio slider?
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About... Combining
Images
This section presents the concepts necessary to successfully
complete image combination using various processes.
Specifically, you need to understand:

• Image Combination
° Image Addition
° Image Subtraction
° Maximum Pixel Extraction
° Minimum Pixel Extraction
° Binding Images

• Image Combination Window
° Saving a Series
° Sliding the Ratio Bar
° Accepting Negative Pixels
2292264-100 Rev. 0 (03/01) 3-3



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 4
Image Combination
The Image Combination function allows you to perform various
operations on one or two sets of images selected on the
Browser and place the resulting images in a new series.

The following functions are available with Image Combination:

• Image Addition

• Image Subtraction

• Maximum Pixel Value Extraction

• Minimum Pixel Value Extraction

• Image Binding

Something to Think About...

• One or two sets of images must be selected.

• If only one set is selected, each operation performed
produces one resulting image.

• If two sets are selected, images in the two sets are
paired according to physical location in the patient’s
body. Unpaired images in either set are ignored. Each
operation performed produces one resulting image per
pair.

Image Addition
Image Addition creates a new series by adding the
corresponding signal intensity values pixel by pixel from one or
two sets of images.

There are two types of image addition possible:

• Addition performed on one set of images, where the signal
intensity values of all images are added, pixel by pixel, and
then divided by the number of images in the set. The
resulting image is an average of all the signal intensity
values.

• Addition performed on two sets of images, where the
images are paired by location and signal intensity values
are added pixel by pixel. A weighting factor can be used by
adjusting the ratio slider bar described later in this chapter.

The order of set selection does not matter for addition unless a
weighting factor is used. For example, (100 + 300) and
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(300 + 100) both yield the same result of 400 because of the
commutative property of addition.

Image Subtraction

Image Subtraction creates a new series by subtracting the
corresponding signal intensity values, pixel by pixel, from two
sets of images. The two sets can be images from the same
series, or images from two different series.

Two types of image subtraction are possible:

• Subtraction performed on two images within the same set,
where the signal intensity values of the second image are
subtracted, pixel by pixel, from the signal intensity values of
the first image.

• Subtraction performed on two sets of images, where the
images are paired by location, and the signal intensity
values of the second set of images are subtracted, pixel by
pixel, from the first set of images. A weighting factor can be
used by adjusting the ratio slider bar discussed later in this
chapter.

The set selection order for subtraction is important. For
example, (100 - 300) and (300 - 100) do not yield the same
result because the commutative property does not apply to
subtraction. Otherwise, negative pixel values are set to zero,
unless you explicitly accept them during the subtraction
process.
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Maximum Pixel Extraction

The maximum pixel value extraction function finds the highest
corresponding signal intensity value, pixel by pixel.

There are two types of maximum pixel value extraction:

• Extraction performed on one set of images, where the
highest signal intensity value is selected, pixel by pixel, from
among all images.

• Extraction performed on two sets of images, where the
images are paired by location, and the highest signal
intensity value is selected, pixel by pixel, between the two
images.

Minimum Pixel Extraction

The minimum pixel value extraction function finds the lowest
corresponding signal intensity value, pixel by pixel.
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There are two types of minimum pixel value extraction:

• Extraction performed on one set of images, where the
lowest signal intensity value is selected, pixel by pixel, from
among all images.

• Extraction performed on two sets of images, where the
images are paired by location, and the lowest signal
intensity value is selected, pixel by pixel, between the two
images.

Binding Images

Binding creates a new series set that consists of copies of
images from one or more existing series.

For example, series 2 with 10 images can be “bound” to series
4 with 15 images to create a new series with 25 images.

Image Combination Window

When you select the [Add/Sub] button from the Browser (or
Viewer), the Image Combination window opens.

Functions in this window allow you to add, subtract, extract, or
bind one or two sets of images and place the resulting images
in a new series.
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The following figure shows the Image Combination window.

Saving a Series

To differentiate combined or processed images from others in
an exam, the resulting images are assigned a series number
and starting image number by the Current Save Series indicator
in the upper right hand corner of the Image Combination
window. By default, images resulting from subsequent
operations are added onto the end of the same series.

To place images resulting from subsequent operations into a
new series, you must select the [New Save Series] button.

This increments the save series number by one and displays
the Save Series and Save Image text boxes in the upper right
corner of the Image Combination window. The numbers in
these two text boxes can be accepted or the Delete and
Backspace keys can be used to delete them, and the desired
numbers can be entered in the text box.

The series resulting from image combination operations are
distinguished from other series in the Browser via one of the
following two indicators in the Browser series list “Type” column:

• “PROC” appears in the Browser series list “Type” column if
the images in the series are the result of processing pairs of
images having identical locations in the patient’s body.

• “COMB” appears in the “Type” column if the images in the
series are the result of a combination of images having
different locations in the patient’s body.
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The following figure displays the Browser series list.

Something to Think About...

• When Add/Sub is performed, the resulting images are
annotated with the day on which the addition/subtraction
was performed. To view the date on which the exam
was performed, refer to the original image set.

• Since “PROC” series contain images resulting from
processing pairs of images having identical locations in
the patient’s body, such series can be used like any
other series of acquisition images, i.e., geometric
measurements, reformatting, 3D reconstruction, etc.

CAUTION:Since “COMB” series contain images resulting from a
combination of images from different locations in the
patient’s body, the absolute anatomical coordinates
accompanying these series (shown both in the
Browser and on the displayed images) are not
accurate. Only relative geometric measurements
(i.e. distance, angle or area) are accurate.

Sliding the Ratio Bar

The Ratio slider is available during addition and subtraction
when both Select Set buttons are selected.
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• Sliding the Ratio bar to the left increases the pixel weighting
of the image (or images) on the left (first) image set.

• Sliding the Ratio bar to the right increases the pixel
weighting of the image (or images) on the right (second)
image set.

• The Ratio slider defaults to the middle to apply equal
weighting.

NOTE: The pixel weighting can be adjusted on only one set of
images, not both.

Accepting Negative Pixels
The Accept Negative Pixels option allows negative pixel values
in the resulting images. If this function is not enabled, all
negative pixel values are set to zero.

This operation is useful on pre and post contrast studies of the
same slice location.
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How to Combine Images
This section provides the step-by-step instructions on
combining images. Specifically, it describes how to:

• Add One or Two Sets of Images

• Subtract Two Images Within the Same Set or Two Sets of
Images

• Extract the Minimum or Maximum Pixels
° One Set of Images
° Two Sets of Images

• Bind Images

• Post Process Three Station Runoffs
° Subtractions
° Acquire Collapsed Images with IVI
° Bind Multiple Series into a Single Series
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Add One or Two Sets of Images

This procedure defines how to perform image addition between
one or two sets of images. This type of addition adds the image
intensity values, pixel by pixel, of all pairs of images between
the two selected sets corresponding to the same physical
location in the patient’s body. Follow this procedure to add one
or two sets of images.

1. Click Display Desktop.

• Located on the desktop control panel.

• The Browser appears.

2. Click [Add/Sub].

• Located on the right column of the Browser.

• The Image Combination window appears.

3. Select the desired images on the Browser images list.

4. Click the left [Select Set].

• Defines the first image set.

• If you are adding two sets of images, select the second
set of images and select the right most [Select Set].

° Defines the second image set.

• By default, equal weighting is applied to the two pixels in
each pair, but you can change the weighting via sliding
the Ratio bar. In all cases, for normalization purposes,
each resulting pixel value is divided by two.

In Brief: Add One or
Two Sets of Images

1. Click Display Desktop.

2. Click [Add/Sub].

3. Select the desired images
on the Browser images
list.

4. Click the left [Select Set].
If you are adding two sets
of images, select the
second set of images and
select the right most
[Select Set].

5. Click [New Save Series].

6. Click [+].

7. Click [=].
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5. Click [New Save Series].

• The images save in the Browser in a new series.

• If you do not select this option, the images save in the
current saved series.

6. Click [+].

• Selects the addition mode.

7. Click [=].

• Performs the operation and generates the new images.

• The new series appears in the Browser when the
function is complete.
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Subtract Two Images Within the Same
Set or Two Sets of Images

The following procedure defines image subtraction between
images within one or two sets. This type of subtraction
subtracts the image intensity values, pixel by pixel, of the
second image or image set selected in the Browser. Follow this
procedure to perform image subtraction on images within the
same set or in two sets.

1. Click Display Desktop.

• Located on the desktop control panel.

• The Browser appears.

2. Click [Add/Sub].

• Located on the right column of the Browser.

• The Image Combination window appears.

3. Click [Clear Selection].

• Clears the selection and insures that both Select Set
button selections have no prior values.

4. Do one of the following:

• If you are subtracting two images within the same set,
select the two images you wish to use from the Browser,
and select the left most [Select Set].

• If you are subtracting two sets of images, select the
image set you wish to use and select the left most
[Select Set]. Repeat for the second set, this time
selecting the right most [Select Set].

In Brief: Subtract
Two Images Within
the Same Set or Two
Sets of Images

1. Click Display Desktop.

2. Click [Add/Sub].

3. Click [Clear Selection].

4. Do one of the following:
° If you are subtracting

two images within the
same set, select the
images and select the
left most [Select Set].

° If you are subtracting
two sets of images,
select the image set
you wish to use and
select the left most
[Select Set]. Repeat
for second set,
selecting right most
[Select Set].

5. Click [New Save Series].

6. Click [Accept Negative
Pixels].

7. Click [-].

8. Click [=].
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5. Click [New Save Series].

• The images save in a new series in the Browser.

• If you do not select this option, the images save in the
current saved series.

6. Click [Accept Negative Pixels].

• Allows negative pixel values in the resulting images.

° If this function is not enabled, all negative pixel
values are set to zero.

7. Click [-].

• Selects the image subtraction mode.

8. Click [=].

• Performs the operation and generates the new images.

• The new series appears in the Browser when the
function is complete.
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Extract Minimum or Maximum Pixel Values

One Set of Images

The following set of steps defines how to find the minimum or
maximum pixel value extraction on one image set. Depending
upon your selection, this type of extraction finds the minimum or
maximum pixel intensity, pixel by pixel, from among the images
selected. To perform this operation:

1. Click Display Desktop.

• Located on the desktop control panel.

• The Browser appears.

2. Click [Add/Sub].

• Located on the right column of the Browser.

• The Image Combination window appears.

3. Click [Clear Selection].

• Clears the selection and insures that both Select Set
button selections have no prior values.

4. Select the desired images on the Browser and click the left
[Select Set].

• Defines the set of images.

5. Click [New Save Series].

• The images save in a new series in the Browser.

• If you do not select this option, the images save in the
current saved series.

In Brief: Extract the
Minimum or Maximum
Pixels From One Set
of Images

1. Click Display Desktop.

2. Click [Add/Sub].

3. Click [Clear Selection].

4. Select the desired images
on the Browser and click
the left [Select Set].

5. Click [New Save Series].

6. Click [Min] or [Max].

7. Click [=].
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6. Click [Min] or [Max].

• Click [Min] to select the minimum pixel value extraction
mode.

• Click [Max] to select the maximum pixel value extraction
mode.

7. Click [=].

• Performs the operation and generates the new images.

• The new series appears in the Browser when image
extraction is complete.
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Extract Minimum or Maximum Pixel Values

Two Sets of Images
The following set of steps defines how to find the minimum or
maximum pixel values extraction between two sets of images.
This type of extraction finds the minimum or maximum pixel
intensity values, pixel by pixel, of all pairs of images between
the two selected sets corresponding to the same physical
location in the patient’s body. To perform this operation:

1. Click Display Desktop.

• Located on the desktop control panel.

• The Browser appears.

2. Click [Add/Sub].

• Located on the right column of the Browser.

• The Image Combination window appears.

3. Click [Clear Selection].

• Clears the selection and insures both Select Set button
selections have no prior values.

4. Select the first set of images on the Browser and click on
the left [Select Set].

• Defines the first image set.

5. Select the second set of images to extract from the Browser,
and click the right [Select Set].

• Defines the second image set.

6. Click [New Save Series].

• The images save in a new series in the Browser.

In Brief: Extract the
Minimum or Maximum
Pixels from Two Sets
of Images

1. Click Display Desktop.

2. Click [Add/Sub].

3. Click [Clear Selection].

4. Select the first set of
images on the Display
Browser and click on the
left [Select Set].

5. Select the second set of
images on the Browser,
and click the right [Select
Set].

6. Click [New Save Series].

7. Click [Min] or [Max].

8. Click [=].
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• If you do not choose this option the images save in the
current saved series.

7. Click [Min] or [Max].

• Click [Min] to select the minimum pixel value extraction
mode.

• Click [Max] to select the maximum pixel value extraction
mode.

8. Click [=].

• Performs the operation and generates the new images.

• The new series appears in the Browser when image
extraction is complete.
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Bind Images
This procedure defines how to bind images together. You can
create a new series that consists of copies of selected images
from one or more existing series. Follow these steps to bind
images together.

1. Click Display Desktop.

• Located on the desktop control panel.

• The Browser appears.

2. Click [Add/Sub].

• Located on the right hand column of the Browser.

• The Image Combination window appears.

3. Click [Clear Selection].

• Clears the selection and insures both Select Set button
selections have no prior values.

4. Select the desired set of images on the Browser and click
the left [Select Set].

• Defines the first image set.

5. Select the desired set of images to bind on the Browser and
click the right [Select Set].

• Defines The second image set.

6. Click [New Save Series].

• The images save in a new series in the Browser.

• If you do not choose this option, the images save in the
current saved series.

In Brief: Bind Images

1. Click Display Desktop.

2. Click [Add/Sub].

3. Click [Clear Selection].

4. Select the desired set of
images on the Browser
and click left [Select Set].

5. Select the desired set of
images on the Browser
and click the right [Select
Set].

6. Click [New Save Series].

7. Click [Bind].

8. Click [=].
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7. Click [Bind].

• The Bind button selects the series binding mode.

8. Click [=].

• Performs the operation and generates the new images.

• The new series appears in the Browser when the
binding is complete.

NOTE: You can concatenate copies of images from other series
to the end of the new series by following the same
procedure, being sure to set up the New Save Series
values correctly prior to clicking the [=] button.
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Subtractions Post Process Three Station Runoffs

Subtractions
After performing a three station runoff with bolus chasing using
SmartStep, it is possible to merge the top, middle, and bottom
images together for filming. It involves three separate steps of
instructions to follow. The first step involves subtracting the
arterial images from the mask images. The second step
involves acquiring a collapsed image projection with the use of
IVI. The last step is binding them into one series which also
aligns the three stations for filming. To perform the first function
of subtracting the runoffs, follow these steps.

1. Click Display Desktop.

• Located on the desktop control panel.

• The Browser appears.

2. Select the arterial images from the upper station.

• Click on the first image of the upper station in the
Browser image list, press Shift, and click on the last
image in the upper station.

3. Click [Add/Sub].

• Located on the right hand column of the Browser.

• The Image Combination window appears.

4. Click [-].

• Selects the subtraction mode.

5. Click the left [Select Set].

• Defines the upper station arterial images as the first
image set.

In Brief: Subtraction
of Three Station
Runoffs

1. Click Display Desktop.

2. Select the arterial images
from the upper station.

3. Click [Add/Sub].

4. Click [-].

5. Click left [Select Set].

6. Select the mask images
from the upper station.

7. Click right [Select Set].

8. Click [Accept Negative
Pixels].

9. Click [=].

10. Click [Clear Selection].

11. Click [New Save Series].

12. Select the arterial images
from the middle station.

13. Click left [Select Set].

14. Select the mask images
from the middle station.

15. Click right [Select Set].

16. Click [Accept Negative
Pixels].

17. Click [=].

18. Click [Clear Selection].

19. Click [New Save Series].

20. Select the arterial images
from the lower station.

21. Click the left [Select Set].
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6. Select the mask images from the upper station in the
Browser image list.

• Click on the first image of the mask upper station in the
Browser list, press shift, and click on the last image in
the mask upper station.

7. Click the right [Select Set].

• Defines the upper station mask images as the second
image set.

8. Click [Accept Negative Pixels].

• Allows negative pixel values in the resulting images.

° If not enabled, all negative pixel values are set to
zero.

9. Click [=].

• Performs the subtraction operation and generates the
new images.

• The subtraction images from the upper station are
series 100.

10. Click [Clear Selection].

• Clears the selection and insures both Select Set button
selections have no prior values to create new values for
the middle station image subtractions.

11. Click [New Save Series].

• Saves in a new series and increments your middle
station runoff to series 101.

12. Select the arterial images from the middle station.

• Click on the first image of the middle station in the
Browser image list, press Shift, and click on the last
image in the middle station.

In Brief: Subtraction
Continued

22. Select the mask images
from the from the lower
station in the Browser
image list.

23. Click right [Select Set].

24. Click [Accept Negative
Pixels].

25. Click [=].
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13. Click the left [Select Set].

• Defines the middle station arterial images as the first
image set.

14. Select the mask images from the middle station in the
Browser image list.

• Click on the first image of the mask middle station in the
Browser image list, press Shift, and click on the last
image in the mask middle station.

15. Click the right [Select Set].

• Defines the middle station mask images as the second
image set.

16. Click [Accept Negative Pixels].

• Allows negative pixel values in the resulting images.

° If not enabled, all negative pixel values are set to
zero.

17. Click [=].

• Performs the subtraction operation and generates the
new images.

• The subtraction images from the middle station is series
101.

18. Click [Clear Selection].

• Clears the selection and insures both Select Set button
selections have no prior values to create new values for
the lower station image subtractions.

19. Click [New Save Series].

• Saves a new series and increments your lower station
runoff to series 102.

20. Select the arterial images from the lower station.

• Click on the first image of the lower station in the
Browser list, press Shift, and click on the last image in
the lower station.

21. Click the left [Select Set].

• Defines the lower station arterial images as the first
image set.
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22. Select the mask images from the lower station in the
Browser image list.

• Click on the first image of the mask lower station in the
Browser list, press Shift, and click on the last image in
the mask lower station.

23. Click the right [Select Set].

• Defines the lower station mask images as the second
image set.

24. Click [Accept Negative Pixels].

• Allows negative pixel values in the resulting images.

° If not enabled, all negative pixel values are set to
zero.

25. Click [=].

• Performs the subtraction operation and generates the
new images.

• The subtraction images from the lower station is series
102.

• The three new series (100, 101, and 102) appear in the
Browser when subtraction is complete.

NOTE: Proceed to step 2, acquiring collapsed image, with IVI.
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Post Processing 3 Station Runoffs Post Process Three Station Runoffs

Acquire Collapsed Images with IVI
To perform the second step, acquiring collapsed images with IVI
for three station runoffs, use the following procedure.

1. Select the upper station subtraction series.

• The upper station subtraction images is series 100 in
the Browser series list.

2. Click [IVI].

• Located on the right hand column of the Browser.

• The Interactive Vascular Imaging (IVI) software package
launches.

3. Right-click the collapsed image and select Save Image.

• The collapsed image is in the upper left corner.

• The new saved image is listed in your Browser series
list as a “PJN” series.

4. Select File > New Model.

• Selecting a new model gives you the ability to obtain the
middle station images.

5. Select the middle station subtraction images

• The middle station subtraction images is series 101 in
the Browser series list.

6. Click [Load Slices].

7. Right-click the collapsed image and select Save Image.

• The collapsed image is in the upper left corner.

• The new saved image is listed in your Browser series
list as a “PJN” series.

8. Select File > New Model.

• Selecting a new model gives you the ability to obtain the
lower station images.

9. Select the lower station subtraction series.

• The lower station subtraction series is series 102 in the
Browser series list.

In Brief: Acquire
Collapsed Images
with IVI

1. Select the upper station
subtraction series.

2. Click [IVI].

3. Right-click the collapsed
image and select [Save
Image].

4. Select File > New Model.

5. Select the middle station
subtraction series.

6. Click [Load Slices].

7. Right-click the collapsed
image and select Save
Image.

8. Select [File] > New
Model.

9. Select the lower station
subtraction series.

10. Click [Load Slices].

11. Right-click on the
collapsed image and
select Save Image.

12. Select [File] > Quit.
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• Click [Load Slices].

10. Right-click on the collapsed image and select Save Image.

• The collapsed image is the image in the upper left
corner.

• The new saved image is listed in your Browser series
list as a “PJN” series.

11. Select File > Quit.

• Exits the IVI program.

• There are three PJN series in your Browser series list.

NOTE: You may now proceed to step 3 to bind multiple series
into a single series.
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Post Process Three Station Runoffs

Bind Multiple Series into a Single
Series

To perform the third step, binding multiple series into a single
series for three station runoffs, use the following procedure.

1. Select the upper station PJN series.

• Click the first PJN series (100) in the Browser series list.

2. Click [Add/Sub].

• Located on the right hand column of the Display
Browser.

• The Image Combination window appears.

3. Click [New Save Series].

• Series 100 is the default number.

4. Change series 100 to series 103.

• Clicking New Save Series multiple times increases the
series number.

5. Click [Bind].

• Selects the series binding mode.

6. Click the left [Select Set].

• Defines the first image set.

7. Select the middle station PJN series.

• Click the second PJN series (101) in the Browser series
list.

8. Click the right [Select Set].

• Defines the second set of images.

9. Click [=].

• Performs the operation and generates the new images.

10. Click [Clear Selection].

• Clears the selection and insures that Select Set button
selections have no prior values.

In Brief: Bind
Multiple Series

1. Select the upper station
PJN series.

2. Click [Add/Sub].

3. Click [New Save Series].

4. Change series 100 to
series 103.

5. Click [Bind].

6. Click the left [Select Set].

7. Select the middle station
PJN series.

8. Click the right [Select
Set].

9. Click [=].

10. Click [Clear Selection].

11. Click [New Save Series].

12. Change the series
number to 104.

13. Select all the images from
binded series 103.

14. Click left [Select Set].

15. Select the lower station
PJN series.

16. Click right [Select Set].

17. Click [=].

18. Click [Quit].

19. Select series 104.

20. Click [Viewer].

21. Type format 3 1 and
press Enter.

22. Film the images.
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11. Click [New Save Series].

12. Change the series number to 104.

• Clicking New Save Series multiple times increases the
series number.

13. Select all the images from binded series 103.

• Click series 103 in the Browser series list.

14. Click the left [Select Set].

• Defines the first set of images.

15. Select the lower station PJN series.

• Click on the third PJN series (102) in the Browser series
list.

16. Click the right [Select Set].

• Defines the second set of images.

17. Click [=].

• Performs the operation and generates the new images.

18. Click [Quit].

• Exits Add/Sub program and closes the Image
Combination window.

19. Select series 104 in the Browser series list.

20. Click [Viewer].

• Located on the right hand column of the Browser.

21. Type format 3 1 and press Enter in the accelerator line.

• The accelerator line is a command text box located in
the lower left corner of your Viewer.

22. Film the images.

• Select a one on one film composer format and press the
F3 key to film the images.

The following picture is a sample
of what you should have created
using the Post Processing Three
Station Runoff steps.
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Where Am I?
Volume 4

Chapter 4

Defining a Region
of Interest with

MIROI

Introduction

This chapter explains the MIROI (Multiple Image Region of Interest)
process. MIROI allows you to view signal intensity values over time.
It contains the step-by-step instructions to help you learn how to:

• Load Image Data into MIROI

• View a Single Pixel Curve

• View a Curve of more than a Single Pixel

• View a Curve Representing the Pixels within a ROI

• Change the Scale of the Graph’s Vertical Axis

• List Signal Intensity Values

• Display a Histogram

• Save the Graph Display
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In addition, this chapter answers the following questions:

1. What is a multiple image region of interest?

2. What is the MIROI layout?

3. How do you manipulate an image?

4. How do you manipulate a graph?
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About... MIROI

This section presents the concepts necessary to successfully
complete the MIROI process. Specifically, you need to
understand:

• MIROI Basics

• MIROI Layout

• MIROI Tool Panel

° Load Series

° Draw ROI

° Single and Multi-Voxel ROI Cursor

° Cursor ROI

° aA Icon

° Window/Level Presets

° Rotate Icons

° Film Composer

° Get Protocol/Delete Protocol

° Browser

° Help Menu

° Quit

• Manipulating the Image

° Show/Hide

° Smooth/No Smooth

° Display Normal

° Save View

° Movie

• Manipulating the Graph

° Set X Unit

° Set Y Unit

° List Values

° Histogram

° Save View

° Create Annotation

° Show Deviation
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MIROI Basics

The Multiple Image Region of Interest (MIROI) tool is analysis
software that allows you to graphically analyze signal intensity
values within a defined area of interest on numerous images.
This tool is useful for graphing a change in contrast
enhancement over time through a defined area.

MIROI requires multiple images from a single series with the
same scan plane, image center, and pixel size. The image set
must be time ordered, but the images are not required to be
equally spaced in time. For example, the trigger delay time for
multi-phase images does not have to be equally spaced.
Computed images, such as, screen saved, reformatted, or
projection images may not be used.

Once valid images are acquired, MIROI displays the
information in a graph that plots the change in signal intensity
over time. This graph is called a time-intensity curve. The
images and graphs can be saved and printed on film.

• Signal intensity is plotted on the y-axis.

• Time is plotted on the x-axis.

Curves are displayed as the ROIs are defined. Up to twenty
curves may be displayed at one time on a single plot. If more
than 20 ROIs are identified, only the 20 most recently defined
ROIs are displayed and plotted. Total dataset size is a function
of available memory and image matrix size.

Applications for using MIROI include contrast injection studies
to determine the acquisition delay for contrast angios. It can
also be used to determine peak flow velocity for vascular
studies by finding the correct trigger delay for gated 2D TOF
studies.

NOTE: The operator workstation’s main Viewer, 3D Analysis
Package, Reformat, IVI, and ClariView must be closed or
stopped before MIROI can be opened.

MIROI Layout

MIROI is selected from the right column of the Browser on the
Display Desktop.
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NOTE: If you have purchased the FuncTool optional software
package, it replaces MIROI with the [FuncTool] button
and MIROI functions are then accessed through
FuncTool.

MIROI opens, displaying the MIROI tool panel, the first image in
the selected set, and the time-intensity curve (TIC).

MIROI Window

The curve in the graph represents the change in pixel value for
the pixel under the cursor in all of the images.

A curve can be displayed for:

• A single pixel

• 2 to 25 pixels

• An area defined by an ROI

The time-intensity curve can be changed to a list of signal
intensity values or a histogram.
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MIROI Tool Panel
The MIROI tool panel displays to the left of the image window.

MIROI Tool Panel

The tool panel contains all of the necessary buttons to perform
the processes in MIROI.

Load Series
A selected series from the Browser is loaded into MIROI for
processing when the [Load Series] button is selected. MIROI
can accept up to 1,024 images. The first series selected is
automatically loaded when MIROI is launched from the
Browser. Subsequent selected series must be loaded into
MIROI by using the [Load Series] button.
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Draw ROI

You have the ability to draw your own ROI by clicking the Draw
ROI icon, then holding down the shift key on the keyboard and
clicking.

Single and Multi-Voxel ROI Cursor

The following icons allow you to change the cursor between a
single ROI to a multi-voxel ROI and from multiple voxels to a
single voxel ROI. Changing the ROI cursor is useful when
performing multi-voxel spectroscopy.

Cursor ROI

The cursor ROI icons place an ellipse or square ROI on the
image. The ROI statistics are also displayed. Once the ROI is
displayed, it can be resized by clicking on one of the four boxes
and dragging to desired size.

aA Icon

You have the ability to annotate your images in MIROI by the
aA icon. Annotation is helpful to clearly label your images.

Window/Level Presets

Predefined Window/Level values can be applied to an image by
selecting a preset value from the tool panel. The preset
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selections are defined using the [User Pref] button in the
Viewer.

Rotate Icons
The following Rotate icons are used to rotate or flip the
displayed image superior, inferior, left, right, anterior, or
posterior. The system annotations are immediately updated on
the image.

Film Composer
The Film Composer can be launched in MIROI by clicking the
[Film Composer] button in the lower right corner of the tool
panel.

NOTE: For additional information on the film composer, refer to
the chapter Filming Images, Volume 1.
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Get Protocol/Delete Protocol
The protocol buttons are used when performing selected
FuncTool operations to retrieve a defined protocol or to delete
an existing protocol from the system.

Browser
The [Browser] button on the tool panel allows access to the
main Browser for viewing exams.

Help Menu
The [Help] button gives access to a Help menu. This menu
provides a quick reference of commonly used commands for
manipulating and saving views and graphs. This is a toggle
button which opens and closes the Help menu.

The following table describes the options found in the Help
menu.

Keyboard Command Function

F1 Films Image

F2 Films page

F5 Saves difference image

Copy (CTRL+C) Copies the ROI

Paste (CTRL+V) Pastes the ROI

Cut (CTRL+X) Deletes the ROI

Shift Adds the ROI

Alt/Meta Density mask ROI

Space Rescales the graph
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Quit
The [Quit] button closes the MIROI window and returns you to
the Browser.

Manipulating the Image
The following table displays the image parameters that appear
red (or underlined), indicating that they may be changed via the
mouse button functions.

H Displays the histogram

S Saves screen view

W Automatic width/level

Image Parameter Description

DFOV The display field of view of the image.

rank = 15/16 The image number of the image displayed
out of the total number of images.

W/L The window and level settings.

Keyboard Command Function
4-10 2292264-100 Rev. 0 (03/01)



Defining a Region of Interest with MIROI
Note the changeable parameters in the figure below.

The changeable numbers displayed in red on the image in
MIROI window can be changed by doing one of the following:

• Clicking the mouse button to increase the number in
increments of one.

• Middle-clicking on the mouse button to change the cursor to
an arrow ⇔, then dragging the mouse left or right to
decrease or increase the number numerically.

The following functions are all accessed by placing the cursor
over the image displayed, then right-clicking and dragging
mouse button to select the feature.

• Show/Hide

• Smooth/No Smooth

• Display Normal

• Save View

• Movie
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Show/Hide
Annotation and graphic ROIs can be hidden or shown the on
the image by toggling the Show/Hide function. This key is not
available until you place annotation or a ROI on the image.

Smooth/No Smooth
The images in MIROI can be filtered by selecting Smooth. This
function toggles between Smooth and No Smooth to select or
turn off the image filtering feature.

Display Normal
In MIROI, the image can be flipped or rotated in different
directions in the image viewer. The image can be restored to its
normal orientation by the Display Normal selection.

Save View
Save View creates a screen save of the image displayed. The
images selected for a save view are stored with an image type
of "ssave" and can be accessed only through the Browser.

Movie
Selecting Movie launches the Movie window for cine display.

Manipulating the Graph
A graph is viewed in MIROI by placing the cursor or ROI on the
image. The graph displays in the viewport to the right of the
image representing the change in pixel(s) value for the pixel
under the cursor for each image in the data set.

• The numbers on the y-axis represent MR units.

• The numbers on the x-axis represent pixel intensity values
in parts per million (ppm).
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The following figure represents a time graph that displays to the
right of the image in the MIROI window.

The y and x-axis scales have changeable numbers displayed in
red (or underlined) on the graph in MIROI window. They can be
changed by doing one of the following:

• Clicking the mouse button to increase the number in
increments of one.

• Middle-clicking on the mouse button to change the cursor to
an arrow ⇔, then dragging the mouse left or right to
decrease or increase the number numerically.

The following functions are all accessed by placing the cursor
over the graph displayed, then right-clicking and dragging the
mouse button to select the feature.

• Set X Unit

• Set Y Unit

• List Values

• Histogram

• Save View

• Create Annotation

• Show Deviation
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The selections overlay the graph on the right side of the image
window.

Set X Unit
The Set X unit function allows you to toggles the x-axis of the
curve between image time and image rank. Rank is defined as
a set of images taken at a location. Rank 1 (the first set of
images taken at the first location) is the default image set
loaded when first entering MIROI. The time is represented in
milliseconds.

Set Y Unit
The Set Y unit function allows you to toggle the unit of
measurement for the y-axis of the curve between the pixels real
value and a normalized value. The normalized scale sets the
y-axis zero point to the ROI pixel value of slice number one.
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The difference between absolute, relative, and percentage may
be visualized vertically along the side of the time graph. This
option is located in the Set Y unit selection as a sub menu.

List Values/Time Graph

Selecting List values displays the values of the current curve in
a table. The voxel intensity changes may be listed by Rank
(image number) or Time (trigger delay). Either Rank or Time
can be selected in the Set X unit sub menu. Time graph returns
the curve to its usual display.

The following figure demonstrates the list values of the current
curve in a table.
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Histogram
Selecting Histogram displays the data in a histogram format.
An alternative is to type “H" from the keyboard.

Save View
Save view allows you to screen save the curve or time graph.
An alternative is to type “S” from the keyboard.

Create/Hide Annotation
Creating annotation allows you to type annotation on the graph.
Select the hide annotation feature to temporarily hide the
annotation on the graph.

Show Deviation
Selecting Show Dev. displays the deviation or measure of
variability according to pixel values within the plotted ROI.
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How to Define a MIROI
This section provides the step-by-step instructions for
performing MIROI. Specifically, it describes how to:

• Load the Image Set Into MIROI

• View a Single Pixel Curve

• View a Curve of More Than a Single Pixel

• View a Curve Representing the Pixels Within A ROI

• Change The Scale of the Graph’s Vertical Axis

• List Signal Intensity Values

• Display a Histogram

• Save the Graph Display
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Anchor Load the Image Set Into MIROI
Use the following procedure to load images into MIROI:

1. Click Display Desktop.

2. Select the images on the Display Browser.

• You can do this by clicking and dragging over a range of
images for multiple images.

• Click on one image for a single image.

• Press the Ctrl key and select images.

3. Click [MIROI].

• Located on the right column of the Browser.

• Launches the MIROI software.

NOTE: If the FuncTool software is installed on your system,
MIROI is contained within FuncTool.

In Brief: Load the
Image Set Into MIROI

1. Click Display Desktop.

2. Select the images on the
Display Browser.

3. Click [MIROI].
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View A Single Pixel Curve
Use this procedure to view a single pixel curve.

1. To view a curve from a single pixel, position the mouse
cursor on the image over the area of interest and press the
SPACEBAR on the keyboard to scale curve.

• The graph curve appears to the right of the image.

In Brief: View A
Single Pixel Curve

1. Position the mouse cursor
on the image and press
the SPACEBAR on the
keyboard.
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View a Curve of More than a Single
Pixel

Use this procedure to view a curve of more than a single pixel.

1. Place the cursor on the number adjacent to the word
“cursor” in the lower left corner of your graph viewer.

2. Middle-click (the cursor becomes ⇔ ) and drag it to the
right.

• The number one increases as the cursor is dragged
right.

° The maximum number is 25. At this point, the cursor
itself widens in size to cover the area in pixels that
was selected.

• Middle-click and dragging to the left decreases the
number.

3. View the new curve.

In Brief: View a Curve
of More than a Single
Pixel

1. Place the cursor on the
number 1 in the lower left
corner of your graph
viewer.

2. Middle-click and drag to
the right.

3. View the new curve.
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Viewing The Curve Representing The

Pixels Within A ROI

View a Curve Representing the Pixels
within an ROI
Use this procedure to create an ROI and to view the curve
representing pixels within an ROI. This feature is useful when
calculating a trigger delay for gated TOF runoffs for each
femoral artery.

1. Place your mouse cursor where the ROI drawing is to begin.

2. Press the Shift key on your keyboard, then click once.

3. While continuing to hold down the Shift key, move the
cursor to the next point and click again.

• A line connecting the first point to the second point is
drawn.

4. Move to the next position and click again until the ROI is
completed.

• Once ROI is complete, there is a closed circle around
the region of interest.

5. To edit or move an ROI, click along any edge of the ROI.

• The ROI changes color and the points along the ROI
border are clearly visible.

• Click and drag a point to resize the ROI.

• Click and drag along the border to move the ROI.

6. View the curve.

• The curve represents the pixel value changes for all the
pixels in the ROI.

• While the cursor is within the graph with curves from any
ROI, two lines (one horizontal and one vertical) appear

In Brief: View a Curve
Representing The
Pixels within a ROI

1. Place your mouse cursor
where the ROI drawing is
to begin.

2. Press the Shift key, then
click.

3. While continuing to hold
down the Shift key, move
the cursor to the next
point and click again.

4. Move to the next position
and click again until the
ROI is completed.

5. To edit or move an ROI,
click along any edge of
the ROI.

6. View the curve.
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along the individual time points, and a relative pixel
value for the ROI displays.

• To draw subsequent ROIs, click anywhere within the
image except on the current ROI.

° This de-selects the current ROI and turns its color
from green to purple.

° Now draw the next ROI in the same way as the first.

NOTE: You cannot add an ROI if you have selected Hide
Graphics from the context menu.
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Change the Scale of the Graph’s
Vertical Axis (Signal Intensity)
Use this procedure to change the scale of the graph’s vertical
axis.

1. Place the cursor over the top or bottom value (displayed in
red text) and do one of the following:

• Click to increase the value.

• Right-click to decrease the value.

• Middle-click (the cursor changes to�) and drag left or
right to increase or decrease the value.

2. Press the Spacebar to auto scale the graph.

• This places the points in the middle of the scale.

In Brief: Change the
Scale of the Graph’s
Vertical Axis (Signal
Intensity)

1. Click on the top or bottom
red value on the vertical
scale.

2. Press the Spacebar to
auto scale the graph.
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List Signal Intensity Values

Use this procedure to change the curve graph to a list of the
actual signal intensity values.

1. Position the cursor on the graph.

2. Right-click and select List Values > rank or time.

• A sub menu appears overlying the graph.

• Rank lists the values by image number.

• Time lists the values by trigger delay.

° This feature is helpful for calculating trigger delay for
gated 2D TOF studies.

In Brief: List Signal
Intensity Values

1. Position the cursor on the
graph.

2. Right-click and select List
values > rank or time.
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Listing Signal Intensity Values Display a Histogram
Use this procedure to display a histogram of the signal intensity
values.

1. Select a curve on the graph or an ROI on the image.

2. Right-click and select Histogram.

• A Histogram displaying signal intensity values replaces
the graph curve.

MIROI / Histogram

In Brief: Display a
Histogram

1. Select a curve or ROI

2. Right-click and select
Histogram.
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Save the Graph Display
Use this procedure to save your graph display.

1. Position the mouse cursor on the graph.

2. Right-click and select Save view.

• Saves the graph for later viewing and archiving.

• The image is stored with an image type of "ssave".

In Brief: Save the
Graph Display

1. Position the mouse cursor
on the graph.

2. Right-click and select
Save view.
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Where Am I?
Volume 4

Chapter 5

Creating Vascular
Projections - IVI

Introduction

This chapter explains the Interactive Vascular Imaging (IVI) process.
This post-processing tool is focuses on the creation of vascular
projection images. The Vascular Display Package, or Interactive
Vascular Imaging, creates projection images from a 2D stack or 3D
volume of Magnetic Resonance Angiography (MRA) images and
allows you to view the data from different angles.

IVI uses a ray tracing technique called Maximum Intensity Pixel
(MIP) to create projection images.

IVI allows you to modify the volume of interest to remove competing
structures, such as fat, to improve the vascular images.

This chapter contains the step-by-step instructions to:

• Select a Valid Image Set

• Modify the Volume of Interest

• Rotate the MIP Image

• Define a Batch Projection Series
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In addition, this chapter answers the following questions:

1. What types of image sets can be processed with IVI?

2. What is a MIP projection?

3. How are MIP projections generated?

4. What effect does threshold have on the volume?

5. What effect does scalpel have on the volume?

6. What are the applications?
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About... IVI
This section presents the concepts necessary to successfully
complete the IVI (Interactive Vascular Imaging) process.
Specifically you need to understand:

• Valid Image Sets

• MIP Projections

• IVI Layout

• Threshold

• Scalpel

• Applications

Valid Image Sets
A valid image set must use a white-blood technique for MIP. A
TOF (Time of Flight) or PC (Phase Contrast) pulse sequence
can be used to obtain white blood images. Vascular pulse
sequences of 2D or 3D, and fast imaging can be used.

All images must have the same orthogonal scan plane, image
center, and pixel size. Oblique images, Add/Sub images, and
Reformat images can be loaded into IVI. Screen saved images
are not allowed.

The range of images loaded for IVI post processing must not
contain two images at the same location.

Isometric voxels (cube shaped) and overlapping slices improve
the quality of IVI projection images. The FOV (Field of View),
the matrix size, and the slice thickness affect the voxel size.
The formula to determine the voxel size is: FOV / matrix = slice
thickness. For example, an image with a 256 x 256 matrix, a
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26cm FOV, and a 1 mm slice thickness results in an isometric
voxel. The imaging option Square Pixel may help to maintain an
isometric voxel especially when using a phase FOV less than
one.

MIP Projections
Maximum Intensity Pixel (MIP) projection traces a ray or angle
through a stack of 2D images or a 3D image volume. The
highest pixel intensity along the ray is projected or displayed in
the resulting image.

In white blood images, the vascular structures typically have
high signal intensity values and project into the created image.

° Along the ray (which is traced through these pixels, the
highest pixel value 80) projects into the image.

Rays can be traced through the 2D stack or 3D volume at
different angles.

Something to Think About...

• The time stamp on IVI images correspond to the time of
the landmark, not the time the source images were
acquired.
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Layout
IVI has a window and displays four viewports:

• The 3D MIP view displays in the upper-left viewport.

• An axial reformat view displays in the upper-right viewport.

• A sagittal reformat view displays in the lower-left viewport.

• A coronal reformat view displays in the lower-right viewport.

The viewport layout can be changed using the View Buttons on
the tool panel or the active annotation on the image.

• 1 - File. The following options are displayed when File is
selected.

° Rebuild - Allows you to rebuild the 3D volume using
a different protocol.

° Load Model - Allows you to load a saved “3D”
model selected on the Browser.

° Save Model - Allows you to save a 3D model.
Saved 3D models appear on the Browser in the
series list with the mention “3DOBJ” in the Type
column of the list.

° New Model - Allows you to close all windows and
return to the Browser to select a new set of images.
Once a new image is selected, select
Build Model > MR Angio.

Axial
Sagittal Coronal

3D Axial

1
2
3
4

5

6

7
8

9

10
11

12
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° Film Composer - Allows you to call up the Film
Composer window in the lower right corner of the
monitor.

° About IVI... - Tells you what version (software level)
of IVI is on your system. Select About IVI..., note the
version of IVI, and click the [OK] button to close the
About IVI... window.

° Quit - Exits IVI.

• 2 - Display Modes. The following options are displayed
when Display Modes is selected.

° Set Batch/Movie Loop - Allows you to prescribe a
film batch consisting of a sequence of reconstructed
images or allows you to set up and run a “movie”
loop via the Batch Filming/Movies window.

° Identify mm./slices - Allows you to set up slice
cross reference markings and/or a graduated ruler
scale via the Identify mm./slices window.

° Cursor Lock - Allows you to restrict 3D cursor
movement to the trace (the trace must be present)
or restrict 3D cursor movement to the x-axis or
y-axis, via the Cursor Lock window.

° Display/Actions Defaults - Allows you to set
graphics (traces and cursor) display, cursor style,
and annotation visibility via the Display/Actions
Defaults window.

° Filming Setup - Allows you to set whether the
cursor is shown or hidden on saved images and the
default film size, via the Filming Setup window.

° Color / Light / Window - Sets density window to
linear or negative via the Color / Light / Window
window.

• 3 - Select Object. When you click this button, the object
defined by the current cursor position is selected and all
the other objects not directly connected to it are deleted
from the view.

• 4 - Tilt/Rotate Mode Select. When you click this icon,
the mouse can be used to tilt and rotate the image via
the on-screen trackball. This feature is used for viewing
purposes only; these rotated images are not be saved
for future use.
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• 5 - Oblique Mode Select. When you click this icon, the
mouse can be used to move and rotate plane traces of
reformatted views (oblique or baseline reformatted) on
all views except curved, histogram, cross section, or
profile views.This is used for viewing purposes only;
these rotated images are not be saved for future use.

• 6 - View buttons. Click on the button of the
corresponding viewport and then select the desired
orientation to change the plane (or select No View to
close viewport).

• 7 - View Planes. When you click one of the
[View Planes] buttons, the 3D object returns to one of
the standard baseline views (Left, Anterior, Superior,
Inferior, Posterior and Right).

• 8 - Movement Increment.

° Selecting mm allows you to apply a specific amount
of movement to the image. The increment size is
changed in millimeters by moving the mouse pointer
into this text box, delete the existing value by
pressing the Backspace key, and enter the desired
increment value from the keyboard. Click on an
arrow button above to move the image by the
millimeters entered, and move in the direction
indicated by the arrow on the button.

• 9 - Rotation Increment.

° Selecting deg. allows you to apply a specific degree
of rotation to the image. The increment size in
degrees is changed by moving the mouse pointer
into this text box, delete the existing value by
pressing the Backspace key, and enter the desired
value from the keyboard. Click on an arrow button to
the rotate by the number of degrees entered and
rotate in the direction indicated by the arrow.
Rotation is possible only on a 3D or Oblique view.

• 10 - Modify Model. The following options are displayed
when Modify Model is selected.

° Threshold/VOI - Allows you to adjust the upper and
lower pixel level thresholds and apply scalpel cuts
via the Threshold/VOI window.

° SAVS/Paintbrush - Not applicable for IVI.

° Advanced Processing - Not applicable for IVI.
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° Filter Floaters - Allows you to set the size threshold
for filtering floaters via the Filter Floaters window.

° Undo - Allows you to undo the last operation
performed.

Something to Think About...

• The possibility of undoing the last operation is
permanently lost if the selection of the views on which
the last operation was performed is changed.

• 11 - Graphics. The following options are displayed
when Graphics is selected.

° Distance - Allows you to measure the distance
along a trace via the Graphics window. The distance
is displayed real-time in the Graphics window.

° Angle - Allows you to measure the angle between
two segments of a trace via the Graphics window.

° Area - Allows you to measure the area defined by a
closed trace via the Graphics window.

° User Annot / Trace - Allows you to enter and edit
text annotation via the Graphics window.

• 12 - Tumble. Clicking the [Tumble] button creates a
short movie loop that provides a slight rocking
movement to the 3D Model. The purpose is to enhance
the depth perception of the object. Click the [Tumble]
button again to resume normal display of the MIP
image.

Threshold
The threshold determines the range of signal intensity values
included for display in the volume of interest. Threshold is
accessed by selecting Modify Model and then selecting
Threshold/VOI.

The volume of interest can be modified by adjusting the
threshold, provided the signal intensity values of the undesired
structures differ from those of the structures of interest.

A minimum threshold displays pixels whose signal intensity
value is equal to or greater than the selected value. Any pixels
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with a signal intensity less than the selected value are removed
from the volume.

• With a minimum threshold of 20, pixels with values less
than 20 are removed from the volume.

A maximum threshold displays pixels whose signal intensity
value is equal to or less than the selected value. Any pixels with
a signal intensity greater than the selected value are removed
from the volume.

• With a maximum threshold of 20, pixels with values
greater than 20 are removed from the volume.

A range threshold can also be used to set both a minimum and
a maximum signal intensity limit.

Scalpel
The volume of interest can also be modified by cutting away
undesired structures using the scalpel feature.

Scalpel is used when physical distance separates structures.

The scalpel defines the cut line. The area outside, inside, or
along the trace created by the scalpel can be removed.
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• Outside the trace removes the area outside of the trace.

A - Shows the area removed from the volume of interest.

• Inside the trace removes the area inside of the trace.

B - Shows the area removed from the volume of interest.

A

B
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How to Create Vascular
Projections Using IVI

This section provides the step-by-step instructions for Creating
Vascular Projections using the IVI process. IVI is used to
generate projection images at different angles through a 2D
stack or a 3D volume of white-blood MRA images.

Specifically, it describes how to:

• Select the Image Set

• Modify the Volume of Interest (VOI)
° Using Scalpel
° Using Threshold

• Rotate the MIP Image

• Define a Batch Projection Series
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Anchor Select the Image Set
It is important to select only the images that meet the
prerequisites to create the Vascular Projections using IVI.

1. Click the Display Desktop icon from the control panel.

2. From the Browser, highlight the exam and series to use for
the creation of IVI Projection images.

• These are the prerequisites:

° A white-blood technique must have been used to
acquire the images. MR Angiogram images are
created by repeatedly exciting a predefined volume
of anatomy until the stationary tissue is partially
saturated and the signal from the tissue is
suppressed. Blood flowing into the predefined
volume of anatomy is not saturated but fully
magnetized by the main magnetic field and yields a
stronger signal. In the resulting image, the blood
appears bright and the stationary tissue is
suppressed.

° All images must have the same scan plane, image
center, and pixel size. Oblique images may used;
although all images must have the same obliquity.
(Screen Save images cannot be used.)

° The range of images selected must not contain two
images at the same location.

In Brief: Select the
Image Set

1. Click the Display
Desktop icon.

2. Highlight the exam and
series on the Browser.

3. Check the image
locations and deselect
any duplicates.

4. Click [IVI].
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3. Click and drag to select images to load for IVI. Check the
locations of all images selected, and deselect all duplicates
at the same location. If you press the Ctrl (control) key while
scrolling through the images, you are able to select only
those images you want to use for IVI. Or, you can make
your first image selection, hold the Shift key and make your
last image selection, and all images in-between are
selected.

4. Click [IVI] from the Browser.

Browser
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Modifying the Volume of Interest Modify the Volume of Interest

Modify the Volume of Interest Using
Scalpel
Modifying the volume of interest process allows you to remove
unwanted structures, such as fat, from the volume of interest
and determine if the unwanted structures differ by physical
distance or by signal intensity. Depending on how the structures
differ determines which method to use to modify the volume of
interest.

• Use scalpel to remove undesired structures that are
physically separate (physical distance) from the volume
of interest.

• Use threshold to remove undesired structures that differ
by signal intensity. Do not use threshold if the signal
intensity values do not differ.

NOTE: Please read the instructions for both Scalpel and
Threshold carefully. They are different procedures and
give different results.

• Threshold and Scalpel may both be applied to the same
IVI image to remove unwanted structures.

The following are step-by-step instructions how to remove
unwanted structures from the volume of interest.

1. Follow the steps to Select the Image Set, as described
previously.

• Once you click [IVI] the images begin to load.

Browser

In Brief: Modify the
Volume of Interest
Using Scalpel

1. Follow the steps for
Selecting the Image Set.

2. Make the viewport with
the 3D MIP primary.

3. Close the remaining
viewports.

4. Select the prescription
plane.

5. Select Modify Model >
Threshold/VOI.

6. Select Display Modes >
Display / Actions
Defaults.

7. Click Free Hand Trace
[On] or [Off].

8. Click [Close].

9. Place cursor at start of
trace.

10. Press Shift to move red
cursor to start point.

11. Press Shift, click and
hold to draw trace, or click
and release repeatedly.

12. Select Cut Mode, inside,
outside, or along trace.

13. Click [Apply Cut].

14. Click [Clear Trace] or
[Undo].
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hgfThe IVI window appears.

IVI window

2. Click on the 3D viewport, in the upper left view, to activate it
as the primary view.

Viewer Display

3. Close the Axial, Sagittal and Coronal viewports to decrease
the processing time. Click Axial, Sagittal, and Coronal
[View Type] in the middle of the IVI window and then click
No View. Although closing these viewports is optional, you
may want to leave them open to use as a reference.

IVI window

In Brief: Modify the
Volume of Interest
Using Scalpel

14. If necessary, change
prescription plane and
repeat steps 9-13. Go to
step 15 if plane change is
NOT needed.

15. Click [Close] from the
Threshold/VOI window.

16. Select File > Quit. To
rotate images, Do Not
Exit. See Rotating the
MIP Image or Defining a
Batch Projection Series.

P3D AXIALAXIALAxial

Sagittal
SagittallSagittall
Sagittal CoronalCoronalCoronallCoronal
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4. To change the prescription plane (plane of the IVI image),
click [L,A,S,I,P,S, or I] found on the IVI window. Clicking
one of these at any time changes the prescription plane.

IVI window

• L=Left View

• A=Anterior View

• S=Superior View

• I=Inferior View

• P=Posterior View

• R=Right View

5. Select Modify Model > Threshold/VOI.

IVI window

The Threshold/VOI window appears.
• Hint: Click and drag along the border of the

Threshold/VOI window to move into one of the closed
viewports.

Modify Model /Threshold / VOI window
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6. To set the trace mode, select Display Modes located on the
IVI window and then select Display/Actions Defaults.

• You only need to do this step to change the default; this
makes your selection the default.

The Display/Actions Defaults window appears.

Display Modes / Display / Actions Defaults

7. Select the trace mode (arrow) of your choice:

• Click [On] to turn on free trace mode.

• Click [Off] to turn on segment trace mode.

NOTE: See the chapter Reformat for more information about
Free Hand Trace.

8. Click [Close] to exit from this window.

9. On the 3D MIP image in view, position the cursor at the
starting point of your trace.

10. Press the Shift key, click and hold the left mouse click and
do one of the following:

• If using Free Hand Trace, drag the cursor around the
region of interest to trace the cut line.

• If using Segment Trace, click and release to deposit
points around the region of interest, thereby tracing the
cut line. Note the following:

° While pressing the Alt key, click and drag any
anchor located on the trace to the desired location.
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Repeat this process to make necessary edits. The
trace updates once the mouse is released.

° Repeatedly pressing the D key deletes a series of
the most recently deposited points.

11. From the Threshold window, select the cut mode. Click the
button to the right of Scalpel, and then select the desired
cut mode.

Threshold / VOI window

• The cut mode choices are:

° Inside trace - removes area inside of the trace.

° Outside trace - removes the area outside of the
trace.

° Along trace - removes the area of the trace (along
the cutline).

12. Click [Apply Cut] to remove the undesired area.

Threshold / VOI window

13. If satisfied, click [Clear trace].

Threshold / VOI window

• If not satisfied, click [Undo] and start over.

Threshold / VOI window

14. If necessary, change the prescription plane (click one of the
buttons as shown below to change plane) and repeat steps
9-14.

IVI window

• If a plane change is NOT needed go to step 16.
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15. Click [Close] to exit from the Threshold/VOI window.

NOTE: The images that have threshold applied are NOT saved
for future viewing or rotations. Go to the section Rotating
the MIP Image for the steps to rotate images and Defining
a Batch Projection Series to save your images.

16. If the images do not need saving or filming, exit the IVI
window. Select File > Quit.

IVI window
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Modifying the Volume of Interest Using

Threshold

Modify the Volume of Interest

Modify the Volume of Interest Using
Threshold
Use threshold to remove undesired structures that differ by
signal intensity. Do not use threshold if the signal intensity
values do not differ.

The following lists the instructions, step-by-step, to remove
unwanted structures from the volume of interest using
Threshold.

1. Follow the steps to Select the Image Set, as described
previously.

• Once you click [IVI] the images begin to load.

Browser

The IVI window appears.

IVI window

In Brief: Modify the
Volume of Interest
Using Threshold

1. Follow the steps to
Select the Image Set.

2. Make the viewport with
the 3D MIP primary.

3. Close the remaining
viewports.

4. Click on the prescription
plane.

5. Select Modify Model >
Threshold/VOI.

6. Select Threshold Values.

7. Click [Apply Threshold]
(or [Undo] or [Cancel
Identity] if necessary).

8. If needed, change plane
and repeat steps 6-7.

9. Click [Close] to exit
Threshold/VOI.

10. To rotate images, go to
the section Rotating the
MIP Image or Defining a
Batch Projection Series.

11. Select File > Quit.
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2. Click on the 3D viewport to activate it as the primary view.

Viewer Display

3. Close the Axial, Sagittal and Coronal viewports to decrease
the processing time. Click Axial, Sagittal, and Coronal
[View Type] in the middle of the IVI window and drag to No
View. Although closing these viewports is optional, you may
want to leave them open to use as a reference.

IVI window

4. To change the prescription plane (plane of the IVI image),
click [L, A, S, I, P, S, or R] on the IVI window. Clicking one
of these at any time changes the prescription plane.

IVI window

• L=Left View

• A=Anterior View

• S=Superior View

• I=Inferior View

• P=Posterior View

• R=Right View

5. Select Modify Model > Threshold /VOI.

IVI window

• Hint: Drag the Threshold/VOI window to the upper right
hand corner of the viewer.

AxialAxial

SagittalSagittalSagittal Coronal

3D
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The Threshold/VOI window appears.

Threshold / VOI window

6. Click and drag on either slider (1) at the top portion of the
Threshold/VOI window to adjust the threshold range.

• Or, you can place the cursor to the right or left of the
current slider position and click once to change the
value by one.

Threshold / VOI window

1

2
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NOTE: When the Threshold Range adjustment sliders are being
moved, the “Identify W/L” (2) function is automatically
activated, and allows you to visualize, in real-time, the
parts of the new object that will be kept. Everything that
is green (or hash marked on a Black/White window)
remains. Below is an example of an image with the
“Identify W/L” function active.

Viewer Display

7. Once the new values are set, click [Apply Threshold]. The
new object is displayed and the [Identify W/L] function is
automatically turned off.

Threshold / VOI window

• The image may “move” in the Viewer. To correct, place
the cursor in the Viewer, right click and drag to center
on Object.

• Clicking [Undo] removes the last threshold applied to
the image.
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• Click [Cancel Identify] removes the shading that was
applied to the image using the threshold values. Cancel
Identify on the Threshold window and toggles between
Cancel Identify and Identify W/L.

Threshold / VOI window

8. If necessary, change the prescription plane (clicking one of
the buttons shown below changes the plane) and repeat
steps 6-7.

IVI window

• L=Left View

• A=Anterior View

• S=Superior View

• I=Inferior View

• P=Posterior View

• R=Right View

9. Click [Close] to exit from the Threshold/VOI window.

NOTE: These images that have the threshold applied are NOT
saved for future viewing or rotations. Go to the section
Rotating the MIP Image for the steps to rotate images and
Defining a Batch Projection Series to save your images.

10. If the images do not need saving or filming, exit the IVI
window by selecting File > Quit.

IVI window
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Rotating the MIP ImageRotate the MIP Images
Once you have created and modified the MIP image, most
times you want to view these images from different angles.
There are three different ways in which to rotate the MIP image:
Interactive, Explicit, and Batch Projection. This section
discusses Interactive and Explicit; Batch Projection is discussed
in the next section. Interactive is similar to a “real-time” view
and Explicit allows you to program exactly which angles (views)
you want.

Something to Think About...

• The time stamp on IVI images correspond to the time of
the landmark, not the time the source images were
acquired.

1. Have a MIP image displayed in Viewer.

• If a MIP is not displayed, follow the steps from the
previous sections Select the Image Set and
Modify the Volume of Interest.

2. To rotate Interactively, click and drag one of the corner
points of the “on-screen” trackball (the square box displayed
in the viewport).

Viewer Display

• The direction of the drag determines the direction of the
rotation.

• Releasing the mouse stops the rotation.

• These images are NOT saved for future review or
filming. (Refer to the section Defining a Batch Projection
Series for information on saving and filming rotated
images.)

In Brief: Rotate the
MIP Image

1. Have a MIP image in
Viewer.

2. To rotate Interactively,
click and drag on corner
of “on-screen trackball.”
Stop the drag to stop the
rotation.

3. To rotate Explicitly,
determine method mm or
deg.

4. Enter the values in the
appropriate text box of
the IVI window.

5. Click arrow in IVI window
to rotate.

6. Stop clicking on arrow to
stop rotation.

7. Select File > Quit.
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• Place the cursor in the image, NOT on the “on-screen
trackball,” right click and then left-click [Save Image] to
save this image on the Browser.

NOTE: The larger the data set, the slower the images rotate.

° To change the default for the “on-screen” trackball,
select Display Modes > Display/Action Defaults
and click the button next to the Controls on 3D
View, to toggle between Handle and Cube.

Display Modes / Display / Actions Defaults

° Click and drag the corners of the “on-screen
trackball” to rotate with Handle or click and drag the
sides of the “on-screen trackball” to rotate with
Cube.

° Click [Close] to exit from the Display/Actions
Defaults window.

3. To rotate Explicitly, first determine the mode: Degrees (deg.)
or Millimeters (mm).

IVI window

4. Enter the value in the text box next to deg. (2) for the angle
of rotation.

• Or, enter the value in the text box next to mm (3) for the
millimeters of movement.

32

1
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5. Click the appropriate arrow (1) in the direction you want to
rotate.

• Each time the arrow is clicked, the image rotates by the
set angle or millimeters.

6. Stop clicking the arrow to stop the rotation.

• The same number of clicks, on the opposite arrow,
brings the image back to its original position.

NOTE: These images are NOT be saved for future viewing or
filming. (Refer to the section Defining a Batch Projection
Series for information on saving and filming rotated
images.)

7. If you do not want to save or film the images, exit the IVI
window by selecting File > Quit.

IVI window
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Defining a Batch Projection Series Rotate the MIP Images

Define a Batch Projection Series
The Batch Projection method allows you view the MIP images
rotating in a loop, similar to a movie. You can film, archive and
view the images directly from Batch Projection. Also, for
additional information about Batch Projection Filming and Movie
Loop see the Reformat chapter.

1. Have a MIP image displayed in Viewer.

• If a MIP is not displayed, follow the steps from the
previous sections Select the Image Set and Modify the
Volume of Interest.

2. From the IVI window, select Display Modes > Set
batch/Movie loop.

IVI window/Display Modes

The Movies window appears.

Display Modes/Set batch/Movie loop

3. Click on a viewport to make it primary.

In Brief: Define a
Batch Projection

1. Have MIP image in
Viewer.

2. Select Display Modes >
Set batch/Movie loop.

3. Make the viewport with
the MIP image primary.

4. Click [Rotation].

5. Select the arrow for
rotation direction.

6. Enter value for Number
of views or enter value
for Angle between
views.

7. Select the Output mode.

8. Click [Add Protocol] to
save protocol or
[Get Protocol].

9. Type in name for protocol,
if appropriate.

10. Click [OK].

11. Click [Apply].

12. Set additional
parameters.

13. Select File > Quit.
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4. Click [Rotation] to view the images in a 180 degree
rotation.

Set Batch / Movie Loop / Movie window

• Check that the Graphics Rx icon is selected on the
Movies window.

Movies window / Graphics

5. On the viewport, click the arrow pointing in the desired
rotation direction.

• The window/level may need to be adjusted to make the
arrows visible.

Viewer

6. On the Movies window do one of the following:

• Enter the number of views in the Number of views (A)
text box and the Angle between views automatically
adjusts for a 180° rotation.
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• Or, enter the degrees of rotation in the Angle between
views (B) text box and the Number of views
automatically adjusts for a 180° rotation.

Movies window

7. Select one of the following Output modes:

Movies window

• Select Preview to simply view the images; these
images are NOT saved to the Browser.

• Select Printer to send the images to the laser printer for
film generation. For more detailed information, see the
Reformat chapter.

• Select Save to send the images to the system disk.
These images are saved to the Browser as a separate
series and can be viewed, manipulated, and filmed via
the Viewer or the Mini Viewer.

NOTE: Preview and Save CANNOT be selected at the same
time.

8. Click [Add Protocol], to save these parameters as a
protocol.

Movies window

The Parameter window appears.

9. Type the name desired for this protocol in the text box.

Add Protocol/Parameter window

A

B
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10. Click [OK] to save the protocol and close the Parameter
window.

• To access this saved protocol, click [Get Protocol] and
then click on this protocol.

• Click [Cancel] to close the Parameter window without
saving the protocol.

Movies window

11. Click [Apply]. The system generates the rotational images.

Movies window

12. You can set additional parameters like Loop mode, and
display speed during the display.

• Click [Close] to exit the Movies window.

13. To exit the IVI window, select File > Quit.

IVI window
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Rotating MIP Images Rotate the MIP Images

Rotate Using First and Last Image
You may want to rotate the MIP images other than 180° as
previously described. The following steps describe how to
select the first and the last slice for the rotation, and to select
specific degrees of rotation allowing for unique customizing of
the rotation.

1. Have a MIP image displayed in Viewer.

• If a MIP is not displayed, follow the steps from the
previous sections Select the Image Set and Modify the
Volume of Interest.

2. From the IVI window, select Display Modes > Set
batch/Movie loop.

The Movies window appears.

Display Modes/Set batch/Movie loop

3. Select the image desired as the first image of the rotation.

4. Click on a viewport to make it primary.

In Brief: Rotate Using
First and Last Image

1. Have a MIP image in
Viewer.

2. Select Display Modes >
Set batch/Movie loop.

3. Select first image for
rotation.

4. Make the viewport with
the first image primary.

5. Click the Movie Mode
icon.

6. Click [First View].

7. Choose one method:

a) Enter value for Number
of views or enter value
for Angle between
views. OR

b) Enter value in degree
text box and direction
(arrow) for rotation.

8. Click [Final View].

9. Select the Output mode.

10. Click [Apply].

11. Select File > Quit.
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5. Click the Movie Mode icon to access the movie functions.

Movie Mode

6. Click [First View].

7. Use one of the following methods to choose the angle of
rotation and the number of images in the rotation:

• Enter a value in either the Number of views text box or
the Angle between views text box. The system
automatically calculates the other value so that when
the two values multiplied together equal 360°.

• Select the degree of rotation by entering the desired
value in the degree text box on the IVI window, and click
the arrow (from the IVI window) to set the direction of
rotation. Continue to click the arrow until you reach the
desired last image for rotation.

IVI window
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8. Click [Final View].

9. Select one of the following Output modes:

• Preview to view the images in rotation on the monitor,
these images not saved,

• Printer to print the rotated images, can only be used if
an output device is connected to the system, or

• Save to save the rotated images to the Browser.

10. Click [Apply] to start the rotation process.

• If you selected Preview and achieved the desired
rotation, you must repeat steps nine and ten, select
Save and select Apply, to save these images to the
Browser for future viewing and archiving.

• To change the start location, end location, or rotation of
images, repeat steps three through nine.

• Click [Close] to exit the Movie Mode window.

11. To exit the IVI window, select File > Quit.

IVI window

NOTE: You can save images individually to the Browser by
placing the cursor in the viewport, right-click and then
left-click on Save Image. This method is useful if you
selected the rotation or movement increment from the IVI
window (step seven).
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Deleting an IVI ProtocolDelete an IVI Protocol
As the list of IVI protocols grow, you may wish to delete unused
protocols. The following are step-by-step instructions to delete
an IVI protocol.

1. Select Display Modes > Set batch/Movie loop to open the
Movies window.

2. Click [Delete Protocol] (see above arrow) to display the list
of stored protocols.

3. Select the protocol to be deleted, and a confirmation
message apppears.

4. Click [Yes] if the correct protocol is named in the
confirmation message.

• Click [No] to exit the message window without any
deletions.

5. Click [Close] to exit the Movies window.

6. Select File > Quit, to exit the IVI window.

In Brief: Delete an IVI
Protocol

1. Select Display Modes >
Set batch/Movie loop.

2. Click [Delete Protocol].

3. Select the protocol to be
deleted.

4. Click [Yes].

5. Click [Close].

6. Select File > Quit.
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Where Am I?
Volume 4

Post-Processing and Analysis

Chapter 6

Reformat

Introduction

This chapter explains the reformatting process. The reformat
software application is designed to generate reformatted cut planes
from the acquired images. It contains the step-by-step instructions to
help you learn how to:

• Select the Image Set

• Move the Orthogonal View Locations

• Adjust the Oblique View Angle

• Define an Oblique Batch Series

• Define a Radial Batch Series

• Define a Curve

• Adjust the Plane Thickness and Rendering Mode in MPVR
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In addition, this chapter answers the following questions:

1. What types of image sets can be processed with reformat?

2. What types of cursor controls are available?

3. What types of orientation guides are available?

4. What is a curved plane reformat?

5. What is a volume reformat?
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About... Reformatting
This section presents the concepts necessary to successfully
complete the Multi-planar Reformat and Multi-planar Volume
Reformat process. Specifically you need to understand:

• Valid Image Sets

• Series/Image Selection

• Reformat Layout
° Starting the Reformat Package
° Plane Orientation Indicator
° File Menu
° Graphics Menu
° Graphics Command Window
° Tilt/Rotate Mode Select Button
° Oblique Mode Select Button
° Windowing Parameter Preset Buttons
° View Type Buttons
° Movement/Rotation Increment Buttons
° Batch Command Window
° Movie Loop Command Window
° Previewing Command Window for Film Batch or Movie

Loop
° Identify mm. / Slices Command Window
° Cursor Annotations Command Window
° Display Graphics Options Command Window
° Display Color Window Command
° Display Film Command Window
° On View Operations

• MPVR

• Applications for Reformat
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Valid Image Set
The Reformat package allows a 2D stack or 3D volume of
image data acquired in one plane to be cut and viewed in a
different plane.

• For example, image data acquired in the axial plane can be
reformatted and viewed in the coronal, sagittal, or oblique
plane.

Acquired image data can also be reformatted and viewed along
a curved plane or in a thicker plane than the original slice
thickness.

It is not possible to perform reformatted cut plane reconstruction
on just any set of images available on your MR system. Certain
requirements must be fulfilled for the images to be eligible for
use by the Reformat Package.

• All images must have the same orthogonal scan plane,
image center, and pixel size. Screen saved images are not
allowed.

• The range of images selected must not contain two images
at the same location, and the inter-slice distance must not
exceed 10 mm.

• Isometric voxels and overlapping slices improve the quality
of reformat images.

NOTE: The physician is responsible for determining if the
maximum inter-slice distance of 10 mm is acceptable for
the exam.

The Reformat Package uses the FIRST selected image in the
Browser as a basis for using/discarding the other images
selected for reconstruction. For example, any images with a
different matrix size, slice obliquity or C.T. gantry tilt from that of
the first selected image in the Browser are discarded from the
reconstruction process.

Something to Think About...

• Reformat selects a viewport with the same image plane
(sagittal, axial, oblique, or coronal) that was used to
create the protocol. If the protocol was created on a
coronal image, it applies to a coronal image, if possible,
regardless of which viewport you have selected. For
example, assume the protocol was created on a coronal
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image. If the you select an axial, sagittal or oblique view
port (red line around viewport) and then select [Get
Protocol], the protocol applies to a coronal viewport, if
there is one available. If there is no coronal viewport
available, the protocol applies to the user selected
viewport.

• Create the protocol with the same plane that is used
during the reformat session.

Series/Image Selection
Select the Display Desktop icon. Before starting the Reformat
Package, you must first select the series or set of images (that
meet the requirements, listed on the previous page) on the
system Browser. You can do this by clicking and dragging over
a range of images for multiple images or just clicking on one
image for the whole series.

NOTE: If only one image is selected on the Browser, the entire
series is used for cut plane reformation.

Reformat Layout

Starting the Reformat Package
Once you have selected the desired series or range of images
on the Browser, click on the [Reformat] button in the Browser.
The Reformat main command window with its default four-view
display (Oblique, Axial, Sagittal and Coronal) pops up.

• The oblique reformat view is displayed in the upper-left
quadrant.

• An axial reformat view displays in the upper-right quadrant.

• A sagittal reformat view displays in the lower-left quadrant.
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• A coronal reformat view displays in the lower-right quadrant.

Plane Orientation Indicator
Reformat provides a plane orientation indicator in the lower
right corner of each view. The indicator cross-references the
reformatted plane to the original (acquisition) plane image.

The oblique plane orientation indicator is located in the lower
right corner of a reformatted view during plane trace
manipulation. It can be used to help you keep track of the plane
trace being rotated or moved, with respect to the patient’s body.
This indicator consists of a cube with a stylized face including

Original
axial
plane

Location of
reformatted
coronal plane
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nose, eyes and mouth. The slice plane is displayed inside the
cube.

File Menu

Click left on [File], the following options are displayed:

File Menu

[New Model], allows you to close all windows and return to the
Browser to select a new set of images for reformation. Once a
new image set is selected, click on [Load Slices] and new
reformatted images are displayed.

[Film Composer], allows you to call up the Film Composer
window to the lower right corner of the monitor.

[Quit], exits the Reformat Package.

Graphics Menu

Click on the [Graphics] button, the following options are
displayed:

Graphics Menu

[Distance], allows you to measure the distance along a two
point trace. You can read the current Total Length and Last
Segment Length of the trace in real time when you have the
Graphics Command Window open.
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To adjust the length and angle of the distance line, hold down
ALT on keyboard then Click and drag on any Red or Green
anchor then release the mouse at the desired location. Distance
in millimeters updates upon mouse release.

Distance Image

[Angle], results in an open three-point trace (i.e. two segment)
appearing in the selected viewport, which you can edit using the
various buttons available at the top of the command window.

You can read the Angle between the two segments of the trace
in the Graphics command window which opens automatically

To adjust the length and angle of the distance line: Hold down
the ALT on keyboard then Click and drag on any Red or Green
anchor then release the mouse at the desired location.

Angle Image
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[Area], results in a closed four-point trace (i.e. polygon)
appearing on the view which you can edit using the various
buttons available at the top of the command window. You can
read the Area inside the polygon in real time when you have the
Graphics command window open.

To edit an ROI:

• Position the cursor in the viewport of interest. Press and
hold the ALT Key.

• Click on any Red or Green anchor and drag it to a desired
location.

• Area display updates upon release of the mouse.

Area Image
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Graphics Command Window
[User Annot Trace], allows you to enter and edit text
annotations via the Graphics command window.

Graphics Command Window

Create trace

This button is used to create a new freehand trace.

• Click left on the [Create trace] button. Press SHIFT key on
keyboard and Click left mouse to create freehand trace.

Delete trace

This button is used to delete the current trace.

• Click on the [Delete trace] button.

NOTE: The deleted trace remains visible on unselected views,
but disappears the next time the view is selected.

Clear point

This button is used to clear the last entered point from the trace.

• Click on the [Clear point] button to clear the last entered
point from the trace.
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Clear trace

This button is used to clear a new trace.

• Click on the [Clear trace] button. You can now create a new
trace by pressing the SHIFT key and the left mouse button.

Show trace

This button is used to display the last trace when the [Show
Graphics] button is set to [No] in the [Display/Actions
Defaults] command window and/or if the [Display] button in
the Graphics command window is set to [Intersection] for
reformatted views.

• Click on the [Show trace] button.

NOTE: This button has no effect if the [Show Graphics] button
is set to [Yes] in the Display/Actions Defaults command
window and, for reformatted views, the [Display] button
in the Graphics command window is set to [Projection].

Display

This button allows you to specify the way you want traces to be
displayed on cut-plane views. It is a toggle button between
[Projection] and [Intersection].

• Choose [Intersection] if you want only a part of the traces
that intersects the cut-plane to be displayed.

• Choose [Projection] if you want the projection of the entire
trace to be superimposed on the cut-plane.

An option that displays an entire or partial trace on all viewports,
except the viewport the original ROI was traced on.

Intersection and Projection Image
2292264-100 Rev. 0 (03/01) 6-11



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 4
Color

This button is used to change the color of the current trace.

• Click on the [Color] button and select the desired color from
the menu that pops up.

Style

This button is used to choose different styles for the current
trace, [Polyline], [3D Spline], [2D Spline] and [Cylinder].
Click on the [Style] button and select the desired trace style
option from the menu that pops up by clicking again on it.

Polyline Image

3D Spline Image
6-12 2292264-100 Rev. 0 (03/01)



Reformat
NOTE: Do not define too many points when using [3D Spline]
style to avoid unpredictable behavior of the spline
function.

2D Spline Image

[2D Spline] displays a smooth trace on reformatted slices. A
Trans field width of the trace may be displayed on views other
than the viewport the original trace was drawn on. The width of
the trace is user dependent and selected from a pop-up menu.

Cylinder Image

Trace edit box

This box enables selecting a trace for editing.

• Click and hold left on the box, drag it to the desired trace on
the image view and drop it.

Trace rotation and translation box

This box is used to rotate and translate a trace.

• Click and hold left on the box, drag it to the desired trace
and drop it.

• A box with control handles (i.e. points) appears around the
trace. Click and hold left on the center handle and drag to
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translate the trace or click and hold left on the handles at the
corners of the box and drag to rotate the trace.

Font type / Attach to Cursor

This button is used to choose the font type for annotations. The
attach to cursor attaches the annotation to the trace with a
yellow line.

• Click on the [Font type] button and select the desired font
type [normal], [italic], [bold], or [small] from the menu that
pops up.

Attach to Cursor Image

• Click to activate the [Attach to cursor] button and again to
deactivate it.

Drag and drop annotation

This text box is used to enter text for annotation anywhere on
the view.
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• Move the mouse pointer into the drag and drop annotation
text box and enter the desired annotation text from the
keyboard.

• Click/Hold on the text, drag to the approximate desired
location on the viewport and release. The annotation
appears on the view.

• To remove an annotation, Click/Hold on the annotation, drag
off the view and release.

Cursor position display

This display provides the 3D cursor position and the associated
voxel intensity in real time. The R, A, S and V values
correspond to the Right, Anterior, and Superior cursor
coordinates in mm, and the Voxel intensity, respectively.

Total Length display

This display provides the total trace length.

Last segment length display

This display provides the length of the last trace segment
entered.

• Measurement accuracy is equal to the displayed length
value + / - inter-slice distance.

Polygon area display

This display provides the area of the polygon defined by the
trace. The area is calculated by projecting the trace onto the
plane of the screen.

• If the trace endpoints are not connected, this area value
is calculated as if a segment were joining the two trace
endpoints.
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• Measurement accuracy is equal to the displayed area
value + / - (inter-slice distance)2.

Angle display

This display provides the angle between two adjacent
segments of the trace. The angle is always measured between
the last two trace segments entered.

• The angle being measured is indicated on the trace by a
small arc between the two segments.

• Measurement accuracy is equal to the displayed
segments which are five times larger than the inter-slice
distance. The accuracy improves with the length of the
segments.

Volume display

This display provides the total volume of the 3D object.
Following is a list of various factors to be considered to
appreciate the accuracy of the volume measurement:

• Measurement accuracy is equal + / - the volume of the
border layer.

• Measurement error is due to partial volume effects of the
voxels making up the 3D object.

• The smoother the object the better the accuracy.

• The higher the image resolution (512 x 512 pixels as
opposed to 256 x 256 pixels) the better the accuracy.

• The larger the object the better the accuracy. For
example, if the volume measurement on a cube-shaped
object displayed with a resolution of 256 x 256 pixels
reads 1cm3 , its true volume is between 0.729 and 1.342
cm3 (-27.1%/+34.2%) whereas if the volume
measurement on a cube-shaped object displayed with
the same resolution reads 1000 cm3, its true volume is
between 970.3 and 1030.3 cm3 (2.97%/+3.03%).

Measurement annotations

The Cursor, Total Length, Last segment length, Polygon area,
Angle displays and Volume displays described in the
paragraphs above can all be represented as moveable,
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real-time updated, on-view annotations, attached to the trace by
a “rubber band.” To do this:

• Click/Hold on the desired display, drag to the
approximate desired location on the view and release.
The measurement annotation appears on the view.

• Click/Hold on the measurement annotation and drag it
to the exact desired location and release.

• To remove a measurement annotation, Click/Hold on it,
drag off the view and release.

Close button

This button is used to close the Graphics command window.

• Click on the [Close] button to close the Graphics
command menu.

Tilt/Rotate Mode Select Button
Click left on the [Tilt/Rotate Mode Select] button, the mouse
can be used to tilt and rotate the image via the on-screen
trackball which appears on the oblique view when the Rotate
icon is selected. The onscreen trackball cursor (red cube) can
be used to rotate the oblique view by clicking and dragging on
one of the four corner handles.

Tilt/Rotate Mode Button
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The red dot cursor icon attaches to a pixel that may be
represented in all 3 planes. The Oblique viewport may be
rotated with the rotation handles.

Tilt/Rotate Mode Images

NOTE: Only the [Tilt/Rotate Mode Select] button OR the
[Oblique Mode Select] button can be activated at a given
moment.

Oblique Mode Select button
Click on the [Oblique Mode Select] button, the mouse can be
used to move and rotate plane traces of reformatted views
(oblique or baseline reformatted) on all views except curved,
histogram, cross section or profile views.

Oblique Mode Button
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Click on the red dot to move vertical, horizontal, and oblique
reference lines. All viewports updates. Click on the solid yellow
oblique line to change oblique viewport only.

Oblique Mode Images

NOTE: Only the [Tilt/Rotate Mode Select] button OR the
[Oblique Mode Select] button can be activated at a given
moment.

Windowing Parameter Preset buttons

When you click left on one of the [Windowing Parameter
Preset] buttons, or simply on the title next to it, the windowing
parameters of the selected view(s) are set accordingly.

Presets

Preset Window / Levels may be set to the site preference. To
change the Title and W/L values go to the Main viewer and
open the User Prefs menu.
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View Type buttons
Click on one of the four [View Type] buttons, a list of view type
options appears. To activate viewport options, click on any
viewport icon and make a selection from the pop-up menu.
Orthogonal planes of Axial, Sagittal, and Coronal display, as
well as the option of Oblique, Curved, Profile, Histogram (Histo)
and Cross section (X Sect.).

Viewport Button Icons

[No View]

Selecting the [No View] , causes the corresponding viewport to
disappear.

[Axial], [Sag], [Coronal]

Select one of these view types, and the corresponding views
appear in that viewport.
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[Oblique]

[Oblique] reformat allows the user to manipulate the oblique
image in any position using the rotation handles, directional
arrows, or viewplane buttons. To enable Oblique Reformation,
an Oblique viewport must be opened.

Oblique Reformatted Images

[Curved]

[Curved] reformat allows the user to trace a line, on an
orthogonal image. This line may be in any direction or on any
slice. An image is then created from that trace. To enable
Curved Reformation, a Curved viewport must be opened. Press
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the SHIFT key and click to deposit points along a line of
interest. The curved viewport updates in real time.

Curved Reformat Sagittal Viewport

Curved Viewport Outcome

[Profile]

A [Profile] view provides a gray scale along a trace.

Profile View

The profile displays the intensities of the pixels along the trace
that you created.
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The horizontal axis indicates the position in millimeters along
the trace.

The vertical axis is the pixel intensity value of that position.

Mean is the average pixel intensity value along the trace.

Std. is the standard deviation of pixel intensity values along the
trace.

The pixel intensity reference line provides a correspondence
between the 3D cursor position along the trace.

[Histogram]

A volume [Histogram] view provides voxel intensity values,
total object volume, and percentage of occurrence of each
voxel intensity value in an object.

Histogram Screen

Smoothing annotation changes the vertical axis values and
creates a smoothing effect on the histogram curve. The
percentage of occurrence values are averaged and are
attributed to the voxel intensity point.

• To change the value, move the mouse to the annotation
value on the view (number are in red next to smoothing).

° Click right to reduce the value by one, click left to
increase the value by one, or click middle mouse and
drag to change values.

The voxel volume information is for the object within the primary
view only. The tolerance for error in the Total Volume
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measurement is directly proportional to the surface area of the
object.

The Class Volume provides information about the Mean, Std.
deviation, Minimum and Maximum pixel range, Volume in cc’s,
and percentage of occurrence of pixels within the boundary
(green dotted) lines.

The voxel reference line position corresponds to the intensity of
the voxel at the 3D cursor location in the object.

• To change the line position:
° Either drag the line to the desired location, or press and

hold the SHIFT key and Click/Drag the mouse left or
right.

[X-Sect.]

A cross-section Histogram view provides a percentage of
occurrence of each pixel intensity value. In a user-defined area
on a reformatted slice, pixel statistic values and area
information is provided.

Cross-Section Histogram
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Movement/Rotation Increment buttons

Click on one of the [Movement/Rotation Increment] buttons
(one of the six buttons marked with an arrow), the selected
view(s) rotate or the 3D cursor moves in the direction indicated
by the arrow on the button. Rotation is possible only on a 3D or
Oblique view.

• The increment size in deg. or mm. can be changed by
moving the mouse pointer onto this text box, deleting
the existing value by pressing the Backspace key, and
entering the desired increment value from the keyboard.

Located directly above the increment rotation buttons is another
way to manipulate and move the images to a desired plane.

• L = Left or sagittal

• A = Anterior or coronal

• S = Superior

• I = Inferior or axial

• P = Posterior

• R = Right
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Batch Command Window

This window is accessed via [Batch]. The Batch Filming/Movie
Loop command window is used to set up one of the following:

• A film batch consisting of a sequence of oblique images.

• A “movie” loop on reformatted images.

Set Batch/Movie Loop Command Window

[Batch filming mode]

The batch filming mode allows you to do several reformations at
once, across the area of interest.

• Click on the [Graphic Rx] button in the Batch
Filming/Movie Loop command window.

The buttons and parameters found in this command window
during batch filming are described below:

Get Protocol

This menu allows the user to call up a previously stored set of
batch filming prescription parameters for use or modification.

• Click on [Get Protocol] to open a list of available batch
filming protocols and select one by clicking left on it.
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The Batch Filming/Movie Loop command window now shows
the parameters from the selected protocol and the
corresponding prescription prompts appear on the primary view.

Delete Protocol

This menu allows you to delete a previously stored set of batch
filming prescription parameters.

• Click on [Delete Protocol] to open the list of available
protocols.

• Select the protocol to be deleted by clicking on it.

• A small window pops up asking if you are sure you want
to delete the protocol. Click on [Yes] to delete the
protocol and click on [No] to cancel the delete
operation.

Add Protocol

This button saves the current set of batch filming prescription
parameters for future direct use via the [Get Protocol] menu.

• Click on the [Add Protocol] button.

• Type the desired name of the protocol in the small
window that pops up.

• Click on [OK] (or press ENTER) to confirm saving of the
protocol or on [Cancel] to abandon.

NOTE: The position and orientation of the prescription prompts
on the view are saved in a protocol. This means when a
protocol is later selected for use via the [Get Protocol]
menu, the prescription prompts appears on the view in
the same position with the same orientation. At that point,
they can be either used directly or moved and oriented
as desired.
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Oblique

This button is used to prescribe a series of parallel oblique
slices for batch filming.

• Click on this button to select this prescription mode.

° The parallel oblique prescription prompts appear on
the primary view and the parameters that are
specific to parallel oblique prescription become
visible in the Batch Filming/Movie Loop command
window.

Rotation

This button is used to prescribe a radial oblique batch on a
primary axial, sagittal, coronal or oblique view.

• Click on this button to select this prescription mode.

° The radial oblique prescription prompts appear on
the primary view and the parameters that are
specific to radial oblique prescription become visible
in the Batch Filming/Movie Loop Command Window.

Number of Views

Number of views:

This text box is used to set the number of views (i.e. oblique
slices) in the batch prescription.
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• Move the mouse pointer into this text box, and delete
the existing value by pressing the BACKSPACE key
once for each digit to be deleted.

• Enter the desired number of views from the keyboard
and press ENTER.

NOTE: For a parallel or (radial) oblique prescription, the number
of cross-reference marks, the value of the Spacing
(Rotation) annotation, the mm. between views (angle
between views) text box are updated according to the
value entered.

Angle between views text box (radial oblique prescriptions
only)

Angle between views:

This text box is used to set the rotation angle between views in
a radial oblique prescription.

• Move the mouse pointer into this text box, and delete
the existing value by pressing the BACKSPACE key
once for each digit to be deleted.

• Enter the desired rotation angle, in degrees, from the
keyboard and press ENTER.

Slice Thickness text box (parallel oblique prescriptions)

Slice Thickness:

This text box is used, in an oblique prescription, to create
oblique slices of a desired thickness.

• Move the mouse pointer into this text box, and delete
the existing value by pressing the BACKSPACE key
once for each digit to be deleted.

• Enter the desired slice thickness in mm, from the
keyboard and press ENTER.

NOTE: To obtain the minimum slice thickness just enter zero.

If slice thickness is equal to two or more voxels, the [Render
mode] button is activated. Select which rendering mode to be
used on the slices. See “Render Mode Button” section.

Field of view

Field of view:

This text box is used to set the desired field of view for the batch
being prescribed.
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• Move the mouse pointer into this text box, and delete
the existing value by pressing the BACKSPACE key
once for each digit to be deleted.

• Enter the desired field of view value, in mm from the
keyboard and press ENTER.

NOTE: A small field of view value effectively “zooms in” on the
center of each prescribed image, whereas a high value
“zooms out.”

NOTE: To facilitate subsequent on-film measurements, you may
want to set the field of view to a value which is a simple,
multiple or sub-multiple of the resulting image size on the
film.

mm. between views text box (Parallel oblique prescriptions
only)

mm. between views:

This text box is used, in a parallel oblique prescription, to set
the spacing between the slices in the prescription.

• Move the mouse pointer into this text box, delete the
existing value by pressing the BACKSPACE key once
for each digit to be deleted.

• Enter the desired distance, in mm, between slices and
press ENTER.

NOTE: The spacing between the cross-reference marks, the
value of the Spacing annotation and the Number of views
text box are updated according to the value entered.

Render mode button (Oblique prescriptions - parallel and
radial with thick slices only)

This button is used to set the rendering mode used to produce
oblique slices when the Slice Thickness is set to a value
corresponding to two or more voxels.

• Click/Hold on this button and select one of the options
from the pull-down menu.

° [Average] provides the average pixel intensity value
of the slice taken along lines perpendicular to it.
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° [MIP] provides the maximum pixel intensity value of
the slice taken along lines perpendicular to it.

° [Min] provides the minimum pixel intensity value of
the slice taken along lines perpendicular to it.

NOTE: The [Render mode] button is disabled when slice
thickness is less than two voxels.

Output select buttons

These buttons are used to select the destination of the batch.

[Preview] is used to view the batch sequence on the monitor.
No film output is generated. Its use excludes the use of the
[Printer] and [Save] options. See “Previewing a film batch or
movie loop” for more details about using this mode.

[Printer] is used to send the batch to the laser imager for film
generation.

[Save] is used to store the batch in the data base. The batch
subsequently appears in the Browser window as a new,
separate series which can be viewed and manipulated via the
Viewer or Mini Viewer application.

• Click on the desired button.

• Click on [Apply] to confirm the selection.

NOTE: The [Printer] button can only be activated if a hard copy
output device is connected to the System.

Format

Format:

Click on this button to select the format for printing.

• Select Printer from the output select buttons to enable
the [Format] button.

• Click on the [Format] button. A list of film formats
appears for the batch.

° The selected format (no. of rows x no. of columns),
appears on the surface of the [Format] button.

NOTE: The list of available formats depends on the type of laser
imager being used.

NOTE: The [Format] button is disabled when the [Printer]
Output select button is not enabled.
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Number of copies

Number of copies:

This text box allows you to enter the number of copies of film
you want. This text box is available only when the [Printer]
Output select button is enabled.

• Move the mouse pointer into this text box, and delete
the existing value by pressing the BACKSPACE key
once for each digit to be deleted.

• Enter the desired number of copies from the keyboard
and press ENTER.

Apply

This button is used to launch batch generation.

• Click on this button to launch batch generation.

NOTE: The batch is sent to the monitor, laser imager or data base
depending on the choice of [Output select] buttons. (See
Output select buttons for more information).

Close

This button is used to close the Batch Filming/Movie Loop
Command Window.

Click on the [Close] button to close the Batch Filming/Movie
Loop Command Window.
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Movie Loop Command Window

To set the Batch Filming/Movie Loop Command Window to the
movie loop mode, click on the [Movie Mode] button.

The window appears as shown below.

Batch Movie / Loop Command Window

The various buttons and parameters in this command window
during movie looping are described below.

First View

This button allows you to specify the first view to be used in the
movie loop.

• Move and/or rotate the primary view to the desired first
position using the viewplane buttons, directional arrows,
or the on-screen rotational handles.

• Click on the [First View] button to enter the first view.
The name of the first view appears on the upper left
corner of the Batch Filming / Movie Loop Command
Window; and the parameters that are specific to that
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view type become visible in the Batch Filming / Movie
Loop Command Window.

Final View

This button allows you to specify the final view to be used in the
movie loop.

• Move and/or rotate the primary view to the final position.

• Click on the [Final View] button to enter the final view.

Number of views and Angle between views

These text boxes are used to specify either a desired number of
images or an angle step size (or a distance step size for
reformatted slices) between images.

• Move the mouse pointer into this text box, and delete
the existing value by pressing the BACKSPACE key
once for each digit to be deleted.

• Enter either the number of images (minimum possible
number of images is five) or the angle step size in
degrees (or distance step size in mm for reformatted
slices) from the keyboard.

NOTE: The Angles between views text box appears only if the
primary view is an oblique image.

Along Trace

This button allows you to generate a movie sequence of oblique
slices along a trace. The use of this function is given below.

• Enter the desired trace in the usual way by pressing the
SHIFT key and clicking on left mouse button.

• Select the oblique slice as primary view.

• Click on the [Along Trace] button.

• Click on [Apply] to execute the Movie Loop along the
trace.
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NOTE: To obtain a sequence of slices perpendicular to the trace,
activate the cursor lock via: [Display Pref] >
[Cursor/Annot Tab] > [Cursor] > [Lock to Trace]
otherwise all slices are parallel to the slice defined via the
[First View] button.

Output select buttons

These buttons are used to select the destination of the movie
loop.

[Preview] is used to view the movie sequence on the monitor.
No film output is generated. Its use excludes the use of the
[Printer] and [Save] options. (See Previewing Command
Window for Film Batch or Movie Loop for more details about
using this mode).

[Printer] is used to send the batch to the laser imager for film
generation.

[Save] is used to store the movie loop in the data base. The
movie loop subsequently appears in the Browser window as a
new, separate series which can be viewed and manipulated via
the Viewer or Mini Viewer application.

• Click on the desired button.

• Click on [Apply] to confirm the selection.

NOTE: The [Printer] button can only be activated if a hard copy
output device is connected to the System.

Format

Format:

Click on this button to select the format for printing.

• Select Printer from the output select buttons to enable
the [Format] button.

• Click on the [Format] button. A list of film formats
appears for the batch.

° The selected format (no. of rows x no. of columns),
appears on the surface of the [Format] button.

NOTE: The list of available formats depends on the type of laser
imager being used.

NOTE: The [Format] button is disabled when the [Printer]
Output select button is not enabled.
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Number of copies

Number of copies:

This text box allows you to enter the number of copies of film
you want. This text box is available only when the [Printer]
Output select button is enabled.

• Move the mouse pointer into this text box, and delete
the existing value by pressing the BACKSPACE key
once for each digit to be deleted.

• Enter the desired number of copies from the keyboard
and press ENTER.

Apply

This button is used to launch movie loop generation.

• Click on this button to launch movie loop generation.

NOTE: The movie loop is sent to the monitor, laser imager or data
base depending on the choice of [Output select] buttons.
See “Output select buttons.”

Close

This button is used to close the Batch Filming/Movie Loop
Command Window.

Click on the [Close] button to close the Batch Filming/Movie
Loop Command Window.
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Previewing Command Window for Film Batch or
Movie Loop

Preview Command Window

When a movie loop or film batch is set up, the [Preview] button
is activated and [Apply] button clicked on to launch it
on-screen, the Batch Filming / Movie Loop Command Window
appears as shown above.

The various buttons and parameters in this command window
are described in the following pages:

Loop Mode

The [Loop mode] button allows the user to choose between
two different preview loop display modes. This button is a toggle
that goes between loop and rock.

The [Loop] mode is used for continuous forward display of the
preview loop; when the last frame in the loop is reached the
loop continues directly back to the first frame.

• Example: 1,2,3,4 1,2,3,4

The [Rock] mode is an alternating forward and reverse mode;
when the last frame in the loop is reached, the preview loop
goes in reverse until the first frame is reached, then the loop
goes forward again, and so on.
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• Example: 1,2,3,4,3,2,1

Display Speed

The Display speed slider allows you to adjust the preview loop
frame rate.

• Hold left on the [Display speed] slider and drag left or
right to obtain the desired display speed.

Or

• Place the mouse pointer to the right of the current slider
position and click to increase the value by one, or place
the mouse pointer to the left of the current slider position
and click to decrease the value by one.

Image index

The image index slider allows you to freeze the preview loop
and go to a desired frame in the loop.

• Place the mouse pointer to the right of the current slider
position and click to increase the value by one, or place
the mouse pointer to the left of the current slider position
and click to decrease the value by one.

Stop

This button allows you to exit the Preview Display Mode and
return to the normal Batch Filming / Movie Loop Command
Window.

• Click on the [Stop] button to exit the Preview Display
Mode and return to the normal Batch Filming / Movie
Loop Command Window.

Pause / Restart

This button allows you to freeze the preview loop during
viewing. This button is a toggle button that goes between Pause
and Restart.
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• Click on the [Pause] button to freeze the preview loop
during viewing. The button becomes the [Restart]
button.

• Click on the [Restart] button to continue displaying the
preview loop. The button again becomes the [Pause]
button.

Step

This button allows you to advance a frozen Preview Loop by
one frame.

• Click on the [Step] button to advance a frozen Preview
Loop by one frame.

Close

This button is used to close the Batch Filming / Movie Loop
command window.

• Click on the [Close] button to close the Batch Filming /
Movie Loop Command Window.

Identify mm. / Slices Command Window

Access this window via: [Display Pref.] > [Identify mm. /
Slices]

Identify mm. / Slices Command Window
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The [Identify mm. / Slices] Command Window is used to set
up slice cross reference markings and/or a graduated ruler
scale on the view.

The buttons and parameters in this Command Window are
described in the following pages.

Identify slices

This toggle button allows you to turn slice cross reference
markings on and off.

• Click on the [Identify slices] button and select [On] or
[Off] from the menu that pops up.

NOTE: Cross reference markings can only be visible if the
original slices cut the view along a horizontal or vertical
line.

Ruler style

This button sets the ruler style to one of three choices:
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None, Tick or Grid.

• Select a view as primary view and click on the
[Ruler style] button and select the desired choice from
the menu that pops up.

• Choose [None] for no ruler on the view, [Grid] for a grid
on the entire view, or [Tick] for tick marks along the side
of the view.

Close

This button is used to close the Identify mm./Slices Command
Window.
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Cursor / Annotations Command Window

Access via: [Display Pref.] > [Cursor / Annotations]

Cursor / Annotations Command Window

Show Annotations

This button allows you to specify whether or not all annotation is
visible on all views.

• Click on the [Show Annotations] button and select [Yes] or
[No] from the menu that pops up.

Cursor Icon

This button allows you to specify the 3D cursor style. This
option gives you the choice of your cursor being a dot, arrow or
crosshair.
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• Click on the [Cursor Icon] button and select the desired
cursor style option (crosshair, arrow or dot) from the menu
that pops up.

Cursor

The [Cursor / Annotations] Command Window is used to
restrict 3D cursor movement to the current trace or to restrict 3D
cursor movement to the X or Y axis.

• Click on the [Lock to Trace] button to enable restriction
of the 3D cursor to the current trace. Click again on the
same button to disable this restriction.

• Click on the [XY Lock] button to restrict 3D cursor
movement to the X or Y axis.

X and Y lines remain present throughout ROI tracing.
• Click on the [Close] button to close the Cursor Lock

Command Window.
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Display / Graphics Options Command Window

Access via: [Display Pref.] > [Graphics Options]

Display / Graphics Options Command Window

The Display/Graphics Options Defaults command window is
used to set up the way graphics (trace) are displayed, free hand
trace and measure location.

The various buttons and parameters in this command window
are described below:

Apply to buttons

These buttons allow you to specify whether the
[Show Graphics] button in this command window
applies to all views and traces or only to selected ones.

• Click on the button and select the desired view(s) from
the menu that pops up.

Show Graphics

This button allows you to turn the display of traces on and off.

• Click on the [Show Graphics] button and select [Yes]
or [No] from the menu that pops up.
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Graphics on Reformatted Views

This button allows you to specify the way traces should be
displayed on cut plane views.

Intersection vs Projection

This button is a toggle button that allows you to choose either
intersection or projection.

• Click on the [Graphics on Reformatted Views] button
and select the desired option from the menu that pops
up.

• Choose [Intersection] to display only the part of traces
that intersects the cut-plane.

• Choose [Projection] to have the projection of the entire
trace to be superimposed on the cut plane.

Free Hand Trace

This button allows you to choose a trace creation mode. It is a
toggle that allows you either straight line segments or free hand
drawing.

• Click on the [Free Hand Trace] button and select [Off]
for straight segment trace creation, or select [On] for
free hand trace creation.
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Measure Location

This button allows you to choose the measure location.

• Click on the [Measure Location] button and select
[Mouse] or [Bottom right].

Close button

This button is used to close the Display/Actions Defaults
Command Window.

• Click on the [Close] button to close the
Display/Graphics Command Window.

Display / Color Window Command

Access via: [Display Pref.] > [Color / Window]

Color / Window Command

The Color / Window command is used to select a linear or
negative density window.

The button and parameters in this command window are
described below.
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Density window

This button is used to select a linear (normal) or negative
(inverse video) density window.

• Click on the [Density Window] button and select the
desired option [Linear] or [Negative] from the menu
that pops up.

Close button

This button is used to close the Display/Actions Defaults
Command Window.

• Click on the [Close] button to close the
Display/Actions Defaults Command Window.
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Display / Film Command Window

Access via: [Display Pref.] > [Film]:

The Filming Command Window is used to specify the default
FOV on magnification and to determine whether or not the
cursor is visible on saved images.

The various buttons and parameters in this command window
are described below.

Show Cursor on Saved Images

This button is used to specify whether or not the cursor is visible
on saved images.

• Click on the [Show Cursor on Saved Images] button
and select either [Show] or [Hide] from the menu that
pops up.

Save Reformat as

This button is used to specify whether or not the images you
save are saved in the Browser as Rfmt or ssave.

• Click on the [Save Reformat as] button and select
either [Rfmt] or [ssave] from the menu that pops up.
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Default FOV on magnification (mm.)

This text box is used to specify the default FOV used when a
magnification or reduction is performed.

• Move the mouse pointer into this text box, delete the
existing value by pressing the BACKSPACE key once
for each digit to be deleted and enter the desired default
FOV, in mm., from the keyboard.

• This value is important for facilitating distance
measurements made directly on the film; when left/right
is clicked on the FOV annotation, the resulting FOV is
doubled/halved with respect to the default FOV value.
Thus you can make measurements directly on the film
and simply divide by the appropriate multiple of two to
obtain the true distance.

Printer Selected

This button allows you to choose a Printer for filming when in
Reformat.

• Click on the [Printer Selected] button and select a
filming destination from the menu that pops up.
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On View Operations
The details of all the operations that can be performed on views
is outlined in the following pages. The figure below shows a
view with the available annotations, indicators and controls that
are described in this chapter.

Oblique Reformat View

The 3D Cursor

The 3D cursor provides 3D point identification on multiple
views. The 3D cursor can appear as a crosshair, arrow or dot.

3D cursor with crosshair
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NOTE: If, instead of a 3D cursor as described above, there are
two perpendicular intersecting lines, this means that the
[XY Lock] button has been activated in the Cursor /
Annotations Command window, and the 3D cursor
position is defined by the point of intersection of the two
lines.

To move the 3D cursor (even if the XY Lock is activated),
proceed as follows:

• Move the mouse pointer to the desired location on the
view.

• Press and hold down the SHIFT key.

• As long as the SHIFT key is held down, the 3D cursor
follows the mouse movements.

• When the 3D cursor is exactly where the user wants it
release the SHIFT key to finish cursor movement.

OR

• An alternate method is to point precisely on the 3D
cursor, Click/Hold on the cursor, and drag to the desired
location and release. Because the defined point is
three-dimensional, move the 3D cursor around on one
view, the other views updates based on the changes in
direction of the cursor.

OR

To move the 3D cursor by an exact amount, use the
[Movement/Rotation Increment Buttons].

• To center the 3D cursor in the 3D field of view, use the
[Reset pointer] option in the Main On-View menu
obtained by Click/Hold the right mouse button on the
view.

• To see the numerical position of the cursor in real time,
use the Graphics Command Window accessible via the
File menu pull-down.

• To restrict cursor movement to a trace (the trace must
be present), use the [Lock Cursor to Trace] button in
the Cursor / Annotations Command Window which is
accessible via the Display Pref. menu.
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To restrict 3D cursor movement to the Xor Y axis, use the [XY
Lock] button in the Cursor Annotations Command /Window
accessible via the Display Pref. menu. The 3D cursor now
appears as the intersection of a horizontal and vertical red line,
which can be manipulated as follows:

• Click/Hold left on the line you want to move.

• Drag the line to the desired position (the other line stays
locked in place).

• Release left mouse.

• The 3D cursor is now at the new intersection of the two
lines.

• To move the 3D cursor without restriction, press and
Click/Hold on the point of intersection of the two lines
and drag to the desired position.

NOTE: The 3D cursor can be either shown or hidden on saved
images.

Main On-view Menu

This menu is accessed by Clicking/Holding right mouse
anywhere on a view except on the trackball control points, the
3D cursor or any of the annotations.

The content of this menu depends on the view type and
whether or not traces are present on the view. Only if there is a
trace on the view [Clear last point] and [Clear trace] appear in
the menu.

Click/Hold down right mouse on a view and the following
options are displayed:

• [Save image] saves the view for future display in the
Display Browser. The Reformat Package assigns a
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name to the saved view that appears in the Display
Browser.

• [Clear last point] exists only if a trace is present and
allows the user to clear the last point entered on a trace.

• [Clear trace] exists only if a trace is present and allows
the user to clear all points from the trace, enabling
restart of trace entry.

• [Enlarge] (does not exist on Profile, Histogram or Cross
Section Views), allows “zooming” in by a factor of two.
This option then becomes [Reset size] for returning to
the normal view.

• [Clear ref. image] removes the plane indicator in lower
right corner of viewport.

• [Lock orientation] (oblique views only), allows lock
view orientation (i.e. prevent rotation). This option then
becomes [Unlock orientation] for restoring rotation
ability.

• [Reset pointer] (does not exist on Profile, Histogram,
Cross Section or Curved Views), allows centering of the
3D cursor in the 3D field of view.

Orientation Annotations

The orientation annotations appear above, below, to the left and
to the right of the view. They indicate the orientation of the
model with respect to the patient’s body (Left, Right, Superior,
Inferior, Anterior and Posterior).

• When an orientation annotation is underlined (red on
color monitors), you can click any mouse button on it
and drag the mouse to orient the image. Release the
mouse button to end the scroll operation.

Patient Name Annotation

The patient name annotation is located in the upper right corner
of the view.

You can show or hide the patient name annotation as follows:

• Click/Hold right on the patient name annotation.

• Select [Show] or [Hide] from the menu that pops up.

• Release.

Window Level and Window Width Annotations

The window level and window width annotations (L and W,
respectively) are located in the lower left corner of the view.
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If the user wants windowing different from those provided by the
[Windowing Parameter Preset] buttons in the main command
window, adjust window level and width using the mouse as
follows:

• Select the view(s) the user chooses to adjust.

• Move the mouse onto one of the selected views and
Click/Hold the middle mouse button.

• Drag the mouse left or right to make the image brighter
(window level reduced) or darker (window level
increased), respectively. Release mouse when the
desired window level is reached. The L annotation
shows the new value.

• Drag the mouse left or right to make the image sharper
(window width reduced) or smoother (window width
increased), respectively. Release mouse when the
desired window width is reached. The W annotation
shows the new value.

Slice Annotation (Acquisition Views Only)

This annotation is located in the upper left corner of acquisition
views. It can be used to “page” through the acquisition slices as
described below.

• Point to the slice’s annotation number “Im: xx". Click to
move up one slice or right to move down one slice. The
slice annotation shows the new value.

• Point to the slice’s annotation number “Im: xx”. Hold
down the middle mouse button and drag left to move
continuously downward in the stack or drag right to
move continuously upward in the stack. The slice
annotation shows the new value.
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Field of View Annotation

This annotation is located in the lower left corner of the view. It
can be used to “zoom” in or out on a view by a factor of two as
described below.

• Point to the field of view annotation “FOV”. Click to half
the current FOV, or Click right to double the current
FOV. The annotation shows the new value.

OR

• Place your mouse over the FOV and depress your
middle mouse and slide left or right and FOV changes in
1cm increments.

Creating and Editing Traces

Be aware that traces are 3D graphics and become part of the
object in all non-icon views. This means that a trace can be
created in one view and then edited in another view.

There are two types of traces that can be edited:

• Segment trace (define a series of points which the 3D
Reformat Package connects together with straight line
segments.

° To create segment traces, first ensure that the [Free
Hand Trace] button in the [Display Pref. Menu] and
located under [Graphics Options] is set to [Off].
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° Holding the SHIFT key down, Click/Drag and
release the mouse button at the first desired point.

° Still holding the SHIFT key down, Click/Drag and
release mouse button at the next desired point.
During dragging, a rubber band appears between
the last point entered and the current mouse
position.

° To clear the last defined point, Click right on the view
and select [Clear last point] from the Main on-view
menu that pops up, or press D on the keyboard.

° To clear the entire trace and start again, Click right
on the view and select [Clear trace] from the Main
on-view menu that pops up, or press Control+U on
the keyboard.

• Free hand trace (the trace follows mouse movement
during creation).

° To create free hand traces, first ensure that the
[Free Hand Trace] button in the [Display Pref.
Menu] and located under [Graphics Options] is set
to [On].
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° Holding the SHIFT key down, Click (do not hold) to
activate tracing.

° Still holding the SHIFT key down, move the mouse
to define the free hand trace.

° Release the SHIFT key to stop tracing. To restart
tracing, again hold the SHIFT key down and Click
(do not hold) left. (A straight line segment is drawn
from the end of the trace to the current mouse
pointer position.) Again, move the mouse to define
your trace.

° To clear the last defined point, stop tracing by
releasing the SHIFT key, then Click right on the view
and select [Clear last point] from the Main on-view
menu that pops up, or press D on the keyboard.

° To clear the entire trace and start again, stop tracing
by releasing the SHIFT key, then Click right on the
view and select [Clear trace] from the Main on-view
menu that pops up, or press Control+U on the
keyboard.
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Editing Traces

To access the Drop to Edit box click left on [File] and select
[Graphics], and then select [User Annot. / Trace]. The
[Drop to Edit Box] is shown below.

• Click/Hold on the [Drop to edit] box, Drag it onto the
desired trace on the image view and drop it.

• Click on any of the points and Click on the defined point
to be moved and drag to the new location.

• Release the left mouse button to enter the new point
location.

NOTE: To quickly clear a point, Drag it to any other existing point
and release left mouse button.

MPVR (Multi-Planer Volume Reformat)
Multi-planar volume reformat allows the adjustment of the
reformat plane/slice thickness and rendering mode.

Reformat defaults to a one voxel thickness. MPVR allows the
voxel thickness to be adjusted from 2 to 50 voxels.

MPVR allows the selection of rendering mode:

• Average provides the average pixel intensity of the
reformat slice.

• MIP provides the maximum pixel intensity of the
reformat slice. (brightest pixels)

• Min provides the minimum pixel intensity of the reformat
slice. (darkest pixels)

MPVR defaults the rendering mode to Average.
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Applications For Reformat
Reformat is used to display a 2D stack or 3D volume of image
data in orthogonal, oblique and curved planes other than the
original acquisition plane.

Use reformat to acquire in one plane but display and view in
other planes.

Use reformat for anatomy that lies along complex or difficult
angles to scan.

Use curved reformat for scoliosis spines and other anatomy that
does not lie in a single plane.

Use MPVR for cholangiograms, myelograms, urograms and
abdominal MRA.
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How To Use Reformat
This section provides the step-by-step instructions for utilizing
reformat. Specifically it describes how to:

• Select the Image Set

• Moving the Orthogonal View Locations

• Adjusting the Oblique View Angle

• Defining a Oblique Batch Series

• Defining a Radial Batch Series

• Defining a Curved Reformat View

• Adjusting the Plane Thickness and Rendering Mode with
MPVR
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AnchorSelecting the Image Set
Use this procedure to select the image data set.

1. Click the [Display Desktop] icon.

2. Highlight the series or range of images on the Display
Browser. (A 3D sequence is recommended). Click/Drag for
selected images.

3. Check the image locations and deselect any duplicates.

4. Click on [Reformat] to launch the software package.

In Brief: Selecting the
Image Set

1. Click the [Display
Desktop] icon.

2. Highlight the series or
range of images on the
Display Browser.

3. Check the image
locations and deselect
any duplicates.

4. Click on [Reformat] to
launch the software
package.
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Displaying and Manipulating Plane Traces Moving the Orthogonal View
Locations
The view location can be adjusted several ways:

1. Position the mouse cursor over area of interest, and press
SHIFT key to move the 3D cursor to update the views.

OR

• Enter an increment value in the mm. text box, and Click
the appropriate arrow.

OR

• Position the mouse cursor on the red slice location
annotation.

° Click left to increase.

° Click right to decrease.

° Click and hold down middle mouse, and drag right to
increase or left to decrease.

In Brief: Moving the
Orthogonal View
Locations

1. Position the mouse cursor
over area of interest, and
press SHIFT to move the
3D cursor to update the
views.
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Adjusting the Oblique View AngleAdjusting the Oblique View Angle

The oblique reformat plane can be adjusted several ways:

1. To use the on screen trackball cursor, click the [Tilt Rotate]
icon.

2. Position the mouse cursor on one of the corner handles of
the on-screen trackball cursor.

3. Click/Hold and drag the on-screen trackball cursor.

OR

To use the Oblique Mode Cursor

1. Click on the orthogonal image that you want to use to adjust
the oblique plane.

2. Click the [Oblique Mode] icon.

3. Position the mouse cursor on the solid tilt line.

4. Click/Hold and drag the tilt cursor.

5. OR, enter a rotation value in the degree increment text
box and Click the appropriate arrow.

In Brief: Adjusting the
Oblique View Angle

1. Click the [Tilt Rotate]
icon

2. Position the mouse cursor
on one of the corner
handles of the on-screen
trackball cursor.

3. Click/Hold and drag the
on-screen trackball
cursor.
2292264-100 Rev. 0 (03/01) 6-63



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 4
Defin Defining an Oblique Batch Series
To define a entire set of batch reformations:

1. Highlight the desired set of images.

2. Click on [Reformat] to launch the Reformat Package.

3. Select the viewport you wish to use to create the batch
series.

4. Click [Batch] button to activate the Batch/Movie Loop
Command Window.

5. Click [Oblique] button.

6. Click on the [Graphic Prescription] icon. (This icon may
already be selected).

7. To define the reformat locations, Click/Hold and drag one of
the batch end markers to the start location.

8. Click/Hold and drag the other batch end marker to the end
location.

9. Click/Hold and drag the slice center reference line to
re-position the entire prescription.

In Brief: Defining an
Oblique Batch Series

1. Highlight the desired set
of images.

2. Click on [Reformat].

3. Select the viewport you
wish to use to create the
batch series.

4. Click [Batch] button.

5. Click [Oblique] button.

6. Click on the [Graphic
Prescription] icon.

7. Click/Hold and drag one
of the batch end markers
to the start location.

8. Click/Hold and drag the
other batch end marker to
the end location.

9. Click/Hold and drag the
slice center reference line
to re-position the entire
prescription.

10. Enter in text boxes:

• Number of views.

• Millimeter between
views.

• Slice thickness.

• FOV

11. Select outputs.

12. Click [Apply].
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10. Enter the appropriate values in the text boxes for:

• Number of views. (number of slices)

• Millimeter between views.

• Slice thickness.

• Field of view.

° If the slice thickness is greater than one voxel, Click
the [Render mode] button and select render mode
type.

11. Select the output.

• Click [Printer] to send the images to the laser camera.

• Select the film format from the pull-down menu.

• Click [Save] to send the images to the system disk as a
new series.

12. Click [Apply].
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Defining a Radi Defining A Radial Batch Series

To define a entire set of radial reformations:

1. Highlight the desired set of images.

2. Click on [Reformat] to launch the Reformat Package.

3. Select the viewport you wish to use to create the radial
batch series.

4. Click [Batch] button to activate the Batch/Movie Loop
Command Window.

5. Click [Rotation] button.

6. Click on the [Graphic Prescription] icon. (This icon may
already be selected).

7. To define the reformat locations, Click/Hold and drag one of
the batch end markers to the start location.

8. Click/Hold and drag the other batch end marker to the end
location.

9. Click/Hold and drag the slice center reference line to
re-position the entire prescription.

In Brief: Defining A
Radial Batch Series

1. Highlight the desired set
of images.

2. Click on [Reformat].

3. Select the viewport you
wish to use create the
batch series.

4. Click [Batch] button.

5. Click [Rotation] button.

6. Click on the [Graphic
Prescription] icon.

7. Click/Hold and drag one
of the batch end markers
to the start location.

8. Click/Hold and drag the
other batch end marker to
the end location.

9. Click/Hold and drag the
slice center reference line
to re-position the entire
prescription.

10. Enter in text boxes:

• Number of views.

• Degrees between
views.

• Slice thickness.

• FOV

11. Select outputs.

12. Click [Apply].
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10. Enter the appropriate values in the text box for:

• Number of views. (number of slices)

• Degrees between views.

• Slice thickness.

• Field of view.

° If the slice thickness is greater than one voxel, click
the [Render mode] button and select render mode
type.

11. Select the output.

• Click [Printer] to send the images to the laser camera.

• Select the film format from the pull-down menu.

• Click [Save] to send the images to the system disk as a
new series.

12. Click [Apply].
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DE Defining a Curved Reformat View
A curved reformat is useful to use on patients with scoliosis,
optic nerves, and other anatomy that does not lie in a single
plane.

To define a curved reformat view:

1. Highlight the desired set of images.

2. Click on [Reformat] button to launch the Reformat
Package.

3. Click on [Oblique] viewport button and from pull-down
menu change to a [Curved] viewport.

4. Select the viewport you wish to use to create the curved
reformat.

In Brief: Defining a
Curved Reformat
View

1. Highlight the desired set
of images.

2. Click on [Reformat].

3. Click on [Oblique]
viewport button and from
pull-down menu change
to a [Curved] viewport.

4. Select the viewport you
wish to use to create the
curved reformat trace.

5. To define the curved
plane, position the mouse
cursor at the starting point
on the desired image.

• Press SHIFT, Click left
and release to deposit
the point.

• Continue to press
SHIFT, re-position
cursor, Click left and
release to deposit the
next point.

6. The defined curved plane
updates in the curved
reformat viewport, (upper
left viewport).
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5. To define the curved plane, position the mouse cursor at the
starting point on the desired image.

• Press SHIFT, Click left and release to deposit the point.

• Continue to press SHIFT, re-position cursor, Click left
and release to deposit the next point.

• Complete the definition of the curved plane.

6. The defined curved plane updates in the curved reformat
viewport, (upper left viewport).
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M Adjusting The Plane Thickness and
Rendering Mode with MPVR
Multi-planar volume reformat allows the adjustment of the
reformat plane slice thickness and rendering mode.

To adjust the plane thickness:

1. Highlight the desired set of images.

2. Click on [Reformat] to launch the Reformat Package.

3. Move the cursor into the Oblique viewport, which is now the
MPVR viewport, (Oblique viewport if upper left view).

4. To adjust the voxel thickness, position the mouse cursor on
the red slice thickness annotation. (See arrow below)

• Click left to increase the thickness.

• Click right to decrease the thickness.

• Click the middle mouse and Drag the mouse to change
the value in real-time.

5. Press SPACEBAR to execute the calculation.

To adjust the rendering mode:

6. Position the mouse cursor on the red rendering mode
annotation on the MPVR image.

7. Click and Hold down right mouse. A pull down menu
appears and you can drag to select a rendering mode.

• Avg

• mip

• min ip

8. Press the SPACEBAR to execute the new rendering mode.

9. To return to a normal oblique image, change the slice
thickness annotation to its minimum value.

In Brief: Adjusting
The Plane Thickness
and Rendering Mode
With MPVR

1. Highlight the desired set
of images.

2. Click on [Reformat].

3. Move the cursor into the
Oblique viewport

4. Position the mouse cursor
on the red slice thickness
annotation.

5. Click the middle mouse
and Drag to change the
value in real-time.

6. Press SPACEBAR.

7. To adjust rendering mode
position the mouse over
the red rendering mode
annotation and Click and
hold down right mouse. A
pull down menu appears
to select rendering mode.

8. Press SPACEBAR.
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Chapter 7

Creating 3D
Models

Introduction

The Three Dimensional (3D) Analysis option is a purchasable
software application designed to generate reconstructed 3D
volumes and reformatted cut planes on an MR series. The program
allows you to build your own model or use a preset protocol such as
MR Angio and MPVR (Multi-Projection Volume Reconstruction).

Images must meet certain requirements to be used in the 3D
Analysis package:

• FOV (Field of View), matrix size, orientation, and display center
must be the same for images in the set.

• Oblique acquisitions cannot be supported for right/left decubitus
patient orientations.

• All images must be at different locations in the set.

• The set should include only axial, sagittal, coronal, or oblique
images; other types of images such as screen saves, multi-slab,
or multi-angle images are not supported.

• Interslice distance must be less than 10 mm.
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3D Analysis uses the first selected image in the data set as a
basis for using/discarding the other images selected for
reconstruction. Any images having a matrix size or requirement
different from that of the first selected image are discarded from
the reconstruction process. Therefore, carefully choose the
data set for 3D Analysis.

Access the 3D Analysis option from either the Browser or the
[Image Analysis] button located on the Viewer. Detailed steps
to perform the 3D Model can be found in the Advantage
Windows User Guide on Volume Analysis, direction number
2221268.
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Where Am I?
Volume 4

Chapter 8

Analyzing Images
with FuncTool

Introduction

This chapter explains the process of analyzing images with
FuncTool. It is a post-processing tool which has multiple functions.
Some of the functions include post-processing techniques for Bold,
Diffusion and Contrast Enhanced Imaging. This chapter contains
key concepts as well as step-by-step instructions to help you learn
how to:

• Display images within FuncTool

• Display graphs within FuncTool

• Create parametric images

• Adjust composite overlays

• Save images from FuncTool

• Film images from FuncTool

• Display 3D Focal CSI Images

• Create 3D Focal CSI Custom Protocols

NOTE: FuncTool is a purchasable post-processing option.
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In addition, this chapter answers the following questions:

1. What types of image sets can be processed with FuncTool?

2. What are time-intensity curves?

3. What are algorithms?

4. What are parametric images?

5. What are the applications of FuncTool?

6. How are the viewports laid out in FuncTool for 3D Focal CSI
images?
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About... FuncTool

This section presents the concepts necessary to successfully
complete the FuncTool Post-processing process. Specifically
you need to understand:

• Description of FuncTool

• Valid Image Sets

• FuncTool Layout

• Algorithms

° Correlation Coefficient

° Positive Enhancement Integral

° Negative Enhancement Integral

° Mean Time to Enhance

° Maximum Slope of Increase

° Signal Enhancement Ratio

° Maximum Difference Function

° Difference Function

° Average

° Diffusion Coefficient

° Exponential Diffusion Coefficient

° Ratio (A-B)/(C-D)

° MR Spectroscopy Protocols

• Applications

• 3D Focal CSI Viewport Layout

° The Chemical Shift or Upper Left Viewport

° The Spectral Grid or Upper Right Viewport

° The Metabolite Image or Lower Left Viewport

° The Reference or Lower Right Viewport

Description of FuncTool

FuncTool is an optional image analysis software package, that
processes dynamic image data to generate information with
regard to changes in image intensity over time in the form of
graphs and parametric images.
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Valid Image Sets
A series of images must be acquired at the same scan location
but at different moments in time, to be compatible with
FuncTool. These series are called time-ordered or multi-phase
series.

More specific, a valid image set must have the same scan
plane, image center and pixel size. Up to 1024 images can be
loaded from a single or multiple series. Signa LX, Signa
Horizon, Signa Advantage, Signa Contour and Signa Profile
images are all compatible, with a few exceptions; no screen
save, reformatted or projection images are allowed.

Recommended pulse sequences are 2D GRE/SPGR, 2D fast
GRE/SPGR, 3D GRE/SPGR, 3D fast GRE/SPGR and EPI.

Something to Think About...

• A “time course” or “dynamic” data set is a time ordered
acquisition with either a sequential change in scan time
for each scan image or a trigger delay (multi-phase
scan). The horizontal scale of a graph for such a data
set represent time.

• A diffusion-weighted data set is an ordered acquisition
with sequential changes in b-values. The horizontal
scale of a graph for such a data set represent b-values.

• A MR spectroscopy data set is an ordered acquisition
with sequential changes in frequency. The horizontal
scale of a graph for such a data set represent parts per
million (ppm values).

NOTE: You should be aware that for MR and CT data sets that
do NOT contain multiple images for each location in
the data set, graphs or function views generated are
generally meaningless. If tried a message appears
saying “Not a time series.”
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FuncTool Layout
FuncTool is accessible from the Display Browser, on the right
side of this screen. Initiating FuncTool from the Display Browser
allows the Functool panel to display. This panel contains the
selections for algorithms, protocols, ROI definition, W/L
adjustment and film composer.

A brief description of the buttons are as followed:

• Load Series - Loads the selected series
from the Display Browser into FuncTool.

• Function - Provides a list of algorithms used to
create a parametric image.
° When displaying the CSI data, the Function menu allows

a number of choices. These choices differ from the
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selections on the [Get Protocol] menu, because the
Function menu selections cannot be modified and
include no information concerning the definition of the
protocols.

NOTE: A list of all algorithms and their functions are discussed
in the next section.

• Predefs - Is an area where seven previously saved
window/level settings are.

NOTE: Predefs are the same as those set in the viewer.

• Annotate - Creates user annotation on images
within the FuncTool screen. Multiple areas of annotation can
be added to an image and later deleted using the Copy,
Paste or Cut special function key or Control-C (copy),
Control-V (paste) or Control-X (cut) on the keyboard. To
move an annotation to a different location on the screen,
click, hold and drag the annotation with the left mouse to the
desired location.

• Polygon/Spline - Creates a polygon or spline
region of interest. A polygon is a ROI with three or more
straight sides. A Spline is the same polygon ROI with
curved corner points.

NOTE: This is a toggle button which allows you to choose either
a polygon or spline shape. The system defaults to first
displaying the polygon. This button is inactive until the
first side of the ROI is defined.

• Split ROI and Merge ROI - Splits an ROI into
multiple single-pixel ROIs, or restores the original ROI.

• ROI - creates an ellipse or square region of
interest (ROI) that’s used to plot time intensity information
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and perform statistical analysis on a specific region. ROI’s
may be cut, copied or pasted using the special function keys
or the Control-X (cut), Control-C (copy), or Control-V (paste)
options. The ROI calculates and displays in the lower left
corner of the image, the following information:

° The area enclosed by the graphic in mm2.
° The mean or average value of the pixels enclosed by the

graphic.
° The standard deviation (DEV) of the pixel values

enclosed by the graphic, which provides a measure of
variability according to pixel values.

° The number of pixels for the cursor and the area
calculated is displayed on the graph viewer.

Something to Think About...

• Before an ROI is defined, the cursor on the reference
image reports a dynamic time curve and updates the
graph and the value posted with each cursor movement.
Press the Shift key to deposit an area of interest and
freeze the time graph posted to the graph view.

• To draw subsequent ROI’s click left anywhere within the
image except on the current ROI. This effectively
de-selects the current ROI and turn its color from green
to purple. (If you have a color monitor.)

• Accuracy of on-view measurements - regardless of the
zoom factor being used to view images, region of
interest statistics are calculated based on the pixels
from the original unzoomed image data.

• Accuracy with region of interest area graphics - area
measurement accuracy using a region of interest
graphic (rectangle, smooth curve, ellipse or free draw) is
equal to the displayed are value +/- the circumference of
the region multiplied by (image pixel size)2/2. Mean and
standard deviation values for the intensity of the pixels
in the region are also affected by this accuracy. Region
of interest statistics are based on the pixels inside the
graphic defining the region.

• Rotate Buttons - Changes the
orientation of the images. Use the Rotate buttons to change
the orientation of the images. To return to the original
display, right-click on the image and select [Display
Normal] from the shortcut menu. You cannot flip or rotate
graphs.
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Something to Think About...

• L, R, A, P image orientation annotations updates on the
image.

• Does not flip or rotate the graphs.

• To return to image to normal orientation, right click,
anywhere on the image, to select [Display normal]
from the pop-up menu.

• Film Composer - Displays the film composer
menu.

• Browser - Brings up the Browser menu,
which list Exams, Series and images. This button can be
used to select another series to replace the series currently
loaded in FuncTool.

• Get Protocol - Displays a list of previously
saved FuncTool protocols. From this menu you can load a
protocol from the saved list.

• Del. Protocol - Displays a list of previously
saved FuncTool protocols. From this menu you can delete
protocols from the saved list.

• Help - Provides a quick reference of commonly
used commands.

° Once [Help] is selected, the [Function] key changes to
[Function Help] and only displays the list of algorithms.
The Function menu is not operational until [Help] is
toggled off.

° Each [Function] algorithm and [Get Protocol] also
contains a [Help] button. This button allows a pop-up
window that contains information specific the function
selected.

• Quit - Closes the FuncTool software. After
closed the screen displays the Display Browser window.
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The FuncTool viewer uses a four quadrant display:

° A reference image is displayed in the upper-left
quadrant. The number of reference images depends on
the number of images in the time-ordered or multi-phase
series.

° The time-intensity curves are displayed in the upper-right
quadrant. They map the change in signal intensity over
time and display the information as a graph, histogram or
table.

On a time graph, the time of occurrence is plotted on the
x-axis and signal intensity is plotted on the y-axis. It
represents the change in pixel values for the pixel under
the cursor for every image in the data set.

Reference Image Time Intensity Curve

Parametric Image Composite Image
2292264-100 Rev. 0 (03/01) 8-9



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 4
On a histogram the signal intensity is plotted on the
x-axis and the frequency of occurrence is plotted along
the y-axis. The height of the bar is determined by
frequency.

In a table the average signal intensity for a ROI is listed
in MR unit values for each image.

° Parametric images are displayed in the lower-left
quadrant. They emphasize the physiological information
extracted from the signal intensity values. In a parametric
image, the color scale (or gray scale) is based on
calculated values.

° A composite overlay of the parametric image and a
reference or anatomic image are displayed in the
lower-right quadrant.

NOTE: Only the two upper views are initially displayed.

Algorithms

Algorithms are mathematical equations that are used to analyze
the signal intensity values. They extract information about
changes in the signal intensity values that the human eye
cannot appreciate in the image. FuncTool algorithms are found
by pressing the [Function] or [Get Protocol] key. Each
algorithm has a separate function and meaning.

NOTE: Algorithms discussed are either found under the
[Function] or [Get Protocol] buttons.

Correlation Coefficient

This algorithm is a relationship of the time course image
intensity values to a user-specified “reference” function. It
provides a pixel by pixel value that represents correlation of the
time course data sets with a user-specified reference pattern.
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Applications for this algorithm may include a Blood Oxygen
Level Dependent (BOLD), or task activation image set. A BOLD
image sequence is typically a single shot, multiphase, GRE-EPI
sequence with a limited number of slice locations and a high
number of phases.

• During the acquisition, a task (stimulation) is performed
on and off. Task activation or stimulation of an area of
the brain increases the oxygen level which increases
the T2* and resulting signal intensity. The type of
task/stimulation depends on the area of the brain of
interest.

• BOLD imaging is typically used in surgical planning to
identify areas of task activities within the brain. It is also
used for cognitive studies, psychiatric evaluation and
treatment monitoring.

Positive Enhancement Integral
This algorithm displays pixels based on the amount of contrast
that passed through the region(s) of interest. It is used to
analyze dynamic contrast studies that capture T1 shortening
effects of a contrast bolus. T1 shortening produces a positive
enhancement or signal increase.

More specifically, it is time-course data acquired during the
injection of an MR contrast agent, which may have image
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intensity variations caused by changes in the magnetic
resonance relaxation rate constant T1, resulting in positive
enhancement. This function calculates the sum of the area
underneath the time intensity curve within the user-specified
range.

Applications for this algorithm may include contrast enhanced
Breast imaging. Pulse sequences used are EPI, GRE, FGRE,
SPGR or FSPGR.

NOTE: This algorithm is a predefined protocol not found under
the function button.

Negative Enhancement Integral

This algorithm displays pixels based on the amount of contrast
that passed through the region(s) of interest. It is used to
analyze dynamic susceptibility studies that capture the T2*
shortening effects of a gadolinium bolus. T2* shortening
produces a negative enhancement or signal decrease.

More specifically, it is time course data acquired during the
injection of an MR contrast agent. This may have image
intensity variations caused by changes in the magnetic
resonance relaxation rate constant T2*, which result in a
negative enhancement. This function calculates the sum of the
area above the time intensity curve within the user specified
range.

An application for this algorithm is dynamic susceptibility
imaging (contrast enhanced imaging). This is typically used for
stroke evaluation in conjunction with a diffusion sequence. Also

Positive Enhancement
Integral display pixels
based on variations in the
volume of contrast.
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used to evaluate tumors (grade, recurrent and primary) and
dementia. Pulse sequences used is a single shot, multi-phase
SE-EPI pulse sequence acquired at 8-12 location with 30-40
phases.

Mean Time to Enhance
This algorithm is used to analyze dynamic susceptibility and
dynamic contrast studies and allows you to differentiate areas
that reach peak contrast at different times. It displays pixels
based on the time (from start) to peak contrast enhancement.

More specifically, for time-course data that exhibits a transient
increase or decrease. The Mean Time to Enhance algorithm
returns a value that characterizes the temporal position of the
transient increase or decrease within the time-course. Transient
increase or decreases that occur later in the time course have
larger Mean Time to Enhance values and earlier increases or
decreases have smaller first moment values.

Negative Enhancement
Integral images display
pixels based on variations
in the volume of contrast.

Mean Time to Enhance
images display pixels based
on variation in peak contrast
times.
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Maximum Slope of Increase

This algorithm is used to analyze dynamic contrast studies and
allows you to differentiate areas based on the rapidity of
contrast enhancement. Calculations done with the maximum
slope of increase displays pixels based on the rate of contrast
enhancement of uptake.

More specifically, with time-course data exhibiting a transient
increase, the Maximum Slope of Increase algorithm returns a
value that characterizes the maximum slope of increase.
Transient increases that occur rapidly have larger maximum
slope of increase values and those occurring gradually have
smaller maximum slope of increase values.

Signal Enhancement Ratio

This algorithm displays pixels based on a ratio value. The
numerator of the ratio is the difference between the peak
contrast and the pre-contrast. The denominator of the ratio is
the difference between the post contrast and the pre-contrast.

Smax - Spre

Spost - Spre

More specifically, with time-course data exhibiting a transient
increase or decrease, the Signal Enhancement Ratio algorithm
returns a value that characterizes the ratio between the above

Maximum Slope of Increase
images display pixels based
on variation in the slope
or rate of contrast
enhancement. Red in-
dicates areas of steep
slope or rapid uptake.
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mentioned Maximum Difference Function value and a
user-specified value relative to the baseline in the time course
data.

This ratio algorithm is used with dynamic contrast studies and
allows you to differentiate areas where contrast enhancement is
washed-out, sustained or still enhancing:

° Washed out Signal Enhancement Ratio > 1.1
° Sustained from 0.9 to < Signal Enhancement Ratio 1.1
° Enhancing Signal Enhancement Ratio < 0.9

NOTE: This algorithm is a predefined protocol not found under
the function key.

Maximum Difference Function
This algorithm displays pixels based on the difference between
the minimum and maximum contrast enhancement. It is used to
analyze dynamic contrast studies and allows you to differentiate
areas that experience a greater difference between baseline
and peak contrast enhancement.

More specifically, with time-course data exhibiting a transient
increase or decrease, the Maximum Difference Function

Signal Enhancement
Ratio images display
pixels based on contrast
enhancement status.
Red areas indicate
wash-out.
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algorithm returns a value that characterizes the difference
between the maximum and the baseline values.

NOTE: This algorithm is a predefined protocol not found under
the function button.

Difference Function

This algorithm returns a value that characterizes the difference
between the pixel value in the currently displayed image and
the corresponding pixel value in the user specified reference
image.

NOTE: This algorithm is a predefined protocol not found under
the function button.

Average

This algorithm returns the average of the pixel values within a
given image range. It is used in particular by the pre-defined
protocols for MR spectroscopy.

By prefixing the image range with min, max, abs, log or dev, the
algorithm can also be used to find the minimum, maximum or
absolute pixel values in a given range, or their natural algorithm
or standard deviation.

Diffusion Coefficient

This algorithm subtracts the T2 effects from diffusion-weighted
images.

° In an isotropic diffusion-weighted image, restricted
diffusion is bright and T2 “shine through” is also bright

° In a Diffusion Coefficient map, restricted diffusion is dark
and T2 is isointense.

° This algorithm is found under the [Function] button.

Max. Difference Function
images display pixels
based on variation
between minimum and
maximum contrast. Red
indicates areas with
greater differences.
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Exponential Diffusion Coefficient
This algorithm removes T2 effects from diffusion-weighted
images.

° In an Exponential Diffusion Coefficient map, restricted
diffusion is bright (the same as a diffusion-weighted
image), and T2 effects are isointense.

° This algorithm is found under the [Get Protocol] button.

Ratio (A-B)/(C-D)
This algorithm is used in a number of pre-defined protocols, that
returns the value scale*(A-B)/(C-D), where A, B, C and D are
image ranges and scale is a user defined scaling value. All
parameters except A may be empty, so that it’s possible to
compute A, A-B, A/C or (A-B)/C. As in the Average algorithm,
the image ranges can be prefixed with min, max, abs, log or
dev.

MR Spectroscopy Protocols
This is a set of protocols used to compute and display metabolic
maps from MR spectroscopy data. They show either the
distribution of a metabolite (defined by its ppm range), or the
ratio between two metabolites.

Pre-defined protocols are available for choline, creatine,
N-acetyl and lactate lipid, and for the choline/creatine and
choline/N-acetyl ratios.

NOTE: These predefined protocols are not found under the
function button.

Applications
FuncTool is used to analyze images from task activation,
dynamic susceptibility, dynamic contrast, and diffusion studies.
Not all algorithms are used for all applications

• Task Activation studies use:
° Correlation Coefficient.

• Dynamic susceptibility studies use:
° Negative enhancement integral
° Mean time to enhance

• Dynamic contrast studies use:
° Positive enhancement integral
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° Mean time to enhance
° Maximum slope of increase
° Maximum difference function
° Signal enhancement ratio

• Diffusion studies use:
° Apparent diffusion coefficient
° Exponential apparent diffusion coefficient
° Ratio (A-B)/(C-D)

• MR spectroscopy studies use:
° MR spectroscopy protocols

3D CSI Viewport Layout
Chemical Shift Images acquired with the Probe-P pulse
sequence are displayed by selecting a display tool such as
[MIROI] or [Functool CSI] from the Display Browser. Select the
3D CSI series from the Display Browser, a message window
appears asking you to select a localizer. Select the localizer
series that you used to prescribe the 3D CSI scan.

The initial display consists of five areas: the command window,
and four display viewports. The chemical shift viewport appears
in the upper left (UL), the spectral grid viewport in the upper
right (UR), the metabolite image viewport in the lower left (LL),
and the reference viewport in the lower right (LR). The chemical
shift viewport defaults to No Smoothing.
8-18 2292264-100 Rev. 0 (03/01)



Analyzing Images with FuncTool
NOTE: Whenever a protocol is selected from the [Get Protocol]
menu, a Function parameters window is displayed over
the bottom viewports.

Figure 1: An example of the first areas displayed by the
post-processing tool using a 3D CSI series.

1 - Chemical shift viewport (Upper Left-UL),
2 - Spectral grid viewport (Upper Right-UR),
3 - Reference viewport (Lower Right-LR),
4 - Metabolite image viewport (Lower Left-LL),
5 - Display command window.

Concepts, Applications, and Terminology
General features of the probe-P CSI display tool are described
in this section. Features specific to each viewport are discussed
later in this chapter.

Region-of-Interest (ROI) and Spectrum Colors

ROIs are outlined by a purple or a green line (Figure 2). A green
ROI is the active ROI and usually has resizing and movement
handles as part of the green outline. A purple ROI is inactive or
deselected, and cannot be moved, resized, deleted, or copied.

1 2

4 3

5
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An active ROI is deselected if you select another ROI from the
command window. The active ROI is also deselected if you click
anywhere on a viewport except on the cursor area, outline, on
another ROI (in the UL, LL, and LR viewports), or spectrum (in
the UR viewport). The same color code is used in the spectral
grid (UR) viewport; purple corresponds to the spectra or
information lists from inactive ROIs, and green to the spectrum
or list from the active ROI. A third color – white – is used on the
spectral grid (UR) viewport to distinguish the spectrum or list
that corresponds to the current cursor location on any of the
other viewports.

Figure 2: Demonstrates a typical Probe-P display with two
ROIs, a reference image, and spectra.

Mouse use

The mouse buttons behave in a different manner when used in
different areas of the viewports.

When clicked, or clicked and dragged over an active annotation
(the red or bright white, alphanumeric characters in a viewport)
the mouse buttons behave in a manner defined by, or
consistent with the active annotation. Active annotations for
each viewport are described later in the chapter.

When clicked in other areas of a viewport, the three mouse
buttons behave in a fairly standard manner.
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The left mouse button is used in combination with the cursor to
select objects (e.g., a spectrum in the UR viewport or an ROI in
any of the other three viewports), to drag or resize selected
objects, to draw ROIs (when used with Shift), or to
communicate a location to the display tool programs.

The middle mouse controls the viewport window width and level
of the chemical shift (UL), of the metabolite image (LL), and the
reference image (LR) viewports.

The right-click brings up viewport specific menus.

Keyboard use

The arrow keys can be used to increase or decrease items
selected with the cursor – the behavior is identical to using the
left and right mouse clicks, respectively.

You can use the Ctrl-X, Ctrl-C, and Ctrl-V key combinations to
delete, copy, or paste an active (green) ROI. Shift is used with
the left mouse button to draw an ROI.

You can use Alt-F3 to raise and lower overlapping window on
the desktop. For example, if you select [Browser] on the
command window, the browser screen covers the display
viewports and command window. To uncover the display
viewports and command window, place the cursor anywhere on
the Probe-P display tool and click Alt-F3. This key sequence
can be used to raise and lower windows on any of the MR
desktops.

Active annotations

Active annotations are the red, or bright white (on a
black/white monitor), numbers, words, or acronyms displayed
on the viewports (Figure 2). The active annotations respond or
perform an action when the cursor is placed on the item and a
mouse button is clicked, or clicked and dragged. You can
increase or decrease active numbers by placing the cursor over
the number, and clicking the left or right, respectively. Similarly,
you can scroll the active numbers by clicking and dragging the
middle button. You can also use the left and right cursor keys
on the keyboard to increase or decrease a numeric value.
Clicking on a red or bright white word allows you to change the
display, or the location of a display. For example, to move the
numeric lists that are displayed on the chemical shift, metabolite
image, and reference viewports, click on the ROI active
annotation and then drag and drop the list on another area of
the viewport.
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The auto active annotation automatically scales the display in a
viewport. For the three viewports that display images or maps
(UL, LL, and LR), clicking on auto automatically adjusts the
window width and level of the displayed image/map. On the
spectral grid (UR) viewport, selecting auto (or pressing the
Spacebar on the keyboard) scales all spectra in that viewport to
the active (green) spectrum. In this case, the maximum and
minimum points in the active spectrum define the maximum and
minimum spectrum display limits. A common scale allows you
to compare and contrast signal intensities from several ROIs.

The patient name, displayed in red, or bright white, in the top
left corner of each viewport, is an active annotation. Clicking the
patient name displays a menu with the selection [Hide patient
name]. The patient name region changes to **** on all the
viewports. You can redisplay the patient name by clicking the
**** and selecting [Show patient name].

The slice location, displayed below the patient name, is an
active annotation. You can page through the slice locations by
clicking or clicking and dragging on this annotation. Multiple
ROIs can be drawn on a slice or the slices of a 3D Focal CSI
series. The ROIs are numbered sequentially in the order in
which they are drawn on the slices.

Active annotations specific to each viewport are discussed later
in this chapter.

Data smoothing conventions – The pixel smoothing feature
that is a standard part of the MIROI or Functool software,
should not be used with Probe-P maps. Keep the “cursor: #
pix” at 1. Normally, the chemical shift images and metabolite
maps in the three image views are displayed using simple pixel
replication or smoothed using a bi-cubic smoothing algorithm.
In addition, depending on the size of the cursor, a “regional”
filter is applied to the images or maps. The size of the filtered
region corresponds to the number of pixels used to define the
cursor size. This means the information from 4, 9, 16, 25, 36,
49, 64, 81, or 100 neighboring pixels is smoothed. The number
of pixels is given by the “cursor: # pix …” active annotation on
the spectral grid viewport, or by the “cursor 1x1 …” display on
the image viewports as shown in Figure 2. To avoid this
“regional” data filter, set the cursor size active annotation to
read “cursor: 1 pix …” on the spectral grid viewport. If you use
any other cursor size, the numeric values corresponding to an
ROI or pixel varies depending on the size of the cursor.
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Image Pan/Zoom

Images or maps are displayed in three of the 4 viewports
(Figure 2). Standard image annotations such as – DFOV, and
A/P, R/L, and S/I that contain red or bright white numbers
indicate that these are active annotations:

“DFOV 24.0 cm”, “A 120”, “R 120”, “L 120”, and “P 120”.

You can zoom by clicking on the DFOV 24.0 entry. You can pan
the image by clicking and grabbing the 120s. Zoomed, pixel
replicated images with a split ROI are shown in (Figure 3).
Select [Display normal] on the shortcut menus to undo the pan
or zoom.

Figure 3: A zoomed display of a pixel replicated metabolite
map and a split ROI.

Shortcut Menus

There are shortcut menus for each of the viewports with
selections that allow you to modify the current and subsequent
displays. Shortcut menus are accessed with a right-click
anywhere on a viewport, except on an active (red or bright
white) annotation, and drag and release on the desired option.
The specific menus for each viewport are described later in this
chapter.

Viewport Shortcut Menu Items

The following items may appear on the viewport shortcut
menus.
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You can toggle between No smooth/Smooth, Hide/Show
grid, Hide/Show Press ROI, and Show/Hide SAT bands to
show or hide these functions.

Table 1

The Movie option is available only in the upper left and lower
left viewports. When selected a window opens allowing
selection of movie display modes. Selecting Volume pages
through the CSI slices or the metabolite slices, depending on

Feature Description

Create Annotate Allows you to create annotation in the
UL, LL, and LR viewports. Cursor must
be in one of the 3 viewports.

Color Ramps Allows you to change the color of the
display. There are six choices:
Rainbow (the default), Hot iron, Puh
thallium, 3 colors, Gray levels, Inv.
Rainbow (Inverted Rainbow).

Display Normal Restores to the default image display if
you have panned and/or zoomed the
image. Window/level are not restored.

Hide/Show graphics Must have cursor in viewport, selecting
hides or shows graphics in that viewport
only.

Hide/Show grid Places the CSI acquisition grid over the
image.

Hide/Show PRESS
ROI

Hides or shows the voxel placement.

Hide/Show SAT
bands

The graphically prescribed SAT bands
are drawn on the reference image.

Movie Allows you to view the chemical shift
images, in the upper left viewport, in a
movie mode, and allows you view the
slices of the metabolite map in the lower
left viewport, in a movie mode. Can use
to check for patient motion.

Save all Saves all the images of the series to the
Display Browser as reformatted images.

Save view Saves the current view to the patient data
base as a screen save image in a
separate series.

Smooth/No Smooth Invokes a bi-cubic interpolation of the
pixel data in the image, or a simple pixel
replication, respectively.
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the viewport. Selecting Time highlights different signal
intensities on the CSI image, and is only available on the
chemical shift viewport. Rock and Loop are options for the
sequence in which images are displayed. Rock alternates
forward and reverse mode when the last image of the series is
reached, for example: a series with four images displays 1, 2, 3,
4, 3, 2, 1. Loop is for continuous forward display of images, for
example: a series with four slices displays 1, 2, 3, 4, 1, 2, 3, 4.

Figure 4: The Movies window.

The Chemical Shift or Upper Left (UL) Viewport
Individual chemical shift images, are displayed as non- zipped
images, and are displayed in gray scale in this viewport. No
smoothing is the default mode for displaying images in this
viewport. The individual rank images can be used to
characterize the homogeneity through the prescribed PRESS
voxel, and the spatial variation of the water suppression. The
rank is the number assigned to the image when the images are
sorted by increasing time. Large variations in both appear as
dark and light regions as in (Figure 5). Each rank image
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corresponds to the spatial distribution of one of 256 equally
spaced frequencies between 4.3 and 0.49 PPM.

Figure 5: The chemical shift viewport, rank=1 display with
five ROIs.

Initially, the first of the 256 chemical shift images is displayed,
as indicated by the rank = 1 / 256 (2) entry displayed at the
bottom left of the viewport. The rank number of the displayed
chemical shift image is an active annotation and can be
changed with the mouse buttons or the arrow keys. A right
mouse click decreases the rank number and a left mouse click
increases the number.

General information for each ROI is printed in this window. In
the example (Figure 5), a column of ROI numbers (1) labeled
“ROI”, a column labeled “mm2” which lists the area in
millimeters for each ROI, and a column labeled “Avg.” are
displayed in the bottom left corner of the viewport. The average
of the signals from the pixels in each ROI is listed in the “Avg.”
column. Depending on the selected metabolite a “Dev.” column
may appear showing the standard deviation. The ROI list can
be moved to another part of the viewport by clicking and
dragging the ROI label with the middle mouse.

The Chemical Shift Viewport Shortcut Menu

The default shortcut menu contains eight selections. Right-click
in the upper left (UL) viewport to access this menu. Once an
ROI, other graphic object, or annotation has been placed on the

1

2
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viewport, other toggle items are added to the menu such as
Hide/Show graphics and Hide/Show annotation.

Figure 6: Chemical shift viewport shortcut menu.

The Spectral Grid or Upper Right (UR) Viewport
One to at least 250 spectra can be displayed in this viewport;
the initial display is blank. Three display colors are used for the
spectra; green for the spectrum from the “active” ROI, purple for
spectra from any other ROIs, and white for the spectrum
corresponding to the cursor location when the cursor is used to
select a spatial region on one of the image display viewports.
The signal intensity for each of the 256 points in a spectrum can
be listed for the spectra from 1- 8 ROIs (Figure 7). This list is
accessed with a right-click in the spectral grid viewport and drag
to select List values. You can click on the image number
located at the top of the list (indicated by the red or bright white
text) to scroll through the list. Left-click to increase and
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right-click to decrease the image number. (For example, the
“Rank im #,” number 65 in Figure 7.)

Figure 7: Spectral grid viewport with a list of signal
intensities from five ROIs.

When you move the cursor on the spectrum or spectra
displayed in the spectral grid viewport, two white lines intersect
on the display and two numbers are displayed in white along
the x- and y-axes (Figure 8). The x-axis number corresponds to
the image rank number or to the PPM value of the chemical
shift image (the 4.30 to 0.49 PPM region of the spectra is
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displayed). The y-axis number corresponds to the signal
intensity at the cursor location on the spectrum.

Figure 8: Using the cursor to display the signal intensity at a
point in the spectrum.

You can also display the rank or complete chemical shift image
in the chemical shift viewport (UL) for a given point in a
spectrum by double clicking on a spectrum. For example, if you
double click on the spectrum at point 143, the display in the
chemical shift viewport changes to the 143rd rank or chemical
shift image, and the UL display is “rank = 143 / 256”. The image
number (im #) is the default for the x axis, to change, right-click
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in the spectral grid viewport, drag to Set x units and select
ppm.

Figure 9: Spectra displayed in the spectral gird viewport.

Active annotations

There are ten active annotations in this viewport. In Figure 9,
the active annotations, starting at the top left and moving down,
are:

• (1) **** – the patient name, which has been hidden in
Figure 9.

• (2) 3389 – the current y-axis maximum value, used to
scale the spectra.

• (3) -580 – the current y-axis minimum value, used to
scale the spectra.

• (4) 1 – the current x-axis starting image, used to zoom
the spectra – units are points or rank image as shown in
Figure 9, or PPM.

• (5) cursor: 1 pix – i.e., the number of pixels averaged to
produce the cursor spectrum, and used to determine the
extent of the cursor size smoothing region. Set the
value to one to avoid cursor size smoothing.

1

2

3

4

5 6 7

8

9

10
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• (6) auto – click to automatically scale the vertical
spectra to the active spectrum (ROI) – pressing the
space bar has the same effect. Select either an ROI or
a specific spectrum in the UR viewport and click auto.
The other spectra are vertically scaled to the selected
ROI or spectrum.

• (7) 2x3 – click to toggle between the display of separate
spectra, as shown in Figure 9, or to display the spectra
superimposed on one frame, i.e., 1x1 (Figure 10).

• (8) AVG – click to toggle between the four spectrum
display selections, AVG, MAX, MIN, and DEV (standard
deviation) – these selections are explained later in the
chapter.

• (9) ROI 05 – indicates the active spectrum (ROI), click
to change the active spectrum, clicking on the word
“ROI” deselects the active spectrum (ROI).

• (10) 256 im # – the current x-axis ending image, used to
zoom the spectra – units are points or rank image as
shown in Figure 9. If you set x units to PPM (using the
shortcut menu, accessed with a right-click), the x
(horizontal) scale changes to 4.30 - 0.49 ppm. With the
cursor over the active annotation of 0.49, a right click
increases this value and a left click decreases this
value, the range is 0.49 - 4.29 ppm.
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Figure 10: Superposition of 16 spectra in the spectral grid
viewport.

Active Spectrum (ROI)

In the spectral grid viewport, to change the active spectrum
(ROI) click on the spectrum, or click on the ROI active
annotation. The active spectrum is always drawn in green.

Y-axis and Spectrum Scaling

Spectra can be scaled to fit the display window by clicking, or
clicking and dragging the y-axis maximum and minimum active
annotations. It is also possible to automatically scale the active
spectrum to fit the display window or a frame by pressing the
Spacebar on the keyboard, or clicking on the auto active
annotation. If more than one spectrum is displayed, all spectra
are scaled to the active spectrum (ROI) with these selections.
Unless explicitly changed, the scale stays the same.

X-axis, Image Rank and the PPM Scale, and Spectrum
Zooming

You can zoom the spectrum by clicking on the x-axis limits to
select the region of the spectrum that you wish to display. Each
spectrum consists of 256 points, one for each of the 256
Chemical Shift or rank images stored in a CSI data set. The
spectra cover a frequency range from 4.30 to 0.49 PPM.

The PPM (parts-per-million) scale relates all resonant
frequencies (peaks) to a standard frequency (i.e., on a Signa
system to in vivo water at 4.7 PPM), and is independent of the
field strength. At 1.5T, a change of 1.0 PPM corresponds to a
change of approximately 64Hz. The N-acetyl groups resonate
at 2.0 PPM, a frequency that is 2.7 PPM or 173Hz lower than
the resonant frequency of the hydrogen atoms in the water
molecule.

Unfortunately the resonant frequency of the hydrogen atoms in
the water molecule is temperature dependent, while the
resonant frequencies of the metabolites are relatively constant
between 10-50°C. A water temperature change of one degree
Celsius (1°C) corresponds to a frequency change of 0.6Hz
(approximately 0.01 PPM). For example, the resonant
frequency of water at 21°C is about 10Hz lower than the
frequency of water at 37°C (body temperature). The
PROBE/SVQ, probe SI, and 3D Focal CSI spectra are
processed assuming tissue water resonates at 4.7 PPM, i.e.,
the tissues are at or near 37°C. When acquiring data from a
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phantom at a temperature other than 37°C, the quantitative
analysis program often fails, and/or the reconstructed spectrum
may be shifted by the temperature dependent shift of the water
resonance from 4.7 PPM.

Cursor Location Spectrum

The spectrum associated with the cursor location is the
spectrum from one pixel, or an averaged value of the spectra
from 4, 9, 16, 25, 36, 49, 64, 81, or 100 pixels. The number of
pixels is selected by clicking on the cursor: # pix active
annotation at the lower left of the viewport. The cursor spectrum
is always displayed in white, and is always the last spectrum in
a multi-spectrum display.

NOTE: Before displaying any metabolite or ratio maps, set the
cursor value to one to avoid additional smoothing (based
on the size of the cursor) of the maps.

Superimposed Spectra or Individual Spectra

In the initial or default display of multiple spectra - the 1x1 active
annotation, (Figure 10) the spectra are superimposed on the
display. The spectra are scaled to the maximum and the
minimum values found in the set of selected spectra or to the
last scale selected. Separate spectra, one for each ROI, are
displayed in smaller individual frames for an NxN active
annotation. In Figure 9, the five spectra are displayed as a 2x3
array, and the active annotation is 2x3.

Spectrum Average or Compression Techniques

The spectra or signal intensity lists can be displayed using one
of 4 different methods to combine the data from more than one
pixel. The four methods are:

° AVG - displays the average of the pixel values,

° MAX - displays the maximum pixel value for each point,

° MIN - displays the minimum pixel value for each point,

° DEV - displays the standard deviation for each point.

For spectra corresponding to a single pixel the AVG, MAX, and
MIN methods produce identical spectra and intensity lists, and
the DEV selection produces straight lines. Typically the default
AVG selection should be used to display the spectra.

The Spectral Grid Viewport Shortcut Menu

This shortcut menu has several options and toggle options, that
can be accessed with a right-click in this viewport. If an option is
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selected, the menu contents change. The default shortcut menu
and the sub-menu selections are:

Figure 11: Spectral grid viewport shortcut menus.

If you place an ROI on one of the image viewports or you use
Create annot., additional items are added to the shortcut menu
as shown in Figure 12:

Figure 12: Expanded spectral grid viewport menus.

The toggle selections in the menu are: List Values and
Spectrum, and Show/Hide dev. The Show/Hide annot. toggle
selection only appears if you select Create annot.

• Under Set X Unit you have the option of choosing rank or
ppm: Sets the x-axis unit label. The choices are points
(image rank) or PPM (parts per million). Each spectrum
consists of 256 points, one for each of the 256 chemical
shift or rank images stored in a probe-P image. Each
spectrum covers the range from 4.30 to 0.49 PPM.

• Under Set Y Unit you have the option of choosing
absolute, relative, percentage, or shape comparison.
For probe-P data display, always select absolute which
plots the actual pixel values for each point. The other
choices are meaningless for spectral data.

• List Values or Spectrum: Toggles between the spectrum
display, and the display of a scrollable list of signal
intensities (Figure 7) for each point in the spectrum.

Histogram: Displays a histogram of the data in an ROI. This
selection is only available if an ROI has been placed on the
images. If selected, the shortcut menu is reduced to three
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selections, Spectrum, List Values, and Save View as shown
in Figure 13, and the shortcut menu is limited to three selections
until you select the Spectrum display again.

Figure 13: Spectral grid viewport menu if Histogram is
selected.

• Show dev. or Hide dev.: Shows or hides the deviation or
measure of variability of the plotted data.

The Metabolite Image or Lower Left (LL) Viewport

Average or Ratio metabolite maps corresponding to the
protocols selected with [Get Protocol] or [Function] are
displayed and manipulated in the lower left (LL) viewport. In the
metabolite image viewport, the prescribed PRESS voxel is
overlaid (the voxel is outlined in white) on the map as shown in
Figure 14.

The metabolite maps are a combination of spatial and spectral
signal intensity information. The maps are derived from the CSI
rank images that can be viewed individually in gray scale in the
chemical shift viewport. Average maps are created by
combining/averaging several contiguous CSI images. The
contiguous regions (see Table 2) correspond to the locations of
the metabolite resonances or peaks.

Table 2

Metabolite Image range PPM

Choline images 64..74 3.24 +/- 0.08 ppm

Creatine images 78..88 3.02 +/- 0.08 ppm

N-Acetyl images 143..154 2.02 +/- 0.08 ppm

Lactate and Lipid images 183..222 0.9..1.5

Startup images 50..200 3.5-1.33

Composite images 64..222 0.9..3.32 ppm
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Ratio maps are a simple extension of the average technique in
which two different, contiguous sets of CSI rank images are
separately combined, and then the two combined images are
divided to produce a ratio map. In essence, a map corresponds
to the spatial distribution of the signal intensity of a region of a
spectrum, or of the ratio of signal intensities in two regions of a
spectrum.

Figure 14: Metabolite image viewport display.

A numeric list of information appropriate to the current
metabolite map or ratio map for each ROI is displayed on this
viewport. The default location of the list is at the bottom left of
the viewport. Click and drag the ROI text to move the listed
information to another area of the viewport. In the example
(Figure 14), ratios from five ROIs are listed. The “Dev.” column
(2) displays the standard deviation of the selected metabolite.
Depending on the metabolite chosen instead of “Dev.” a “%”
column appears showing the relation of the individual ROI ratio
values to the 100% value assigned to the active (green) ROI.
The ratio for the active, fifth ROI is listed as 1082.2 (the actual
value is 1.0822 which is scaled by 1000). The ratio for the fourth
ROI is listed as 1555.5 which is 43% greater than the ratio from
the active ROI.

1
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Depending on the metabolite chosen instead of a “%” column
you may be given a “Dev.” column displaying the standard
deviation.

You can adjust the window width and level of the map by
clicking and dragging the middle mouse, or by clicking on the
active annotations at the bottom left of the viewport – “W = 340”
or “L = 255” in Figure 14. The range of the color scale (1) at the
left edge of the viewport is related to the window width (W) and
window level (L) as:

colorscale maximum = W + L/2,

and

colorscale minimum = W – L/2.

You can adjust the colorscale maximum and minimum by
clicking on the numbers at the top and bottom of the colorscale;
425 and 85 in Figure 14. If you select [H] at the top of the
colorscale, those pixels in the map with an intensity larger than
the maximum colorscale intensity are colored black. If you
select [L] at the bottom of the colorscale, those pixels with an
intensity less than the minimum colorscale intensity are colored
blue. The [H] selection allows you to quickly see the maximum
areas on any map.

If you change the display in the metabolite image viewport, e.g.,
if you zoom on the image or adjust the window width or level,
the same changes or selections are applied to the metabolite
map overlaid on the LR reference viewport.

The Metabolite Image Viewport Shortcut Menu

To access this menu, right-click in the viewport. The default
shortcut menu contains four toggle selections – No
smooth/Smooth, Show/Hide grid, Hide/Show Press ROI,
and Show/Hide SAT bands. Once an ROI, any other graphic
object, or annotation has been placed on the viewport, an
additional toggle item is added, Hide graphics and Show
graphics is added to the menu. Menu options selected in this
viewport that affect the display of the map in the metabolite
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image viewport have the same effect on the map overlaid on
the reference viewport. The contents of the menu are:

Figure 15: Metabolite image viewport shortcut menu.

The Reference or Lower Right (LR) Viewport
Initially the display in the reference viewport consists of a
metabolite map at a 50% transparency level overlaid on the
localizer image currently displayed in the chemical shift
viewport with the prescribed PRESS voxel outlined by a white
line (Figure 1). When the display tool is launched a dialog box
appears asking you to select a localizer image, highlight the
localizer series from the Display Browser, the default is image
three of the selected series.
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This localizer reference image is displayed in the reference
viewport, as shown in Figure 16.

Figure 16: Reference viewport display with reference
image.

You can adjust the transparency of the overlay by clicking on
the 50% transparent (arrow) active annotation. You can adjust
the window width and level of the localizer image by clicking
and dragging the middle mouse.

The Reference Viewport Shortcut Menu

The default shortcut menu contains 10 selections. These
selections are accessed with a right-click in the viewport. Once
an ROI, any other graphic object, or annotation has been
placed on the viewport, other menu options appear.

The contents of menu are:

Figure 17: Reference viewport shortcut menu.
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• Set Reference Image to display a selected image, or the
original, default display. The shortcut options are original
and selection.

The selection properties are:

• The default display in this viewport is a metabolite map at a
50% transparency level overlaid on the default image of the
localizer series that you selected. Use Set reference image
to display an image from a selected series, or the original
CSI image with smoothing.

° If you select original, the smoothed CSI image appears
with a metabolite map overlay.

° If you select selection, the localizer (selected) series,
image three appears with a metabolite map overlay.

3D Focal CSI Display Tool Command
Window

There are several different features of the command window
that should be considered and require further explanation.

Function

The Function menu allows a number of choices to display the
CSI data. These choices differ from the selections on the [Get
Protocol] menu, in that the Function menu selections cannot
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be modified and include no information concerning the
definition of the protocols.

The Function menu selections opens to a set of metabolite
selections.

The General menu displays the following choices:

The Research menu displays the following choices:

The Spectroscopy menu displays the following choices:

The map of the metabolite or ratio of metabolites is displayed.

If you select a metabolite or ratio, such as Creatine/Choline a
dialog box appears with the options for [Compute], [Save
Protocol], [Close], and [Help].

• Compute - Clicking allows the changes that you make to
the parameters on the panel are invoked by clicking
[Compute]. Whenever you click [Compute] the protocol
title on the Function parameters panel, the function view,
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and the composite view is changed to the generic “Average”
or “Ratio (A-B)/(C-D)”.

• Save Protocol - Clicking allows you to save the metabolite
or ratio as a protocol that can be stored and recalled for
future use. Enter the name of the new protocol in the entry
text box on this panel. To accept, and create the new
protocol, click [OK]. Click [Cancel] to leave the “Save
protocol” panel without creating the new protocol. User
created protocols can be deleted at any time by clicking
[Del. Protocol] on the Main Control Panel.

• Close - Allows you to exit from the Function parameters
dialog box. Generally you would only use [Close].

• Help - Clicking [Help] enlarges the Function parameters
panel to include an explanation of the protocol, simple
algorithmic information, and definitions of the parameters.
Help allows viewing of the absolute value for the selected
metabolite or ratio. This value cannot be changed, it is for
viewing only.

Selecting a protocol from the [Function] menu, a Function
parameters window (Figure 18) appears over the lower two
viewports. No input lines are displayed on these windows and
the selected protocols cannot be modified.

Figure 18: The Function parameters window appears.

Get Protocol

Selecting [Get Protocol] displays the metabolite map or
metabolite ratio map using the pre-defined spectral regions to
calculate the metabolite or ratio maps.
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The following is brief description of the protocols:

• N-acetyl − displays the averaged, absolute pixel values
from CSI image 143 through image 154 as a metabolite
map,

• Choline − displays the averaged, absolute pixel values
from CSI image 64 through image 74 as a metabolite map,

• Composite − displays the averaged, absolute pixel values
from CSI image 64 through image 222 as a metabolite map,

• Startup − displays the averaged, absolute pixel values over
the region 50-200. This is a good picture of the excited ROI.

• Creatine – displays the averaged, absolute pixel values
from CSI image 78 through image 88 as a metabolite map,

• Lactate lipid – displays the averaged, absolute pixel values
from CSI image 183 through image 222 as a metabolite
map,

• Choline/creatine – displays a map of the ratio of the
choline, 64 -74 region, to the creatine, 78 – 88 region,

• Choline/N-acetyl – displays a map of the ratio of the
N-acetyl, 143 – 154 region, to the choline, 64 – 74 region.

Selecting a protocol from the [Get Protocol] menu on the
command window, a Function parameters window, specific to
the protocol, is displayed. Windows similar to those seen in
Figures 19 and 20 appear. You can modify these windows,
although the startup and composite windows cannot be
modified. The Function parameters window for the Average
metabolite maps of N-acetyl, choline, creatine, and lactate-lipid
regions is fairly simple, with one input parameter line that
defines the metabolite region and combining method (Figure
19).

Figure 19: Function parameters window for the Average
(choline) protocol.

If you select one of the Ratio (A-B)/(C-D) map protocols from
the [Get Protocol] menu, a more complex window (Figure 20),
is displayed. For the pre-defined choline/creatine and
N-acetyl/choline ratio protocols, four of the 6 input parameter
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lines are used to define 2 spectral regions, a threshold factor,
and a scale factor.

Figure 20: Function parameters window for the Ratio
(choline/N-acetyl) protocol.

Both Average and Ratio (A-B)/(C-D) Function parameters
windows contain four (4) selectable buttons. The four buttons
shown in Figure 19 or 20 are labeled; [Compute], [Save
Protocol], [Close], and [Help]. Typically, you would only use
[Close] to close the window.

• [Help] enlarges the Function parameters window to include
an explanation of the protocol, simple algorithmic
information, and definitions of the parameters.

• Changes made to the parameters in the input parameters
text boxes are invoked by selecting [Compute]. Whenever
you click [Compute] the protocol title on the Function
parameters window, the metabolite image viewport, and the
reference viewport is changed to the generic Average or
Ratio (A-B)/(C-D).

• To save the changes for future use, click [Save Protocol].
Enter the name of the new protocol in the text box.
Selecting [OK] creates and saves the new protocol.
° Selecting [Cancel] leaves the Save protocol window

without creating the new protocol. User created protocols
can be deleted at any time by selecting [Del. Protocol]
on the command window and drag to the protocol to
delete.

• Click [Close] to close the window.

The Function parameters window for the Ratio (A-B)/(C-D)
(choline/N-acetyl) protocol displayed in Figure 20 is the basis
for all of the spectroscopy Function parameters windows. The
Average (choline) example in Figure 19 is a simplified version of
the ratio window.

In addition to the four selectable buttons, the window has six
input parameter text boxes:

• The first four text boxes, labeled Image(s) A, Image(s) B,
Image(s) C, and Image(s) D, specify an image or a range
of images used in the protocol calculations. The values
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returned by the pre-defined protocols are the scaled values
of A, or A/C. It is possible to return the values of A, A – B,
A/C, (A – B)/C, or (A – B)/(C – D), depending on which input
parameter text boxes are left empty. For example, to return
the simple ratio A/C, the B and D input parameter text boxes
are left empty as shown in Figure 20. Clearly the Image(s) A
input parameter text box can not be empty.

• The fifth text box specifies a pixel value Threshold used to
suppress background noise or spurious signals. The
threshold value is compared to the value of the denominator
C or (C – D); whenever the denominator is less than the
threshold value, the ratio is set to zero, and appears as a
black pixel in the ratio map.

• The last parameter text box defines a Scale factor. A scale
factor of 1000 is recommended to minimize round-off and
integer truncation artifacts. For example, a scale factor of
1000 means that ratio values like 1.432 or 0.789 are listed
in the metabolite image viewport as 1432 and 789,
respectively. Using a smaller scale factor, in most cases,
reduces the number of digits in the ratio. For example, scale
factors of 100, 10, and 1 would scale the 1.432 value as
143, 14, and 1, respectively. Scale factors other than 1, 10,
100, or 1000 makes either visual or simple arithmetic
comparisons of the spectra and ratio values difficult and are
not recommended.

The general Ratio (A-B)/(C-D) algorithm uses the threshold and
scale factors to return a value for each pixel in the ratio map
according to the general equations:

if Threshold ≤ (C – D) then,

Pixel Value = Scale * (A – B) / (C – D),

or if Threshold > (C – D),

Pixel Value = 0.0 (the pixel is set to black on the ratio map).

The Image(s) input parameters can be a single image N, or a
range of images N..M. For spectra this means either a single
point, or a range of points in the spectra, respectively. There are
also five, 3 letter input parameter prefixes that can be used to
modify the combination of the points in the given region of the
spectrum during a calculation:

° abs N..M – returns the average of the absolute values of
the pixels in the range,
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° min N..M – returns the minimum pixel value from the
range,

° max N..M – returns the maximum pixel value from the
range,

° log N..M – returns the average of the natural logarithms
of the pixels in the range,

° dev N..M – returns the standard deviation of the pixels in
the range.

The input entry text boxes in the pre-defined protocols for the
four metabolite maps, and two metabolite ratio maps are all of
the form abs N..M. Image or spectral regions are defined for
three chemical species (N-acetyl groups, choline, and creatine),
and a region containing the two chemical species lactate and
lipid. The startup and composite protocols combine the signals
from most of the spectral region.

The choline, creatine, and N-acetyl regions are used to define
the input parameter entries for the choline/creatine, and the
choline/N-acetyl ratio maps. Using the Function parameters
window for the choline/N-acetyl Ratio map in Figure 20 as an
example, the absolute values of the signal intensities for the
chemical shift images 64 through 74 (Image(s) A = abs 64..74)
are divided by the absolute values of the signal intensities of the
chemical shift images 143 through 154 (Image(s) C = abs
143..154) using a threshold value of 2000. The quotient is
multiplied by the 1000 scale factor.

NOTE: A scale factor should be a multiple of 10.

The ratio map for with this protocol is calculated using the
equation:

Pixel value = 1000 * (abs 64..74) / (abs 143..154)

where any value of (abs 143..154) <2000 is set to zero.

Region of Interest

To place an ROI on the chemical shift, metabolite image, and
reference viewports click either [square ROI] or [ellipse ROI].
A green (active) ROI is drawn at the center of the three image
viewports. The ROI can be moved or resized by clicking on the
resizing and movement handles on the ROI – the handles are
only present on an active ROI. Alternatively, you can select
Shift, left-click and drag to draw an ROI.

Once an ROI has been placed on the viewports, it can be split
or divided to display the reconstructed CSI pixels contained
within the ROI as shown in Figure 3. To split the ROI, select
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[split ROI]. To return to the merged or single ROI, click [merge
ROI]. Note that an ROI of any shape – rectangle, ellipse, or
freely drawn – is composed of the square, reconstructed CSI
pixels. By selecting [split ROI] you can always see which CSI
pixels contribute to the ROI, and to the numeric information
displayed or listed for the ROI. Once the ROI has been split it is
possible to move and delete the individual CSI pixels.

Hints

Using Numeric Data Lists

To insure that the numeric data from an ROI that is listed on one
of the 3 image viewports is consistent and reproducible, always
set the cursor size active annotation on the spectral grid
viewport to read “cursor: 1 pix …” (arrow Figure 21). The cursor
size is also indicated by the “cursor 3x3 …” (circled Figure 22)
annotation near the top left corner of the metabolite image and
reference viewports. Using a value other than one invokes an
additional pixel smoothing algorithm for the metabolite and ratio
maps that varies with the cursor size.

Figure 21: Solid White=choline peak maximum.
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Figure 22: Metabolite image and reference viewports with
nine (3x3) pixel cursor smoothing.

Metabolite and Ratio Maps with Sharp Edges

Occasionally the metabolite and ratio maps terminate with a
sharp edge. The sharp edges are often an artifact of the cursor
size smoothing algorithm noted just above. To avoid these
artifacts always set the cursor size active annotation on the
spectral grid viewport to read “cursor: 1 pix …”.

Saving and Filming Images

For more information regarding filming images see, Volume 1,
Chapter 10.

When saving images in FuncTool there are two things you
should remember:

° Right mouse click on the image and drag to Save View.

° Images do not save in color. Data set must be
re-processed through FuncTool to display color.
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How to Post Process
Images with FuncTool
This section provides the step-by-step instructions describing
how to:

• Display Valid Image Sets

• Display Various Graphs

• Create Parametric Images
° Function Algorithm
° Protocol Algorithm

• Adjust the Composite Overlay

• Display 3D Focal CSI Images

• Create a Custom 3D Focal CSI Protocol
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Anchor Display Valid Image Sets
Use this procedure to load and display valid image date sets
into FuncTool. You should already be familar with basic mouse
functions before attempting this section.

To perform this and other tasks in this section you should have
already acquired your valid image sets by using the GE
pre-defined protocols listed in their appropriate sections.

1. Click on the [Display Desktop] icon.

2. Select the patient on the exam Display Browser. Then
select the series you wish to load into FuncTool.

3. Click on [FuncTool], located on the right side of the Display
Browser screen. The selected series loads into FuncTool.

NOTE: The series automatically loads the mid-line slice of the
series.

° If you desire another location to be displayed, place
cursor on the red location annotation on the reference
image and click with the left mouse to decrease location
or the right mouse to increase the image location.

° If you desire another phase/rank image to be displayed,
place the cursor on the red rank annotation on the
reference image and click with the left mouse to increase
image phase/rank or click with the right mouse to
decrease image phase/rank.

4. You can window and level the image to your preference, by
using the middle mouse button.
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Display the Graphs
After a valid data image set has been loaded into FuncTool you
may want to display different graphs. To do this the steps are as
follows:

1. Identify an area on the image you wish to concentrate on.

NOTE: If you place your cursor on this area a time intensity curve
appears in the graph section. Whenever you move the
cursor a new graph curve appears. This curve graph is
not set until you place an ROI.

2. Define your area of interest by using an ROI. To do this click
the [Elliptical ROI] or [Square ROI].

3. Size and position the ROI over the area of interest. Once
sized and positioned, tap the Space bar to scale and
display time intensity curve.

4. To display the time intensity curve in time units. Position the
cursor on the time-intensity curve in the upper right
quadrant, right click and drag to Set X-axis, and select
Time.

5. To display the time intensity curve in image number.
Position the cursor on the time-intensity curve in the upper
right quadrant, right click and drag to Set X-axis, and select
Rank.

6. To display a histogram instead of a time-intensity curve.
Position the cursor on the time-intensity curve in the upper
right quadrant, right click, and drag to Histogram.
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Create Parametric Images

Function Algorithms

To create a parametric image using algorithms located under
the Function button.

1. Click the [Function] button. The function
menu appears.

2. Click the desired algorithm.

° Select Correlation Coefficient for task activation.

The Correlation Coefficient menu appears. Input

parameters: Reference pattern is a sequence of
numbers indicating the task or activity repeat cycle. For
example you might input (-1 9 -1 9)this means to
skip image 1 in the set of 10 images look at remaining 9
images. (Image 1 is commonly known as the flash image
and is not needed in the data set.) Confidence Level is
the statistical confidence chosen to threshold the display
of the parametric image. The lower the confidence level,
the higher degree of statistical confidence. Show
Correlation is generally set to ’+’, so that all correlations
greater than ’0’ are displayed.
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° Select Negative Enhancement Integral for dynamic
susceptibility. When this menu appears, input the values

requested. Threshold default is 50. Base default is
constant.

° Select Mean Time to Enhance for dynamic susceptibility
or dynamic contrast. When this menu appears, input the

values requested. Threshold default is 50. Base default
is constant.

° Select Maximum Slope of Increase for dynamic
contrast. Input the requested imaging parameters.
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° Select Diffusion Coefficient for maps for diffusion. Input

parameters requested. B value should be what was set
in scan prescription. Confidence level default is 0.01.

° Select Ratio (A-B)/(C-D) for maps for diffusion. Input the

values requested. Image ranges and numbers can be
used for values.

3. Now click [Compute] to process the values. A parametric
image appears in the lower left quadrant and composite
overlay image in the lower right quadrant.

4. The parametric image color scale defaults to rainbow, if you
choose to change this scale, right click over the parametric
image and drag to color ramp. Select the desired ramp.
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Create Parametric Images

Protocol Algorithms

To create a parametric image using algorithms located under
the Get Protocol button.

1. Click the [Get Protocol] button. The menu
appears.

2. Click the desired protocol algorithm.

° Select Signal Enhancement Ratio for dynamic contrast.

Input the parameters values. It is recommended you use
default values. A = max. 1, B = first pre-enhancement
image, C = last post-enhancement image, and D = same
input value as B.
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° Select Maximum Difference Function for dynamic
contrast. Input the requested values, recommended as

default values.
° Select Difference Function. Input the parameters

values. It is recommended you use default values.
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° Select Exponential Diffusion Coefficient. Input the

parameters values. It is recommended you use default
values. A = 1, B = none, C = 2, threshold 50, and scale
1000.

° Select Positive Enhancement Integral for dynamic
contrast. Input the parameters values. It is recommended

you use default values.
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3. Click [Compute] to process the values. A parametric image
appears in the lower left quadrant and composite overlay
image in the lower right quadrant.

4. The parametric image color scale defaults to rainbow If you
choose to change this scale, right click on the parametric
image and drag to [color ramp]. Select the desired ramp.
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Adjust the Composite Overlay
You can change the image used for the composite image in the
lower right quadrant.

1. Click the [Browser] button. This returns
you to the display desktop.

2. Select the series and the image you want to display the
overlay on, from the Display Browser.

3. Press [Alt] and [F3] at the same time to return to the
FuncTool viewer.

4. Place the cursor in the lower right quadrant.

5. Right click and drag to [Set Reference Image]. Drag to
[Selection] to display the selected image.
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Display 3D Focal CSI Images Display 3D Focal CSI Images
Use this procedure to display the 3D Focal CSI images that you
obtained during scanning. The prerequisites for display are a
valid image set of 3D Focal CSI images and a display tool such
as Functool CSI or MIROI. Software versions below Functool
2.0 are not able to accommodate the 3D Focal CSI images.

1. Select a 3D Focal CSI series from the Display Browser.

2. Click the display tool, [Functool CSI] for example, to launch
the display software.

• When the display tool is launched a dialog box appears
asking you to select a localizer image. Highlight the
localizer series from the Display Browser. The default is
image three of the selected series.

3. Select an appropriate localizer series/image from the
Display Browser and click [Ok].

• The display tool command window appears on the left
and four viewports appear to the right. The upper left
(UL) viewport displays a chemical shift image, the upper
right (UR) is for displaying spectra (blank until an ROI is
selected), the lower left (LL) displays a metabolite map,
and the lower right (LR) displays a metabolite map
overlaid on a reference image.

NOTE: The image in the UL, LL, and LR viewports default to the
first image of the selected CSI series.

• The viewports default to the reference of metabolites,
you must select from the [Get Protocol] menu to select
a different metabolite. See step 4.

• Click [Cancel] to discontinue display.

4. Click [Get Protocol] and drag to select a metabolite display
protocol from the menu. This displays the metabolite map
and the map overlay. The protocol menu provides the
following metabolite map selections:

• N-acetyl

• Choline

• Composite

In Brief: Display 3D
Focal CSI Images

1. Select a 3D Focal CSI
series.

2. Select and launch the
display tool software.

3. Select an appropriate
localizer series/image
and click [Ok].

4. Click [Get Protocol] and
select a metabolite.

a) A right-click in the
viewport allows
selection of saving
one or all images.

b) Repeat steps one
through four if needed,
or continue with steps
five through ten.

5. Select an ROI.

6. Click and drag one of the
square handles to size
the ROI.

7. Click the center of the
active ROI and drag to
move to desired position.

8. Place the cursor in the
spectral grid viewport and
press the Spacebar to
scale.
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Startup• Startup

• Creatine

• Lactate Lipid

• Choline/creatine

• Choline/N-acetyl

a) If desired, a right-click in the viewport displays a
shortcut menu that allows selection of saving one
or all images for later viewing from the Display
Browser.

b) You can stop here, repeat steps one through four if
needed, or continue with steps five through ten to select
specific ROIs and obtain metabolite information for
those areas.

5. Select one of the following ROIs from the display tool
command window:

• Elliptical for a circular ROI

• Square for a square ROI

• Spline for a spline ROI, and draw the ROI

NOTE: The ROI is drawn on the three image viewports.

6. Click and drag one of the square handles to size the ROI.

7. Click the center of the active ROI and drag to move to
desired position.

8. Place the cursor in the spectral grid viewport and press the
Spacebar to scale the grid to fit the viewport.

9. To place multiple ROIs on the viewports do one of the
following:

• Click on the ROI in the viewport to make inactive, then
select the ellipse, square, or polygon/spline. Repeat as
needed, remember to make the active ROI inactive.

• To split an ROI, select the ROI to make it active and
click [Split ROI].

In Brief: Display 3D
Focal CSI Images

9. To place multiple ROIs:

• Click the ellipse,
square, or
polygon/spline.
Repeat as needed.
OR

• Select the ROI to
make it active and
click [Split ROI].

10. With the crosshair in
upper right viewport,
right-click, drag to X Unit
and select ppm.

11. Set the active annotation
cursor: # pix, in the
upper right viewport, to
one.
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NOTE: You can page through the slices and place multiple ROIs
on any of the slices. The ROIs are numbered
consecutively (even if ROIs are placed on multiple slices).
The maximum number of ROIs on one image is 12. For
more than 12 ROIs, the new data replaces the data of
previous ROIs. For example, ROI number 13 data
replaces the data for ROI number one, ROI number 14
data replaces the data for ROI number two, and so on.
All the ROIs are still seen on the viewport, just the data
is missing. You can view the data for all the ROIs with a
right-click in the UR viewport and click List Values.

10. With the crosshair still remaining in the upper right viewport,
right-click to view a shortcut menu. Drag to X Unit and
select ppm (parts per million). This displays the ppm scale
below the spectrum which designates the chemical address
of each metabolite.

11. In the upper right viewport the active annotation cursor: #
pix should be one. To change the number (#) click, or click
and drag left/right on the cursor number. Setting the value to
one avoids cursor size smoothing.

NOTE: At anytime, you have the option to split the ROI, or merge
the ROI by selecting the icon from the display tool
command window.
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CreatingCreate a Custom 3D Focal CSI
Protocol
The following step-by-step instructions teach you how to create
site specific 3D Focal CSI display protocols. As a simple
example, this task creates a protocol to display a ratio map and
ROI ratio lists that correspond to the maximum of one
metabolite (choline) divided by the maximum of the another
metabolite (creatine) with reasonable Scale and Threshold
values.

1. Have a valid 3D Focal CSI data set with the display tool
launched.

2. Click [Get Protocol].

3. Select a metabolite ratio protocol.

• The Function parameters window appears.

4. Determine the maximum for the desired metabolite peaks
using the cursor in the spectral grid view.

• In the example shown in Figure 23, the solid white lines
indicate that the maximum choline signal appears at
point 71, and the dotted white lines show that the
maximum creatine value occurs at point 82. In actual
practice, the maximum value for the creatine peak
would be determined using solid white lines too, but for
this illustration dotted white lines are used.

Figure 23: Spectral grid viewport. Solid White=choline peak
maximum. Dotted white=creatine maximum.

In Brief: Create a
Custom 3D Focal
Protocol

1. Select a 3D Focal CSI
series.

2. Click [Get Protocol].

3. Select a metabolite ratio
protocol.

4. Determine the maximum
for the desired metabolite
peaks using the cursor in
the spectral grid view.

5. In the Image(s) A text
box, enter abs 71.

6. In the Image(s) C text
box, enter abs 82.

7. Change the Threshold
text box value to 500.

8. If needed, change the
Scale text box value to
1000.

9. Click [Compute].

10. Make any changes to the
Threshold value required
to create a pleasing ratio
map, and to the Scale
value.
2292264-100 Rev. 0 (03/01) 8-63



Signa® MR/i ™ with Signa Select™ (ASP2) Volume 4
Fig 5. In the Image(s) A input parameter text box, enter abs 71,
the point value of the first metabolite.

6. In the Image(s) C input parameter text box, enter abs 82,
the point value of the second metabolite.

• Leave the Image(s) B and Image(s) D input parameter
text boxes empty.

7. In the Threshold text box, change to an initial value of 500.

8. If needed, in the Scale text box, change the value to 1000.

9. Click [Compute] to compute and display the new Ratio
map.

10. Make any changes to the Threshold value required to
create a pleasing ratio map, and to the Scale value to
produce reasonable ratio values.

• For example, setting the Threshold value to 500 may
produce a map with spurious signals outside of the
prescribed PRESS voxel, in that case you would
increase the value. If on the other hand the map is
black, the threshold is too large and should be reduced.

11. Click [Save Protocol] to save this new protocol.

12. When prompted for the new name, enter a suitable name,
for example, Cho/Cr MAX, and click [OK].

• The new protocol appears on the [Get Protocol] menu,
and remains there until deleted.

In Brief: Create a
Custom 3D Focal
Protocol

11. Click [Save Protocol] to
save.

12. Enter a name and click
[OK].
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Symbols
# of Phases to Reconstruct V2, 13-18

Numerics
2D Mode V1, 3-16
2D PC Oblique Imaging V2, 8-7
2D Phase Contrast (2D PC) V2, 8-6
2D Time of Flight GRE and SPGR V2, 6-3
2DTOFX V2, 6-6
2-Point Tool V3, 5-13, V3, 5-32
3 Plane Localizer V2, 1-1, V2, 1-6
3D Analysis V4, 7-1, V4, 7-2
3D CSI Viewport Layout V4, 8-18
3D Focal CSI V2, 12-32
3D Focal CSI Display Tool Command Window V4, 8-40
3D Mode V1, 3-17
3D MultiSlab V1, 3-19
3D Phase Contrast (3D PC) V2, 8-23
3D TOF GRE/SPGR V2, 6-15
3D Volume Prescription V1, 3-19
3-Point Tool V3, 5-14, V3, 5-32, V3, 5-33

A
A.I. V1, 6-10
A.I. Code V1, 6-30
A.I. Mappings Browser V1, 6-10
Abbreviated Patient Information V1, 3-8
Abdomen Application V3, 5-50
Abort Scan V1, 2-6
About IVI... V4, 5-6
abs N..M V4, 8-45
Accelerator Bar V1, 9-70
Accelerator Command List V1, 9-71
Accelerator Commands V1, 9-18, V1, 9-70
Accept Negative Pixels V4, 3-10
Acoustic Hazards V1, 1-26
Acquire at Current V3, 5-37
Acquire at End V3, 5-34, V3, 5-35
Acquire at Start V3, 5-34, V3, 5-35
Acquire End V3, 5-19
Acquire Start V3, 5-19
Acquire Tab Card Screen V3, 5-6
Acquisition Matrix V1, 3-58
Acquisition Timing V1, 3-58
Active Spectrum V4, 8-32
Adaptive Phased Array V1, 4-8
Add a Host V1, 11-35
Add One or Two Sets of Images V4, 3-12
Add Protocol V4, 5-30
Adding one or two sets of images V4, 3-12
Additional Imaging Options V3, 1-45
Additional Parameters V1, 3-39
Adjust the Receiver Gain to Achieve Optimum Signal V1,

8-17
Adjust the Transmit Gain to Achieve Optimum Flip Angle
V1, 8-12
Adjusting the Composite Overlay V4, 8-59
Advanced Processing V4, 5-7
Advisory Panel V1, 3-84
AE Title V1, 2-19
Algorithms V4, 8-10
Along trace V4, 5-18
Analog Gain R1 V1, 8-17
Analyzing Images V1, 9-36
Angle V4, 5-8
Angle Between Views V4, 5-30
Angle between views V4, 5-33
Annotate V1, 9-48
Annotation V1, 9-16
annotation V1, 9-10
Annotation (system) V1, 9-59
Annotation of an Edited Exam V4, 2-6
Anonymous Patient V1, 11-4
Apply Cut V4, 5-18
Apply Locations V3, 5-19, V3, 5-34, V3, 5-35
Applying Mattes to Images V1, 9-51
Archive Image Data V1, 11-18
Archive Media V1, 11-5
Archive Node V1, 6-35
Archive Queue V1, 11-9
Area V4, 5-8
Arrhythmia Rejection V2, 10-5
Arrhythmia Rejection Window V2, 13-18, V3, 2-40
Arrhythmia Rejection Window (ARW) V3, 2-42
Assign Image Storage V1, 6-34
Audio Trigger Volume V3, 2-34
Auto Archive V1, 3-73
Auto Center Frequency V1, 3-65
Auto Clear V1, 10-15
Auto Clear Page V1, 10-7
Auto Prescan V1, 3-89, V1, 8-4
Auto Printing V1, 10-6, V1, 10-15
Auto Scan V1, 3-83, V1, 7-12
Auto Transfer by Exam V1, 3-74
Auto Transfer by Series V1, 3-74
Auto Window/Level V1, 3-26
Automatically Prescanning V1, 8-9
Autoshim V1, 3-68
AutoStep V1, 3-84, V1, 7-13, V3, 4-6, V3, 4-9
Autoview V1, 3-24
autoview screen V1, 2-2
AutoView Window V1, 3-24
Available Imaging Time (AIT) V3, 2-47, V3, 2-55
Average V4, 8-16
Averages V3, 5-18
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B
Bandwidth V1, 3-38
Basic Problem Resolutions V1, 2-18
Batch Command Window V4, 6-26
Batch Filming/Movies V4, 5-6
Batch Projection V4, 5-28
Bind Images V4, 3-20
Binding Images V4, 3-7
Binding images V4, 3-20
Biomagnetic Hazards V1, 1-23
Birthdate V1, 6-5
Blood Oxygen Level Dependent V4, 8-11
Blood Suppression V3, 1-44
Body Coil V1, 4-7, V1, 4-16
body coil V1, 4-16
BOLD V4, 8-11
Bolus Chasing V3, 4-1
Bookmark V3, 5-39
Bookmark - Recall V3, 5-30
Bookmark - Replace V3, 5-30
Bookmark Images V3, 5-9
Bookmark images V3, 5-11
Bore heating V1, 1-17
Brachial Plexus Application V3, 5-49
Brain Spectrum V2, 12-6
Browser V1, 9-6
Building a Protocol V1, 5-9
Burn Hazards V1, 1-16
Burst Scan Time V3, 3-3
B-Value V2, 11-34

C
Cable Connection Ports V3, 2-17
Cable/Connector Warnings V1, 1-18
Cancel Identify V4, 5-24
Cardiac Array coil V1, 4-24
Cardiac Compensation V3, 1-32
Cardiac Gating V3, 2-6
Cardiac Gating and Triggering V3, 1-33
Cardiac Gating and Triggering Parameters V3, 2-37
Cardiac Gating/Triggering V3, 2-74
Cardiac Phases V3, 2-47
Cardiac Phases to Reconstruct V2, 9-6
Cardiac Pulse Sequences V2, 13-1
Cardiac Sweep Rate V3, 2-29
Cardiac Trigger Level V3, 2-31
Cardiac Trigger Level Annotation V3, 2-33
Cardiac Triggering V3, 2-7
Cardiac Waveform V3, 2-24
Cardiac/Peripheral Display V1, 2-5
CEMRA V3, 3-2
Centric K-space Filling V3, 3-6

Change window width and level V1, 9-27
Check the Archive Queues V1, 11-30
Check the Cryogen Levels V1, 1-46
Chemical Saturation V1, 7-37, V1, 8-7, V3, 1-39
Chemical Shift Imaging (CSI) V2, 12-4
ChemSAT Tune V1, 8-7
Choline V4, 8-43
Choline (Cho) V2, 12-6
Choline/creatine V4, 8-43
Choline/N-acetyl V4, 8-43
CINE V3, 2-5
CINE Acquisitions V3, 2-9
Cine GRE V2, 9-3
Cine Mode V1, 3-21
Cine Paging V1, 9-7, V1, 9-31
Cine PC V2, 9-19
Cine Pulse Sequences V2, 9-1
Cine Screen V1, 3-48
Cine SPGR V2, 9-17
ClariView V4, 1-1, V4, 1-3, V4, 1-10
ClariView and PPS V1, 6-26
ClariView filters and PPS V1, 6-26, V4, 1-4
ClariView Screen V4, 1-6
Classic V3, 1-20
Classic and Improved Fat Saturation V1, 7-39
Clear Trace V4, 5-18
Clinical Hazards V1, 1-23
Closing Real Time Interactive Imaging V3, 5-17
Coil Sensitivity Range V1, 4-8
Coil Type V1, 3-11
Color / Light / Window V4, 5-6
Combined Cardiac and Respiratory Gating/Triggering V3,
2-56
Combined Cardiac and Respiratory Gating/Triggering
Guide V3, 2-58
Combined Cardiac and Respiratory Gating/Triggering
Screen V3, 2-35
Combining Images V4, 3-1
COMP V1, 6-25
compare V1, 9-34
Complete V1, 6-10, V1, 6-25
Complex Difference V2, 8-6
Composite V4, 8-43
composite overlay V4, 8-10
Composition of Archiving Option V1, 11-6
Computer room V1, 2-14
Concatenated SAT V1, 7-34
concatenated spatial saturation V1, 7-73
Configure V1, 10-22
Configure a Remote Host V1, 11-35
Configuring a Remote Host V1, 11-38
Confirguring mobile sites V1, 2-22
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Connect Pro V1, 6-23
ConnectPro V1, 6-7
ConnectPro Plus V1, 6-7, V1, 6-12
Console Room V1, 2-9
Contraindications for Use V1, 1-6
Contrast V1, 3-70
Contrast Mechanism V3, 3-3, V3, 4-4
Contrast resolution V1, 7-15
contrast-enhanced MR angiography V3, 3-1
Control panel V1, 5-4
control room V1, 2-9
Conventional SAT V1, 7-32
copy an entire protocol V1, 5-14
Copy Rx V1, 7-26
Copying a Protocol V1, 5-14
Copying a series in a Protocol V1, 5-22
Correlation Coefficient V4, 8-10, V4, 8-52
Create an Anonymous Patient V1, 11-16
Creatine V4, 8-43
Creatine/phosphocreatine (Cr/PCr) V2, 12-6
Creating a Custom 3D Focal CSI Protocol V4, 8-63
Creating Vascular Projections V4, 5-1
Cross-Reference V1, 9-56
Cross-Reference a Series V1, 9-56
Cryogens V1, 1-11
CTL Array coil V1, 4-21
Cube V4, 5-26
Cursor Location Spectrum V4, 8-33
Cursor Lock V4, 5-6
Curved reformat V4, 6-68
Custom annotation V1, 9-60
Cut Plane Tools V3, 5-13

D
Data Available for Edit V4, 2-3
dB/dt Level V1, 3-87
Defer V1, 6-10, V1, 6-25
Define Cut Planes V3, 5-32
Define Saturation Bands V1, 7-72
Defining a Region of Interest with MIROI V4, 4-1
Defining a Scanning Range V1, 7-22, V1, 7-62
Defining Saturation Bands V1, 7-32, V1, 7-72
deg V4, 5-7, V4, 5-26
Degrees V4, 5-26
Delay After Acquisition V1, 3-50
Delete protocol V4, 5-35
Deleting a Host V1, 11-38
Deleting a Protocol V1, 5-19, V1, 5-20
Deleting a Registered Patient V1, 6-6, V1, 6-22
Deleting an IVI protocol V4, 5-35
Deleting Site Protocols from MOD V1, 5-31
Desktop Organization V1, 2-16
Detach Storage Media V1, 11-32

dev N..M V4, 8-46
Diastole V3, 2-12
Difference Function V4, 8-16, V4, 8-56
Diffusion Coefficient V4, 8-16, V4, 8-54
Diffusion EPI V2, 11-32
Digital Gain R2 V1, 8-17
Discontinue V1, 6-11, V1, 6-25
Display Desktop V1, 2-16
Display Modes V4, 5-6
Display modes V4, 5-32
Display Normal V1, 9-44
Display/Actions Defaults V4, 5-6, V4, 5-17
Displaying 3D Focal CSI Images V4, 8-60
Displaying Images in Viewer V1, 9-25
Displaying the Graphs V4, 8-51
Displaying Valid Image Sets V4, 8-50
Distance V4, 5-8
Double-IR V2, 13-4
Drag and Drop V1, 10-15
Draw Line V3, 5-13, V3, 5-32
Driven Equilibrium Preparation V3, 1-24
DWI Screen V1, 3-50

E
E,S,I V1, 10-15
ECG Gating Warnings V1, 1-20
ECG Gating/Triggering V3, 2-5
ECG Histogram V3, 2-25
ECG Inversion V3, 2-30
ECG Lead Placement V3, 2-18
ECG Lead Selection V3, 2-29
ECG Leads V3, 2-13
ECG Noise Filter V3, 2-28
ECG Waveform V3, 2-9
Echo Planar Imaging (EPI) V2, 11-4
Echo Planar Pulse Sequence V2, 11-1
Echo Time V1, 3-30
Echo Train Length V1, 3-36
Edit Applications screen V4, 2-10
Edit Log V4, 2-8
Edit Patient Data V4, 2-12
Edit Patient Data Screen V4, 2-7
Edit Patient Data screen V4, 2-12
Editing a Protocol V1, 5-16, V1, 9-54
Editing a protocol V1, 5-16
Editing Patient Data V4, 2-10
Eliminate Ferromagnetic Items From The Security Zone
V1, 1-36
Eliminate Magnet Hazards V1, 1-36
Ellipse ROI V4, 8-46
elliptical matte V1, 9-51
Elliptical ROI V4, 8-51
elliptic-centric k-space filling V3, 4-2
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Emergency Magnet Run-Down V1, 1-28
Emergency Off V1, 1-27
emergency off V1, 1-27
Emergency Stop V1, 1-26, V1, 2-4
emergency stop V1, 1-26
End Exam V1, 3-78, V1, 7-10
End Exams with ConnectPro V1, 6-10
End PPS V1, 6-25
Enhancing Images V1, 9-54
Enhancing with Smoothing V4, 1-9
Equipment Hazards V1, 1-26
Erase All V1, 9-42
Erasing an Image From the Film V1, 10-19
Exam Description V1, 6-6
Exam Text Page V1, 10-18
Exclusion Zone V1, 1-10
Explicit V4, 5-25
Explicit Prescription V1, 7-22
Explicit prescription V1, 7-62
Explicitly V1, 7-62, V4, 5-26
Exponential Diffusion Coefficient V4, 8-17, V4, 8-57
Expose Order V1, 10-7
Extended Dynamic Range V3, 1-48
Extract Minimum or Maximum Pixel Values V4, 3-16

One Set of Images V4, 3-16
Two Sets of Images V4, 3-18

Extract the minimum or maximum pixels V4, 3-16
Extremity coil V1, 4-22

F
F Keys V1, 10-8
F1 V1, 10-8, V1, 10-16
F1-F11 V1, 10-8
F1-F4 keys V1, 10-8, V1, 10-16
F2 V1, 10-9, V1, 10-16
F3 V1, 10-9, V1, 10-16
F4 V1, 10-9, V1, 10-17
Factors that Affect Contrast V1, 7-15
Factors that Affect Scan Time V1, 7-17
Factors that Affect SNR V1, 7-18
Factors that Affect Spatial Resolution V1, 7-16
Fallback V1, 7-27
Fan V1, 2-6
Fast 2D Phase Contrast V2, 8-15
Fast 2D Time of Flight GRE/SPGR V2, 7-4
Fast 2DPC V2, 8-15
Fast 3D TOF GRE/SPGR V2, 7-17
Fast Gradient Echo (FGRE) V2, 5-3
Fast Recovery Fast Spin Echo (FRFSE) V2, 3-21
Fast Spin Echo (FSE) V2, 3-3
Fast Spin Echo Pulse Sequences V2, 3-1
Fast Spin Echo-Inversion Recovery (FSE-IR) V2, 3-30
Fast Spoiled Gradient Echo (FSPGR) V2, 5-3

Fast Time of Flight Pulse Sequences V2, 7-1
FastCard V2, 10-3
FastCard Non-sequential V2, 10-5
FastCard Pulse Sequence V2, 10-1
FastCard Sequential V2, 10-4
FastCine V2, 13-15
FastCine PC V2, 13-15
Feature Status Area V1, 11-4
Female Pelvis Application V3, 5-52
Field of View V1, 3-51
Film Composer V1, 10-4, V1, 10-13, V4, 5-6
Film Format V1, 10-5
Filming Queue V1, 10-23
Filming Setup V4, 5-6
filming the text page V1, 10-18
Filter and Save to Database V4, 1-7
Filter Description and Use V4, 1-4
Filter Floaters V4, 5-8
Filter J V4, 1-3
Filter Name V4, 1-4
Final View V4, 5-34
First View V4, 5-33
FLAIR V2, 3-38
Flair EPI V2, 11-26
Flip Angle V1, 3-35, V1, 8-6
flip or rotate V1, 9-47
Flow Analysis V2, 9-28
Flow Compensation V3, 1-26
Flow Compensation Direction V1, 3-67
Flow Encoding Axis V2, 9-34
Flow Recon Type modes V2, 8-6
FOV Center V1, 3-55
FPS V1, 9-32
Fractional Echo V1, 3-31
Frame Rate V3, 5-7
Frames per Second Notification V1, 3-86
free trace V4, 5-17
Frequency Direction V1, 3-64
Frequently Asked Cardiac Questions V3, 2-69
FRFSEOPT V2, 3-23
FSE-XL V2, 3-7
FSE-XL IR with Blood Suppression V2, 13-6
FSE-XL with Blood Suppression V2, 13-4
Full annotation V1, 9-60
Full Echo Train V3, 1-47
Function (F) keys F5-F10 V1, 9-68
Function Algorithms V4, 8-52
Function menu V4, 8-40
FuncTool V4, 8-1
FuncTool Layout V4, 8-5

G
Gated 2D TOF V2, 7-4
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Gating V3, 2-6
Gating Contro V1, 3-75
Gating Control V3, 2-23
Gating Reset V3, 2-34
Gating/Triggering Icon V1, 3-47
Gating/Triggering Screen V1, 3-47
GE Library V1, 5-5, V1, 9-16
GE Protocol Library V1, 7-5
Get Protocol V4, 8-42
GI

HIS/RIS DICOM V1, 6-27
Mobile V1, 2-24, V1, 2-26

Glutamate (Glu) V2, 12-7
Glutamine (Gln) V2, 12-7
GPFlex V1, 4-25
Gradient and Shim Coil Function V1, 4-3
Gradient Coils V1, 4-3
Gradient Echo (GRE) V2, 4-3
Gradient Echo EPI V2, 11-11, V2, 11-19
Gradient Echo Pulse Sequences V2, 4-1
Gradient, Shim, and Imaging Coils V1, 4-1
Graphic Prescription V1, 7-23
Graphic Prescription Screen V1, 3-42
Graphic Rx Icon V1, 3-43
Graphic SAT Prescription V1, 7-41
Graphically V1, 7-65
Graphics V4, 5-8
Greyscale V1, 10-6
Grid V1, 9-41
Grid appearance V1, 9-63
Grid Preferences V1, 9-17, V1, 9-63
Grid spacing V1, 9-63
Guided Install V1, 2-23, V1, 2-26, V1, 6-13, V1, 6-30
Guided Install - HIS/RIS DICOM Mode V1, 6-33
Guided Install for HIS/RIS DICOM V1, 6-13
Guided Install for Mapping Protocols to Action Items V1,
6-13
Guided Install HIS/RIS DICOM Mode V1, 6-27
Guided Install window V1, 6-28

H
Handle V4, 5-26
Handle Contact with Liquid Cryogens V1, 1-48
Hazard Warnings V1, 1-13
Head Coil V1, 4-6
head coil V1, 4-13
Head Coil QA V1, 4-10
Heart Application V3, 5-54
Heart Rate/Update Rate V3, 2-50
Hide and Show V1, 9-43
High Risk Patients V1, 1-24
HIS/RIS V1, 6-7
HIS/RIS Action Item Code V1, 6-32

HIS/RIS DICOM mode V1, 6-13, V1, 6-27
HIS/RIS tab V1, 6-14
Histogram V4, 8-51
histogram V4, 8-10
Home V1, 2-6
Home Images V3, 5-9
Home images V3, 5-9
Hydrogen Proton Precessional Frequency V1, 4-5

I
IAC Application V3, 5-39
Icon labels V1, 10-7
Identify mm./slices V4, 5-6
Identify W/L V4, 5-24
iDrive V3, 5-1, V3, 5-4
iDrive Pro V3, 5-4
IGRx V3, 5-18, V3, 5-19
ilinq Desktop V1, 2-17
Image V1, 10-15
Image Acquisition Delay V3, 3-3
Image Addition V4, 3-4
Image Analysis V4, 7-2
Image Annotation V1, 9-12
Image Buffer V3, 5-20
Image Combination V4, 3-4
Image Combination Menu V4, 3-7
Image Contrast Buttons V3, 5-14
Image Display V1, 3-25
Image Enhance V1, 9-54
Image Enhancement Purpose and Benefits V4, 1-3
Image Management Desktop V1, 2-16
Image Slide Bar V4, 1-6
Image Storage Annotation V1, 6-34
Image Subtraction V4, 3-5
Imaging Coil Function and Classification V1, 4-5
Imaging Mode V1, 3-16
Imaging Option Annotation V1, 9-13
Imaging Options V1, 3-22, V1, 7-14
Imaging Plane V1, 3-13
Implant and Prosthesis Hazards V1, 1-6
Indications for Use V1, 1-5
Individual Spectra V4, 8-33
Infusion Angiography V3, 3-3
inhomogeneities V1, 4-5
INPR V1, 6-25
Inside trace V4, 5-18
Interactive V4, 5-25
Interactive Vascular Imaging V4, 5-1
Interleaved V1, 3-49
Inter-Sequence Delay V3, 2-46
Inter-Sequence Delay (ISD) V3, 2-55
inverse video V1, 9-78
Inversion Recovery (IR) V2, 2-15
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Inversion Recovery Preparation V3, 1-23
Inversion Time V1, 3-34
IP address V1, 2-18, V1, 2-19, V1, 2-23
Isometric voxels V4, 5-3
IVI V4, 5-1, V4, 5-15
IVI Command Window V4, 5-15, V4, 5-20
IVI process V4, 5-1

K
Keyboard & Mouse V1, 2-10
Knee Application V3, 5-46
K-space Filling V3, 4-4

L
Label Storage Media V1, 11-20
Labeling the Storage Media V1, 11-6
Lactate (Lac) V2, 12-7
Lactate lipid V4, 8-43
Landmark V1, 2-6, V1, 3-8, V1, 5-10, V1, 6-6
Landmarking V1, 7-50
Laser Align Light V1, 2-5
Laser Light Hazards V1, 1-13
Lead Display V3, 2-29
level V1, 9-6
Light V1, 2-6
Limit Access to the Exclusion Zone - Screen Patients and
Personnel V1, 1-37
Linking a Protocol to a Patient V1, 6-18
Lipids (Lip) V2, 12-7
Liquid Cryogen Concerns V1, 1-11
List of Previously Entered Hospitals V1, 2-20
Loading Text Pages V1, 10-18
Loading the images V1, 10-8
Loading with Drag and Drop V1, 10-15
Loading With the Function Keys V1, 10-16
Locations per Acquisition V3, 2-68
Locations per Acquisitions V2, 9-5
log N..M V4, 8-46
Lower Left (LL) Viewport V4, 8-35
Lower Right (LR) Viewport V4, 8-38
LX Table V1, 2-8

M
Magnet Emergencies V1, 1-41
magnet enclosure V1, 2-4
Magnet Hazards V1, 1-8
magnet room V1, 2-4
Magnetic Resonance Angiography (MRA) V4, 5-1
Magnetic Resonance Suite V1, 2-3
Magnetization Transfer V3, 1-42
Magnify glass V1, 9-65
Magnifying Glass V1, 9-39
Magnifying Images V1, 9-37
Manage Disk Space V1, 11-33

Managing Disk Space V1, 11-10
Managing Images V1, 11-1
Managing Site Protocols V1, 5-7
Manual Arrhythmia Monitoring V2, 13-18, V3, 2-43
Manual Prescan V1, 3-89, V1, 8-4
Manually Prescan V1, 8-10
Manually Prescanning V1, 8-10
Mapping Protocols V1, 6-30
mask V3, 4-1
masking V3, 4-2
Match Coarse Center Frequency to the Patient V1, 8-10
Match Fine Center Frequency to the Patient V1, 8-15
Matrix Zerofill Interpolation Processing V3, 1-13
Matte V1, 9-51
max N..M V4, 8-46
Maximize/Minimize V1, 3-27
Maximum Difference Function V4, 8-15, V4, 8-56
Maximum intensity pixel V4, 5-4
Maximum Monitor Period V3, 3-3
Maximum Pixel Extraction V4, 3-6
Maximum Slope of Increase V4, 8-14, V4, 8-53
Mean Time to Enhance V4, 8-13, V4, 8-53
Measure V1, 9-53
Merge ROI V4, 8-47
Message area V3, 5-16
Metabolite and Ratio Maps with Sharp Edges V4, 8-48
Metal Heating Warnings V1, 1-21
Meta-series V3, 4-3
meta-series V3, 4-2
Millimeters V4, 5-26
min N..M V4, 8-46
Minimum Pixel Extraction V4, 3-6
MIP V4, 5-1, V4, 5-4
MIROI Basics V4, 4-4
MIROI Layout V4, 4-4
mm V4, 5-26
Mobile Site Configuration V1, 2-18, V1, 2-23
Mobile Site Setup V1, 2-23, V1, 2-24
Mobile Site Setup window V1, 2-24
MOD V1, 2-10
Mode V1, 3-73
Modify Model V4, 5-7, V4, 5-16, V4, 5-21
Modifying the Volume V4, 5-14
Mouse basics V1, 2-13
Move to Scan V1, 2-6
Movement/Rotation Increment buttons V4, 6-25
Movies screen V4, 5-28, V4, 5-29
Movies window V4, 5-29
MPVR V4, 7-1
MR Angio V4, 7-1
MR Compatibility V1, 1-31
MR Spectroscopy Protocols V4, 8-17
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MRA Algorithms V4, 1-9, V4, 1-13
MRA-MIP filter V4, 1-3
MRS Mode V1, 3-21
Multi Phase V3, 1-50
Multi Phase Icon V1, 3-49
Multi Phase Screen V1, 3-48
Multi-Plane Graphic Rx V1, 7-28
multiple stations V3, 4-1
Multi-Slab V2, 6-20
Multi-Station V3, 1-53
Myo-inositol (ml) V2, 12-7

N
N-acetyl V4, 8-43
N-acetylaspartate (NAA) V2, 12-6
Navigate the Schedule Screen V1, 6-8
Navigate through screens and menus V1, 2-30
Negative Enhancement Integral V4, 8-12, V4, 8-53
Netmask V1, 2-19
Network DICOM Devices V1, 2-20
Network from the Scan Rx Desktop V1, 11-42
Network Images To & From Connected Stations V1,
11-42, V1, 11-45
Network Queues V1, 11-13
Networking Terms V1, 11-12
Networks V1, 11-12
Neurovascular coil V1, 4-23
New Save Series V4, 3-8
New Series V1, 3-77, V1, 7-9
NEX and SNR V1, 7-21
niobium-titanium V1, 4-5
No Phase Wrap V3, 1-9
No. of Copies V1, 10-7
Number of Acquisitions Before Pause V1, 3-63
Number of Acquisitions/Locations Before Pause V1, 3-63
Number of Cardiac Phases to Reconstruct V3, 2-48, V3,
2-68
Number of Echoes V1, 3-28
Number of Excitations (NEX) V1, 3-60
Number of Locations Before Pause V1, 3-63
Number of Repititions Before Pause V1, 3-63
Number of Respiratory Intervals V3, 2-51
Number of R-R Interval V3, 2-39
Number of Shots V1, 3-29
Number of Slices/Slabs V1, 3-56
Number of views V4, 5-33

O
Oblique Batch V4, 6-64
Oblique Mode Select V4, 5-7
on-screen trackball V4, 5-25, V4, 5-26
Optimize Chemical Saturation V1, 8-19
Optimizing Image Quality with Prescanning V1, 8-1

Options for Saturation Techniques V3, 1-36
Options that Control Artifacts V3, 1-4
Options that Enhance or Alter Contrast V3, 1-17
Options that Enhance Spatial Resolution V3, 1-12
Options that Minimize the Effects of Motion V3, 1-26
Options to Balance SNR V3, 1-45
Orbit Application V3, 5-42
Orientation Buttons V3, 5-16
Output mode V4, 5-30
Outside trace V4, 5-18

P
PAC (Physiologic Acquisition Control) Unit V1, 2-7
Paging V1, 9-7, V1, 9-31
Pan Cursor V3, 5-11
Parameter Trade-offs V1, 7-15
Parametric images V4, 8-10
Partial annotation V1, 9-60
Partial Radial Spacing V1, 7-29
Patient Age V1, 6-5
patient alert device V1, 2-2
Patient Alert System V1, 1-30
Patient Comfort Module V1, 1-16
Patient Demographics V1, 6-4
Patient Emergencies V1, 1-31, V1, 1-40
Patient Entry V1, 3-11
Patient History V1, 6-6
Patient Information V1, 3-6
Patient Information Edit Log V4, 2-8
Patient Informaton Edit Log V4, 2-14
Patient Log V4, 2-14
Patient Position V1, 3-9
Patient Positioning Warnings V1, 1-16
Patient Preparation and Scan Start Up V3, 3-13
Patient Register V1, 6-21
Patient Screening Form V1, 1-38
Patient transport V1, 2-8
Patient Weight V1, 6-5
Pause Scan V1, 2-6
Pause Scanning V3, 5-18, V3, 5-36
Pause When Ful V3, 5-38
Pause When Full V3, 5-36, V3, 5-37
PC V4, 5-3
PC Monitor V1, 2-10
Perform Arrhythmia Rejection and FastCard V3, 2-42
Performed Procedure Step V1, 6-12
Performing Coil QA V1, 4-10
Performing QA for Other Coils V1, 4-11
Peripheral (photo-pulse) Sensor V3, 2-15
Peripheral Gating Warnings V1, 1-20
Peripheral Gating/Triggering V3, 2-5
Peripheral Nerve Stimulation V1, 1-13
Peripheral nerve stimulation V1, 1-29
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Peripheral Vascular coil V1, 4-24
Phase Acquisition Order V1, 3-49
Phase Contrast V4, 5-3
Phase Contrast (PC) V2, 8-3
Phase Contrast Pulse Sequences V2, 8-1
Phase Correct V1, 3-69
Phase Difference V2, 8-6
Phase FOV V1, 3-61
Phase Offset Multi-Planar V3, 1-45
Phased Array Breast coil V1, 4-23
phased array coils V1, 4-18
Phases of SmartPrep V3, 3-5
Phases Per Location V1, 3-49
Picture This Library V1, 5-6, V1, 9-18
Picture This Protocol Library V1, 7-5
Place Bellows and Route the Tubing V3, 2-84
Place Electrodes and Route the Cable V3, 2-74
Play Backward V3, 5-22
Play Forward V3, 5-22, V3, 5-37
Port No. V1, 2-19
Position the Patient V1, 7-51
Positive Enhancement Integral V4, 8-11, V4, 8-57
Post Process Three Station Runoffs

Acquire Collapsed Images with IVI V4, 3-26
Bind Multiple Series into a Single Series V4, 3-28
Subtractions V4, 3-22

Post Processing Three Station Runoffs V4, 3-22
Power down under emergencies V1, 2-38
Powering down under Emergencies V1, 2-22
PPS V1, 6-12, V1, 6-23
P-R Interval V3, 2-11
Precessional and Transmit Frequency V1, 8-6
Pregnant or Infant Patients V1, 1-23
Prep Scan V1, 3-89
Prepare the Patient for the Exam V1, 7-46
Prepare to Scan V1, 3-82, V1, 7-11
pre-register a patient V1, 6-1
Pre-Registering a Patient V1, 6-16
Pre-Registering Patient V1, 6-4
Prerequisite Skills V1, About-1, V2, About-1
Prescan V1, 3-88
Prescanning V3, 4-6, V3, 4-11
Prescribe Scan Locations For A Series V3, 5-34
Preset buttons V4, 6-19
Preset window widths and window levels V1, 10-25
Presets V1, 9-18, V1, 9-68, V1, 10-25
PRESS V2, 12-10
Preview V4, 5-30
Previewing Command Window for Film Batch or Movie
Loop V4, 6-37
primary viewport V1, 9-5
print options V1, 10-6

Print Queue V1, 10-11, V1, 10-23
Print Series V1, 10-10, V1, 10-17
Print Series window V1, 10-10, V1, 10-17
Printer V4, 5-30
Printing V1, 10-8, V1, 10-20
Printing Images V1, 10-20
Printing Protocols V1, 5-24
Printing Site Protocols V1, 5-24
PROBE/SV V2, 12-4
PROBE-P V2, 12-10
PROBE-S V2, 12-10
Protect the Patient from RF Burns V1, 1-43
Protect the Patient’s Eyes and Ears V1, 1-45
Protocol V1, 3-23, V1, 7-4
Protocol Algorithms V4, 8-55
Protocol Building V1, 5-1, V1, 5-9
Protocol Desktop V1, 2-16
Protocol Libraries V1, 7-4
protocol Libraries V1, 5-14
protocol library V1, 5-14
Protocol Manager V1, 5-4
Pulse Sequence V1, 3-21
Pulse Sequence Annotation V1, 9-15
Pulse Sequence Database Name V1, 3-22
Pulse Sequences V1, 7-13
Purpose and Benefits V1, 8-4
P-Wave V3, 2-10

Q
QA test V1, 2-15
QRS Complex V3, 2-11
Quality Assurance V1, 2-15
Quench V1, 1-11
Quench with Vent Failure V1, 1-42
Quick Step iDrive for 3 Plane Localizer V3, 5-56

R
Radial Batch V4, 6-66
Radial Graphic Rx V1, 7-28
Radial Graphically V1, 7-70
Ramp Pulse V2, 6-16
Ratio (A-B)/(C-D) V4, 8-17, V4, 8-45, V4, 8-54
Ratio Slider V4, 3-9
Raw f ile manager V1, 2-36
Raw file manager V1, 2-37
Real Time V3, 5-5
Real Time Interactive Acquire Tab Card V3, 5-28
Real-Time V3, 1-53
Real-Time Sequence V3, 5-27
Reasons for Auto Prescan Failures V1, 8-5
reboot V4, 1-13
Rebooting During the ClariView Procedure V4, 1-13
Receive V1, 8-7
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Receive Gain V1, 8-7
Receiver Bandwidth and SNR V1, 7-20
Receiver Sensitivity V1, 8-7
rectangular matte V1, 9-51
Redo V3, 5-17
Reference Image V1, 9-8, V1, 9-45
reference image V4, 8-9
Reference Scan V1, 3-90
Reformat

Cursor / Annotations Command Window V4, 6-42
Display / Graphics Options Command Window V4,
6-42
Display / Graphics Options Command window V4,
6-44
File Menu V4, 6-7
Graphics Command Window V4, 6-10
Identify mm. / Slices Command Window V4, 6-39
Layout V4, 6-5
Oblique Mode Select Button V4, 6-18
On View Operations V4, 6-50
Plane Orientation Indicator V4, 6-6
Series/Image Selection V4, 6-5
Tilt/Rotate Mode Select Button V4, 6-17
Valid Image Set V4, 6-4
View Type Buttons V4, 6-20

Reformat Layout V4, 6-5
Reformation Color Window Command V4, 6-46
Reformation Film Command Window V4, 6-48
Refresh V1, 10-24
Refresh List V1, 9-24
Region of Interest V4, 8-46
Region-of-Interest (ROI) V4, 8-19
Regulate Contrast with Cardiac Gating V3, 2-80
Regulate Contrast with Respiratory Gating V3, 2-88
Relative SNR% V1, 3-85
Remote Configure window V1, 10-22
Remote Printer V1, 10-11, V1, 10-21
Remove a Host V1, 11-38
Remove Annotation V1, 9-50
Remove Image Data V1, 11-33
Removing Images from the System Disk V1, 11-11
Repeat a Series V1, 5-22
Repetition Time V1, 3-33
Report Cursor V1, 3-25
Reset Center V1, 7-27
Reset the TPS V1, 2-35
Reset TPS V1, 2-18
Reset Values V1, 3-85
Respiratory Bellows Placement V3, 2-21
Respiratory Compensation V3, 1-28
Respiratory Display V1, 2-4
Respiratory Gating V3, 2-7, V3, 2-16
Respiratory Gating and Triggering V3, 1-30, V3, 2-16

Respiratory Gating and Triggering Parameters V3, 2-50
Respiratory Gating with FastCine/FastCine PC V2, 13-19
Respiratory Gating/Tiggering V3, 2-5
Respiratory Gating/Triggering V3, 2-84
Respiratory Triggering V3, 2-8, V3, 2-17
Respiratory Waveform V3, 2-25
Respond to Emergencies V1, 1-40
Restore Images from Local Archive Media V1, 11-26
Restoring Images from Local Archive Media V1, 11-8
Restoring Protocols from MOD V1, 5-31
Restrictions for Restoring Images from Archive Media V1,
11-8
Restrictions for Saving Images V1, 11-7
Restrictions on Use V1, 1-5
Retrieve Images from a Remote Host (Network Receive)
V1, 11-48
Retrieve Locations V3, 5-19
Reversing the Video V1, 9-78
Review Tab Card V3, 5-22
Reviewing Protocol Parameters V1, 7-60
RF Power V1, 1-22
Right Mouse Button V1, 9-65
Right Mouse button V1, 9-17
Rotate Cursor V3, 5-12
Rotate using first and last image V4, 5-32
Rotating the MIP V4, 5-25
Rotation V4, 5-29
Rotation Increment V4, 5-7
Rotation Movie Loop Command Window V4, 6-33
R-R Interval V3, 2-12
Rx Locations V3, 5-18
Rx Manager V1, 3-71, V1, 7-6
Rx Manager List V1, 3-79, V1, 7-7

S
Safety Information V1, 1-5
Safety Notices V1, About-7, V2, About-5
Safety Review V1, 1-34
SAR Level V1, 3-86
SAR Limits V1, 1-24
SAT Gap V2, 7-8
SAT Icon V1, 3-40
SAT in the FOV V1, 7-35
SAT Prescription Screen V1, 3-40
SAT pulse V2, 6-6
Save V4, 5-30
Save Image V3, 5-38
Save Image button V3, 5-17
Save Images V1, 11-23, V3, 5-38
Save Range V3, 5-38
Save raw data V1, 2-21
Save Rx as Protocol V1, 3-82, V1, 5-19, V1, 7-11
Save Series V1, 3-85
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Save State V1, 9-77
Save Window/Level V1, 3-26
Save/Restore/Print Protocol V1, 5-31
Saveraw data V1, 2-36
Saving a Protocol V1, 5-19, V1, 9-58
Saving a Series V4, 3-8
Saving and Filming Images V4, 8-48
Saving Images V1, 11-7
Saving Protocols to an MOD V1, 5-27
Saving Site Protocols to MOD V1, 5-27
SAVS/Paintbrush V4, 5-7
Scale V4, 8-45
Scalpel V4, 5-14, V4, 5-18
scalpel V4, 5-9
Scan V1, 3-89, V1, 7-75
Scan Desktop V1, 2-16
Scan Modes V1, 3-72
Scan Operations V1, 3-87
Scan Rx Desktop V1, 3-1
Scan Rx Icon V1, 3-2
Scan Timing V1, 3-27, V1, 7-15
Scan TR V1, 8-17
Scan with SmartStep V3, 4-7
Scanning V1, 7-75
Scanning Range V1, 3-51, V1, 7-22
Scanning with a Protocol V1, 7-1
Scanning with SmartPrep V3, 3-13
Schedule V1, 6-6
Schedule Screen V1, 6-7
SCIC V1, 6-11, V1, 6-25
SCIC and PPS V1, 6-11, V1, 6-25
SCP V1, 6-27, V1, 6-29, V1, 6-31, V1, 6-32
SCP tab V1, 6-29
Screen Save V1, 9-58
Scroll V1, 9-40
Scrolling V1, 9-40, V1, 9-65
Security Zone V1, 1-8
segment trace V4, 5-17
Select an Archive Device V1, 11-18
Select Object V4, 5-6
Selecting a Protocol V1, 7-58
Selecting a Registered Patient V1, 6-20
Selecting an Archive Device V1, 11-5
Selecting the Image Set V4, 5-12
Sequential V1, 3-49, V3, 1-49
Series Binding V1, 9-17, V1, 9-66
Series Control V1, 3-84
Series Text Page V1, 10-18
Service Tools Desktop V1, 2-17
Set Batch/Movie Loop V4, 5-6, V4, 5-28
Set End V3, 5-19
Set Range First V3, 5-37

Set Range Last V3, 5-37
Set reference image V4, 8-40
Set Start V3, 5-19
Set up the Gating Control V3, 2-86
Set up the Gating Control Parameters V3, 2-76
Setting a Primary Viewport V1, 9-29
Setting a Secondary Viewport V1, 9-30
Setting the Trigger Point and Trigger Window V3, 2-53
Setting Window and Level Presets V1, 10-25
Sharpening V4, 1-3
Sharpening Algorithms V4, 1-9, V4, 1-13
sharpening algorithms V4, 1-9
Shim Coils V1, 4-5
Shoulder Application V3, 5-47
Shoulder coil V1, 4-22
Shutdown your Signa LX V1, 2-34
Shutting down your Signa LX V1, 2-22
Signa Gating Algorithms V3, 2-26
Signal Enhancement Ratio V4, 8-14, V4, 8-55
Single image save V3, 5-17
Single Shot Fast Spin Echo (SSFSE) V2, 3-50
Single Shot Fast Spin Echo-IR (SSFSE-IR) V2, 3-50
Single-voxel Proton Brain Exam V2, 12-4
Site Library V1, 5-6, V1, 9-5
Site Protocol Library V1, 7-5
Slice Location Limits V3, 5-20
Slice Zerofill Interpolation Processing V3, 1-15
Slide Format V1, 10-6
Slider V1, 3-25
SmartPrep V3, 1-52, V3, 3-1
SmartStep V3, 4-1, V3, 4-2
smoothing V4, 1-3
Smoothing algorithms V4, 1-9
SNR V1, 4-7
Sorting Exams in Numerical Order V1, 9-21
Sorting Images V1, 9-5
Sorting the Patient Register V1, 6-21
Spacing V1, 3-53
Spatial mode V1, 9-7
Spatial Resolution V1, 7-16
Spatial Resolution Parameters and SNR V1, 7-19
Spatial SAT V3, 1-37
Spatial Saturation V1, 7-32
spatial saturation V1, 7-72
SPECIAL V3, 4-3, V3, 4-4
Spectral Inversion at Lipids V3, 1-40
Spectroscopy V2, 12-1
Spectroscopy Single Voxel V2, 12-10
Spectrum Average or Compression Techniques V4, 8-33
Spectrum Colors V4, 8-19
Spin Echo V2, 2-3
Spin Echo EPI V2, 11-11
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Spin Echo Pulse Sequence V2, 2-1
Spine Application V3, 5-45
Split ROI V4, 8-47
Split ROI and Merge ROI V4, 8-6
Spoiled Gradient Echo (SPGR) V2, 4-20
Square Pixel V3, 1-12
Square ROI V4, 8-46, V4, 8-51
Square Viewports V1, 9-17, V1, 9-67
ST Segment V3, 2-11
Standard CINE Screen V3, 2-66
Start V1, 2-6
Start a Scan Prescription V1, 7-48
Start a stationary system V1, 2-28
Start and End Location V1, 3-55
Start your mobile system V1, 2-26
Starting the Reformat Package V4, 6-5
Starting your mobile system V1, 2-22
Starting your stationary system V1, 2-22
Startup V4, 8-43
Status Area V1, 10-7
STEAM V2, 12-10
STL% V1, 3-87
STL% or dB/dt V1, 3-22
Subtract Two Images Within the Same Set or Two Sets of
Images V4, 3-14
Subtracting two images V4, 3-14
Superimposed Spectra V4, 8-33
surface V1, 4-5
Surface and Phased Array Coils V1, 4-7
surface and phased array coils V1, 4-21
Surface Coil Intensity Correction V3, 1-17
Surface Coil Warnings V1, 1-18
surface coils V1, 4-18
Swap Phase/Freq V3, 5-18
System Cabinet Room (Computer Room) V1, 2-14
System Disk Space V1, 11-10
System supplied text V1, 9-10
Systems with a Helium Level Meter V1, 1-46
Systems with a Magnet Monitor Unit V1, 1-47
Systole V3, 2-12

T
T1 FLAIR V2, 3-38
Table Transport Emergency Release V1, 1-29
Tailored RF V3, 1-4
Temporal and Spatial Image Play Modes V3, 5-23
Temporal Lobe Application V3, 5-41
Temporal mode V1, 9-7
Tetramethylsilane (TMS) V2, 12-7
Text Page V1, 10-18
Text pages V1, 10-18
The Chemical Shift or Upper Left (UL) Viewport V4, 8-25
The Metabolite Image or Lower Left (LL) Viewport V4,

8-35
The Reference or Lower Right (LR) Viewport V4, 8-38
Thermal Stress V1, 1-22
Threshold V3, 3-3, V4, 5-8, V4, 5-20, V4, 8-45
Threshold /VOI V4, 5-16
Threshold Range adjustment sliders V4, 5-23
Threshold/VOI V4, 5-7
Tick Marks V1, 9-17
Ticks Marks V1, 9-62
Tilt Cursor V3, 5-12
Tilt/Rotate Mode Select V4, 5-6
Time a Bolus V3, 5-36
Time Display/Patient Position V1, 2-5
Time of Flight V4, 5-3
Time of Flight Pulse Sequences V2, 6-1
time-intensity curves V4, 8-9
Timer V3, 5-17, V3, 5-36
time-varying magnetic fields V1, 4-3
Tips for Adjusting the Gating Trigger Level in ECG Gating
V3, 2-33
Tissue heating V1, 1-22
TMJ Application V3, 5-43
TOF V4, 5-3
Torso Array coil V1, 4-21
Torso Pelvis Array coil V1, 4-24
TPS Reset V1, 2-35
tracker V3, 3-1
Transfer the Patient to the System Table V1, 7-50
Translate Cursor V3, 5-12
Transmit Data to a Remote Host (Network Send) V1,
11-45
Transmit Gain V1, 8-6
Transmit Power V1, 8-6
Trigger Delay V2, 7-6, V3, 2-44
Trigger Delay (TD) V3, 2-44
Trigger Point (TP) V3, 2-52
Trigger Type V2, 9-4, V2, 13-17, V3, 2-38, V3, 2-67
Trigger Window V3, 2-40
Trigger Window (TW) V3, 2-53
Triggering V3, 2-7
Triple-IR V2, 13-6
Tumble V4, 5-8
Turbo Mode V3, 4-4
Turbo mode V3, 4-2
T-Wave V3, 2-11
Two Prescan Programs V1, 8-4

U
Undo V3, 5-17, V4, 5-8, V4, 5-18
Undo Buttons V3, 5-17
Update a Host V1, 11-40
Update BPM V2, 9-5
Update Images V1, 3-26
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Update R-peak Amplitude V3, 2-34
Updating a Host V1, 11-40
Upper Left (UL) Viewport V4, 8-25
User Annot / Trace V4, 5-8
User Control Variables Screen V1, 3-46
User Preferences V1, 9-16
User Training V1, 1-7
Using Accelerator Commands V1, 9-70
Using Connect Pro V1, 6-23

V
Valid Image Set V4, 5-3
Variable Bandwidth V3, 1-6
Vascular Screen V1, 3-45
Velocities V2, 8-5
VENC V2, 8-5
Very Selective Spatial Saturation V2, 12-7
View buttons V4, 5-7
View Edit V1, 3-81, V1, 7-10
View Planes V4, 5-7
Viewer V1, 9-6
Viewing Patient List V1, 9-22
Viewing the Patient Log V4, 2-14
Viewport Control V1, 9-5
viewport layout V4, 5-5
Views per Segment V2, 13-18, V3, 2-48
Views Per Segment (VPS) V3, 2-48
volume controls V1, 2-2
volume of MRA images V4, 5-1
Voxel size V2, 6-8

W
Waveform Display V3, 2-24
window V1, 9-6
window width and level settings V1, 9-27
Window Widths and Window Levels V1, 9-68
Working Safely V1, 1-1
Worklis V1, 6-7
Worklist V1, 6-7, V1, 6-24
Workspace Cabinet V1, 2-10
Workstation components V1, 2-3
workstation components V1, 2-2
Workstation Monitor V1, 2-10
Wrist coil V1, 4-22

X
X-axis, Image Rank and the PPM Scale, and Spectrum
Zooming V4, 8-32

Y
Y-axis and Spectrum Scaling V4, 8-32

Z
Zoom V1, 9-37
Zoom In V3, 5-18
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